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Customer Release Notes
Fiery Command WorkStation Package, v6.4

This document contains important information about this release. Be sure to provide this information to all users
before proceeding with the installation.

About this release
The following applications are included in this release:
o Fiery Command WorkStation Package v6.4.0.512

* Fiery Command WorkStation v6.4.00.62
 Fiery Hot Folders for Mac v4.00.0.31
e Fiery Hot Folders for Windows v4.00.0.31

o Fiery Software Manager v4.3.0.13

Upgrading

This installer will upgrade any existing Fiery Command WorkStation Package to the latest package containing Fiery
Command WorkStation and Fiery Hot Folders. Optionally, you can install Fiery Remote Scan by using Fiery
Software Manager.

Note: Fiery Command WorkStation Package v6.4.0.512 is not supported on macOS Catalina 10.15. To use Fiery
Command WorkStation on macOS Catalina 10.15, do not upgrade the existing Fiery Command WorkStation
Package to the latest package, or use Fiery Command WorkStation Package 6.5.

To upgrade from Fiery Command WorkStation version 5.x to 6.4, upgrade to Command WorkStation 6.3 first
(available in Fiery Software Manager), and then upgrade to version 6.4.

Fiery Command WorkStation Package supports Fiery servers running FS100 and later, and Fiery proServer and Fiery
XF 7.0 and later. It will not connect to:

o Fiery servers running Fiery System 9/9e Rel2 and System 10 software and previous versions
o Fiery XF 6.x servers and earlier
o Fiery Central servers

If you need access to these products, do not upgrade. Fiery Extended Applications Package is still available at
www.efi.com/cws. For a full list of supported cutsheet printers, see http://fiery.efi.com/CWS/supported-printers.
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For more information on technical specifications, refer to www.efi.com/cws.

What's new?

For more information on new features, visit http://fiery.efi.com/CWS/Whats-New.

macOS 10.15 (Catalina) information

Fiery Preview, Fiery Impose, Fiery Compose, or Fiery JobMaster on macOS 10.15

PDF Support Applications kit

The PDF Support Applications kit (provided by EFI), which consists of Adobe Acrobat and Enfocus PitStop, is
not compatible with macOS 10.15 (Catalina). If you use Acrobat and/or PitStop, do not upgrade to macOS
10.15. For new installations, the PDF Support Applications installer does not run.

Upgrading to macOS 10.15 while using the current PDF Support Applications kit may result in the following
issues:

e Ifyou have Acrobat DC already installed before upgrading to macOS 10.15, it will run normally. However,
the Acrobat DC installer is not compatible with macOS 10.15, so new installations of Acrobat DC are not
possible. Additionally, the included Enfocus PitStop is not supported with macOS 10.15.

e Ifyou have Acrobat XI already installed before upgrading to macOS 10.15, it will not run, and is not
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supported for macOS 10.15. We recommend uninstalling Acrobat XI before upgrading to macOS 10.15. The

Acrobat XI uninstaller will not run on macOS 10.15, so if you upgrade to macOS 10.15 with Acrobat XI still

installed, your system will be in a state in which Acrobat XI does not work and cannot be uninstalled.
If a compatible version of Acrobat is not installed, the following issues apply:

¢ The Editin Acrobat function is unavailable in Fiery Impose, Fiery Compose, and Fiery JobMaster.

e Opening a PostScript job with Fiery Preview, Fiery Impose, Fiery Compose, or Fiery JobMaster may result in

an error.

o Fiery Impose templates that use the workflows User defined finish size or Based on Trim Box may not work

properly with PostScript jobs.

o Fiery Hot Folders does not provide the option to convert PostScript files to PDF.

Other issues

After you upgrade to macOS 10.15 from an older macOS version, launching Fiery Preview, Fiery Impose, Fiery

Compose, or Fiery JobMaster may cause one of the following messages to be displayed:

o "ICUConverter.framework" will damage your computer. You should move it to the Trash.

"ICUData.framework" will damage your computer. You should move it to the Trash.

macOS 10.15 erroneously identifies these files as malware. To resolve these issues, reinstall Fiery Command
WorkStation Package version 6.4.0.396 or later, which is compatible with macOS 10.15.

When you hover your mouse over buttons for any of the control icons in Fiery Preview, Fiery Impose, Fiery
Compose, or Fiery JobMaster, the tool tips are not displayed.
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Full Disk Access

Because of changes in how macOS 10.15 manages security, there are now additional steps required to allow
Fiery applications to function properly.

You need to make changes to the Full Disk Access security feature in macOS in order for Fiery applications to
manage updates and access files such as Impose templates and hot folders. Enable Full Disk Access for Fiery
applications such as Fiery Command WorkStation.

1 Close all Fiery applications.
2 Go to System Preferences > Security & Privacy > Privacy > Full Disk Access.

Click the Lock icon in the bottom-left corner and enter your password.
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Click the + button.

5 Inthe Applications folder, select Fiery Software Manager and Fiery Software Uninstaller and click Open.

These applications require full disk access in order to maintain and update Fiery applications on your
computer.

6 In the Applications folder, select the Fiery Command WorkStation application and click Open.

7 Ifyou use Fiery Hot Folders or Fiery Remote Scan, select each application and click Open.

When Fiery Hot Folders detects that the Documents, Desktop, and Downloads folders are being used, it
issues a message requesting full disk access. This message is still displayed even after access has been granted.
You can dismiss this message and continue working.

Safari browser errors on macOS 10.15

If you use Safari on macOS 10.15, you will encounter repetitive browser errors when trying to open the following
webpages from Fiery Command WorkStation Device Center > General > Tools:

e Fiery System Restore
o Fiery System Image
o Fiery Resources and Settings

These errors can also occur when you open Fiery WebTools in the Safari browser.

Use Chrome or Firefox to access these webpages.

Fiery XF on macOS 10.15

If you use Fiery XF with Color Verifier, do not upgrade to macOS 10.15.

When you connect to a Fiery XF server, the Color Verifier application is not compatible with macOS 10.15.
Although a message prompts you to update Color Verifier, there is no update available at this time. Click OK to
dismiss the message.
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Fiery Spot Pro

Fiery Command WorkStation 6.4 allows you to manage spot colors with Fiery Spot Pro, which replaces Fiery Spot-
On. Fiery Spot Pro includes the following improvements and more:

e Export spot colors as ASE format to use as a swatch library in Adobe Creative Suite Applications such as Adobe
Photoshop.

o Easily apply spot color edits to all profiles.

o Create custom swatch books to fit your desired page size.

For a full list of improvements, see https://www.efi.com/spotpro.

Fiery Spot Pro is available to selected servers with the following requirements:

e FS200 Pro and later software

o Fiery Graphic Arts Package, Premium Edition

Learn more at http://fiery.efi.com/spotpro/supported-printers.
If your Fiery server does not have Fiery Spot Pro enabled, Fiery Command WorkStation will continue to support

Fiery Spot-On.

Considerations for using Fiery Spot Pro

e Do not use the "@" symbol in any spot color name.

o After you start Spot Pro, wait approximately 60-120 seconds before using the search function, or switching
output profiles.

o Optimizing spot colors after several iterations may result in more pronounced differences between the original
spot color and a converted spot color.

e There is a slight numerical rounding of converted L*a*b* values and device CMYK values.

o Two instances of Spot Pro on different user systems connecting to the same Fiery server may lead to errors if
both users perform editing operations.

Update Fiery Command WorkStation Package independently from Fiery system software

Fiery Command WorkStation software now behaves just like a standard application during installation.

Installing the Fiery Command WorkStation Package on a Fiery server is now the same as installing on a remote
client. This means that if the Fiery Command WorkStation Package software installed on a Fiery server requires a
reinstallation or upgrade, analysts or technicians will not need the System Software DVDs in order to do so.

When you install Fiery Command WorkStation on the Fiery server, the installation will not update the software
packages that are shared via WebTools or SMB. Also, the Fiery Service will not be stopped during install/upgrade/
uninstall of Fiery Command WorkStation 6.4.

Installing on Fiery XF server

When you install the Fiery Command WorkStation Package version 6.4 on a Fiery XF 7.x server, the Fiery XF server
is stopped while installation is in progress. After the installation has finished, the Fiery XF will automatically restart.
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64-bit application

Fiery Command WorkStation 6.4 (CWYS) is a native 64-bit application for both macOS and Windows platforms.

32-bit operating systems are not supported for CWS 6.4. If Fiery Software Manager is already running on a 32-bit
operating system (OS) such as Windows 7 32-bit, it will not display the update notifications for the CWS 6.4
package. If you attempt to run this version of Fiery Software Manager on a 32-bit OS, you will see a compatibility
error, and Fiery Software Manager will not run. To view the supported operating systems, see http://fiery.efi.com/
cws-specifications.

Fiery Color Profiler Suite and Fiery Command WorkStation 6.4

Fiery Color Profiler Suite 5.0 (CPS) and earlier versions are not fully compatible with Fiery Command WorkStation
Package 6.4 (CWS) for cutsheet printers. We recommend updating to Fiery Color Profiler Suite 5.1.

When using CPS 5.0 with CWS 6.4, you may experience the following issues:

o Ifyou see a message in CWS "Connect the spectrophotometer to your computer” while CPS is currently open,
close CPS and click OK to continue.

e After you create a new calibration setting in Calibrator, the Create new profile button to launch CPS is hidden.
This issue is resolved after upgrading to CPS 5.1.

Impose template location path

The Impose template location path has been removed from Fiery Hot Folders preferences. Instead, Fiery Hot Folders
uses the Impose template path used by Fiery Impose, which is defined in Fiery Impose > Edit > Preferences.

Set Defaults improvements

e In Set Defaults, a new default Output Paper Size named Same as Job Size is available.
¢ Locking the Same as Job Size option causes undesirable results and the locked state is therefore ignored.

o The Same as Job Size option for Output Paper Size is not available for Mixed Media, imposition, or Booklet
Maker workflows.

Job Properties improvements

¢ In Fiery Command WorkStation 6.4, you can start Job Properties in 2 seconds or less.

¢ When you open the Job Properties window for any job, it displays all the defaults. When you click on functions
such as Paper Catalog, FreeForm, control bar, the settings for these areas will be populated.

e When Job Properties needs to display more than 500 Paper Catalog entries, clicking the Paper Catalog list results
in a delay of about 8 - 80 seconds for the window to be refreshed. If there are as many as 5,000 entries, expect a
delay of 80 seconds.

e When you apply a curve in Fiery ImageViewer to a job, delete the curve, and then inspect the properties for the
job, the deleted curve name is still displayed as being associated with the job. However, when you click the
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ImageViewer Edits list, it becomes blank. If you do not select an available Fiery ImageViewer curve, the original
job settings for the curve will be retained.

e Behavior similar to the blank Fiery ImageViewer list also occurs in these other areas of Job Properties: Output
Profile, RGB source, CMYK Source, Use Spot Group, Control Bar, Create Master, and Use Master.

Even though a Paper Catalog option or setting may be invalid, an error message is not displayed in these
scenarios:

* You log in to Fiery Command WorkStation and view properties for a job that has valid Paper Catalog job
settings.

* You click the list of Paper Catalog entries in the job properties and select any Paper Catalog option from the
list.

* You reset Paper Catalog to factory settings from Fiery Command WorkStation.

* You select properties for a job that already has Paper Catalog job settings.

Issues fixed in Fiery Command WorkStation Package v6.4.0.512

Fiery Command WorkStation

An Impose template with the Marks preset name containing any of a large number of multi-byte characters
sometimes caused Fiery Command WorkStation to stop responding.

On macOS computers, with the OS language set to French or German, Fiery Calibrator stopped responding
before completing the calibration.

Issues fixed in Fiery Command WorkStation Package v6.4.0.500

Fiery Command WorkStation

On a Japanese-language system, when you printed a calibration test page while creating a new calibration, or
when you printed a calibration test page from Calibration Manager, the calibration name and output profile
name in the test page appeared garbled.

You could not create a calibration set with a Paper Catalog entry as paper source.

On a Japanese-language system, if you restarted the Fiery server, you could not save the Job Presets created from
Device Center.

When you performed a recalibration, the calibration test page started to be processed, but it was never printed.
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Fiery Command WorkStation Package v6.4.0.471

Issues fixed in Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

e Display of thumbnails was delayed in the Page View and Sheet View panes of Fiery Impose and Fiery Compose.

¢ Ifyou have more than 300 Fiery Impose templates, selecting an Impose template from Job Properties > Layout >
Impose > Templates caused Fiery Command WorkStation 6.4 to stop responding.

e You could not use the Advanced Search option in Fiery Command WorkStation to search for jobs that have
coated or uncoated media types.

Fiery XF

¢ To print a scaled job with cut marks, you had to move the job manually within the media in Job Editor and
change the X and Y positions of the job.

Known issue in Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

e Spot colors that are defined using non-ASCII characters are not supported for cutsheet printers.

Issues fixed in Fiery Command WorkStation Package v6.4.0.434
Fiery Command WorkStation

o After upgrading to Fiery Command WorkStation 6.4, you could not print a job from Fiery Command
WorkStation using custom paper sizes created on the printer.

o After upgrading to Fiery Command WorkStation 6.4, you could not apply bullets in Microsoft Word documents.

e Anincorrect error message occurred when you launched Fiery Impose, Fiery Compose, or Fiery JobMaster with
the user home folder set to a network folder.

o Fiery Hot Folders used to discard the folder structure when backing up and restoring from multiple levels deep
folder structures. The folder structure of Fiery Hot Folders is now retained after you restore from a backup.

Fiery XF

o The Fiery XF updates count per day would increase if Fiery Command WorkStation was running continuously
on a Windows client computer.

e In Color Tools > Settings, the halftoning setting Stochastic Screening (SE2) always changed back to Error
diffusion (SE1).



Customer Release Notes 8
Fiery Command WorkStation Package, v6.4

In Color Tools > Total Ink Limit, after you defined the custom chart configuration, you could not print the Total
Ink Limit (TIL) chart. An error message stated that the settings exceeded the media size.

Upgrading to Fiery Command WorkStation 6.4 caused the C:\ProgramData\Fiery\Fiery XF\Client\Working folder
to be deleted.

Note: Do not delete any of the preferences when uninstalling the current version of Fiery Command
WorkStation and upgarding to the latest version. Deleting preferences will cause the C:\ProgramData\Fiery\Fiery
XF\Client\Working folder to be uninstalled, which can result in the loss of important job data (applicable for
Windows only).

Issues fixed in Fiery Command WorkStation Package v6.4.0.358

Fiery Command WorkStation

In Fiery Impose, with a specified offset value, if you switched from standard cropmark to Japanese cropmark, a
single trim mark was applied in the Job Preview and Sheet view windows.

In Fiery Impose, when you created a template for a mixed page size PDF with Align to center positioning, the
template settings were not applied correctly to the job. To use the template successfully with the expected
output, re-create the template.

The unused tabs of a JobMaster job were not ejected to the specified tray.

When you created a new calibration profile by duplicating and renaming an existing profile, the properties of the
new profile did not match those of the original profile.

The page preview thumbnails were not generated in Fiery Preview, Fiery Impose, Fiery Compose, and Fiery
JobMaster.

Fiery XF

When you use the MATIC cutter with Step and Repeat jobs, the cut mark positions displayed in Job Editor did
not match the cut mark positions in the output.

A system user name containing accented characters (such as with the acute accent) sometimes caused Server
Manager to stop responding. Also, if you changed the working folder to a folder name that contained Cyrillic
characters, the new folder was not located.

The NVIDIA GeForce GTX1660 graphic card caused Server Manager and Job Editor to stop responding.

Fiery Command WorkStation Package v6.4.0.321

Issues fixed in Fiery Command WorkStation Package v6.4.0.321

The following issues are fixed:

Fiery Command WorkStation

When you edited the color curves of an existing output profile in Device Center > Resources > Profiles > Output
Profiles, the changes were not retained.

When you restored Hot Folders from a backup file, the Hot Folders failed to process some files.
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Fiery XF

In Job Editor, cut marks for nesting and step-and-repeat jobs are no longer displayed in the printer’s non-
printable margins.

You can now correctly save cut contour sources and methods as a preset.
The Contour cutting button is now available for print and cut devices on macOS operating systems.
When a job was cropped after rotation, the dimensions were reversed.

The crop margin was previously limited to 1000 cm. The maximum crop margin is now the same as the width/
height of the job.

When editing a VPC file in Color Tools, the curves of all color channels were displayed, even if you selected only
one color channel.

Known issue in Fiery Command WorkStation Package v6.4.0.321

Fiery Command WorkStation

On macOS computers, the tool tips are not displayed for any of the control icons in Fiery Preview, Fiery Impose,
Fiery Compose, and Fiery JobMaster.

Issues fixed in Fiery Command WorkStation Package v6.4.0.261 SP1

If you started Fiery Command WorkStation immediately after the Fiery server started and then selected a stacker
tray (or other installable option) in Job Properties, the option was sometimes shown as not installed. Now the
correct settings are displayed.

After you updated to Fiery Command WorkStation 6.4 on macOS and connected to the Fiery server for the first
time, Fiery Command WorkStation sometimes stopped responding and then exited. This issue has been
resolved.

When you attempted to open Job Properties, it would exit unexpectedly if Finishing > Crease had been added to
the Quick Access tab before you upgraded to Fiery Command WorkStation 6.4. This issue has been resolved.
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Le présent document contient des informations importantes concernant cette version. Distribuez-le a tous les
utilisateurs avant de procéder a l'installation.

A propos de cette version
Cette version comprend les applications suivantes :
o Fiery Command WorkStation Packagev 6.4.0.512

* Fiery Command WorkStationv 6.4.00.62
e Fiery Hot Folderspour Mac v 4.00.0.31
e Fiery Hot Folderspour Windows v 4.00.0.31

o Fiery Software Managerv 4.3.0.13

Mise a niveau

Cet installateur met a niveau tout Fiery Command WorkStation Package existant vers le dernier package contenant
Fiery Command WorkStation et des Fiery Hot Folders. Vous pouvez également installer Fiery Remote Scan a l'aide
de Fiery Software Manager.

Remarque : Fiery Command WorkStation Packagev 6.4.0.512 n’est pas pris en charge sous macOS Catalina 10.15.
Pour utiliser la Fiery Command WorkStation sous macOS Catalina 10.15, ne mettez pas a niveau le Fiery Command
WorkStation Package existant vers le dernier package, ni n'utilisez Fiery Command WorkStation Package 6.5.

Pour effectuer une mise a niveau de Fiery Command WorkStation version 5.x vers la version 6.4, effectuez au
préalable une mise a niveau vers la Command WorkStation 6.3 (disponible dans Fiery Software Manager), puis une
mise a niveau vers la version 6.4.

Fiery Command WorkStation Package prend en charge les Fiery servers exécutant le logiciel FS 100 et ses versions
ultérieures ainsi que Fiery proServer et Fiery XF 7.0 et ses versions ultérieures. Il ne se connecte pas aux serveurs
suivants :

o Fiery servers exécutant le logiciel Fiery System 9/9e Rel2, ainsi que le logiciel System 10 et ses versions
antérieures

o Lesserveurs Fiery XF 6.x et versions antérieures ;

e Serveurs Fiery Central
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S'il vous faut accéder a ces serveurs, n'effectuez pas la mise a niveau. Fiery Extended Applications Le package est
toujours disponible sur www.efi.com/cws. Pour une liste compléte des imprimantes a feuilles prises en charge,
consultez http://fiery.efi.com/CWS/supported-printers.

Pour plus d’informations sur les spécifications techniques, consultez le site www.efi.com/cws.

Nouveautés

Pour plus d’informations sur les nouvelles fonctionnalités, visitez http://Fiery. EFL.com/CWS/Whats-New.

informations sur macOS 10.15 (Catalina)

Apercu Fiery, Fiery Impose, Fiery Compose, ou Fiery JobMaster sous macOS 10.15

Kit d'applications de prise en charge PDF
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Le kit d’applications de prise en charge PDF (fourni par EFI) constitué d'Adobe Acrobat et d'Enfocus PitStop est

incompatible avec macOS 10.15 (Catalina). Si vous utilisez Acrobat et/ou PitStop, veuillez ne pas effectuer de
mise & niveau vers macOS 10.15. Le programme d’installation des applications de prise en charge PDF ne
s’exécute pas pour les nouvelles installations.

Lorsque le kit d’applications de prise en charge PDF est en cours d'utilisation, la mise a niveau vers macOS 10.15

peut causer les problemes suivants :

¢ SiAcrobat DC est déja installé avant de procéder a la mise a niveau vers macOS 10.15, il s'exécute
normalement. Toutefois, le programme d’installation d’Acrobat DC est incompatible avec macOS 10.15.
Impossible donc de procéder a de nouvelles installations d’Acrobat DC. En outre, le logiciel inclus Enfocus
PitStop n’est pas pris en charge par macOS 10.15.

e Acrobat XI ne s’exécute pas et n’est pas pris en charge par macOS 10.15 s'il est déja installé avant de
procéder a sa mise a niveau vers macOS 10.15. Il est recommandé de désinstaller Acrobat XI avant de
procéder a la mise a niveau vers macOS 10.15. Le programme de désinstallation d’Acrobat XI ne s’exécute
pas sur macOS 10.15. En effectuant donc une mise a niveau vers macOS 10.15 avec Acrobat XI encore
installé, il ne pourra ni fonctionner, ni étre désinstallé.

Si aucune version compatible d’Acrobat n’est installée, les problémes suivants surviennent :

¢ Lafonction Modifier dans Acrobat est indisponible dans Fiery Impose, Fiery Composeet Fiery JobMaster.

e L’ouverture d’'une tache PostScript avec Apercu Fiery peut entrainer une erreur dans Fiery ImposeFiery
Composeou Fiery JobMaster.

e Les modeles Fiery Imposequi utilisent les flux de production Taille de finition définie par I'utilisateur ou Basé

sur la zone de coupe risquent de ne pas fonctionner correctement avec les tiches PostScript.

o Fiery Hot Foldersne dispose pas d'options de conversion des fichiers PostScript au format PDF.

Autres types de problémes

Apres la mise a niveau d'une version plus ancienne de macOS vers macOS 10.15, le lancement de I'Apercu Fiery,

Fiery Impose, Fiery Compose, ou Fiery JobMaster peut faire afficher I'un des messages suivants :

o "ICUConverter.Framework" endommage votre ordinateur. Veuillez I'envoyer a la corbeille.

o "ICUData.Framework" endommage votre ordinateur. Veuillez I'envoyer a la corbeille.
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macOS 10.15 assimile par erreur ces fichiers a des logiciels malveillants. Pour résoudre ce probleme, veuillez
réinstallez Fiery Command WorkStation Package version 6.4.0.396 ou ultérieure, qui est compatible avec macOS
10.15.

Les infobulles ne s'affichent pas lorsque vous placez le curseur de la souris sur 'une des icones de parameétre de
I'Apercu Fiery Fiery Impose, Fiery Compose ou Fiery JobMaster

Accés complet au disque

En raison des améliorations apportées dans la fagon dont macOS 10.15 gére la protection, des opérations
supplémentaires sont désormais nécessaires pour que les applications Fiery fonctionnent correctement.

Il est nécessaire de modifier les options de protection d'Accés complet au disque dans macOS afin que les
applications Fiery puissent gérer les mises a jour et accéder aux fichiers tels que les modeéles Impose et les hot
folders. Activer I’Accés complet au disque pour les applications Fiery telles que Fiery Command WorkStation.

1 Fermer toutes les applications Fiery.
2 Aller a Préférences du systéme > Sécurité et confidentialité > Confidentialité > Accés complet au disque.

Cliquer sur l'icéne du verrou dans le coin inférieur gauche et saisir le mot de passe.

H W

Cliquer sur le bouton +.

5 Dans le dossier Applications, sélectionner Fiery Software Manager et Fiery Software Uninstaller et cliquer sur
Ouvrir.

Ces applications nécessitent un acces complet au disque pour pouvoir conserver et mettre a jour les
applications Fiery sur votre ordinateur.

6 Ouvrir le dossier Applications, sélectionner I'application Fiery Command WorkStation et cliquer sur Ouvrir.

7 Sivous utilisez Fiery Hot Folders ou Fiery Remote Scan, sélectionnez chaque application, puis cliquez sur
Ouvrir.

Fiery Hot Folders génére un message demandant un accés complet au disque lorsqu'il détecte que les dossiers
Documents, Bureau et Téléchargements sont en cours d'utilisation. Ce message continue de s’afficher méme
apres l'autorisation d’accés. Vous pouvez supprimer ce message et continuer de travailler.

Erreurs du navigateur Safari sur macOS 10,15

Si vous utilisez Safari sous macOS 10,15, vous rencontrez des erreurs récurrentes sur votre navigateur lorsque
vous essayez d’ouvrir les pages Web suivantes a partir de la Fiery Command WorkStation Vue périphérique >
Général > Onglet:

¢ Restauration systeme Fiery
e Image du systéme Fiery

e Parametres et ressources Fiery

Ces erreurs peuvent également se produire lorsque vous ouvrez Fiery WebTools dans le navigateur Safari.

Utilisez chrome ou Firefox pour accéder a ces pages.

Fiery XFsous macOS 10.15

Veuillez ne pas effectuer de mise a niveau vers macOS 10.15 si vous utilisez Fiery XF avec Color Verifier.
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L’application Color Verifier est incompatible avec macOS 10.15 en cas de connexion a un serveur Fiery XF.
Aucune mise a jour de Color Verifier n'est disponible pour le moment, méme si un message vous invite a le
mettre a jour. Cliquer sur OK pour supprimer le message.

Fiery Spot Pro

Fiery Command WorkStation6.4 permet de gérer les tons directs avec Fiery Spot Pro, qui remplace Fiery Spot-On.
Fiery Spot Pro comprend entre autres les améliorations suivantes :

o Exporter les tons directs au format ASE pour les utiliser comme bibliotheque d’échantillons dans les applications
Adobe Creative Suite telles que Adobe Photoshop.

e Appliquer facilement des modifications de tons directs a tous les profils.
e Créer des nuanciers personnalisés pour s'adapter au format de page souhaité.
Pour obtenir la liste complete des améliorations, consultez https://www.EFL.com/spotpro.

Fiery Spot Pro est disponible pour les serveurs sélectionnés suivants :

o Logiciel FS200 Pro et versions ultérieures

o Fiery Graphic Arts Package, Premium Edition

Pour en savoir plus, visitez le site http://fiery.efi.com/spotpro/supported-printers.

Si Fiery Spot Pro n'est pas activé sur votre Fiery server, Fiery Command WorkStation continuera de prendre en
charge Fiery Spot-On.

Remarques relatives a l'utilisation de Fiery Spot Pro

e Nutilisez pas le symbole "@" dans les noms des tons directs.

¢ Une fois que vous avez démarré Spot Pro, attendez environ 60 a 120 secondes avant d’utiliser la fonction de
recherche ou de changer de profil de sortie.

e L’optimisation des tons directs aprées plusieurs itérations peut entrainer des différences plus prononcées entre les
tons directs d'origine et les tons directs convertis.

o Il existe un léger arrondissement des valeurs numériques L*a*b* converties et des valeurs CMJN du périphérique.

e Deux occurrences de Spot Pro sur différents systémes utilisateur connectés au méme Fiery server peuvent
entrainer des erreurs si les deux utilisateurs effectuent des opérations de modification.

Mise a jour de Fiery Command WorkStation Package indépendamment du logiciel systeme
Fiery

Le logiciel Fiery Command WorkStationse comporte désormais comme une application standard durant
l'installation.

La procédure d'installation de Fiery Command WorkStation Package sur un Fiery serverest a présent identique que
celle d'un client distant. Cela signifie que, si le logiciel Fiery Command WorkStation Packageinstallé sur un Fiery
server nécessite une réinstallation ou une mise a niveau, les analystes ou techniciens n’auront pas besoin des dvd
logiciels systéme pour ce faire.

Lorsque vous installez Fiery Command WorkStation sur un 1 Fiery server, l'installation ne met pas a jour les
progiciels partagés via WebTools ou SMB. En outre, le service Fiery ne sera pas interrompu durant I'installation/mise
a niveau/Désinstallation de Fiery Command WorkStation 6.4.


https://www.efi.com/spotpro
http://fiery.efi.com/spotpro/supported-printers
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Installation sur un serveur Fiery XF

Lorsque vous installez la version 6.4 de Fiery Command WorkStation Package sur un serveur Fiery XF 7.x, le serveur
Fiery XF est interrompu durant I'installation. Une fois l'installation terminée, Fiery XF se relancera
automatiquement.

Application 64 bits

Fiery Command WorkStation 6.4 (CWS) est une application 64 bits native pour les plateformes macOs et Windows.

Les systémes d’exploitation 32 bits ne sont pas pris en charge par CWS 6.4. Si Fiery Software Manager est déja en
cours d’exécution sur un systéme d’exploitation 32 bits comme Windows 7 32 bits, il n'affichera pas les notifications
de mise a jour du package CWS 6.4. Si vous essayez d’installer cette version de Fiery Software Manager sur un
systéeme d’exploitation de 32 bits, une erreur de compatibilité se produira et Fiery Software Manager ne s'exécutera
pas. Pour afficher les systémes d’exploitation pris en charge, consultez le site http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite et Fiery Command WorkStation 6.4

Fiery Color Profiler Suite 5.0 (CPS) et les versions antérieures ne sont pas entiérement compatibles avec Fiery
Command WorkStation Package 6.4 (CWS) pour les imprimantes a feuilles. Nous vous recommandons d’effectuer
une mise a jour vers Fiery Color Profiler Suite 5.1.

Lorsque vous utilisez CPS 5.0 avec CWS 6.4, vous pouvez rencontrer les problémes suivants :

e Sivous voyez le message suivant dans CWS « Connectez le spectrophotometre a votre ordinateur » alors que
CPS est ouvert, fermez CPS et cliquez sur OK pour continuer.

e Apreés avoir créé un nouveau parametre de calibrage dans Calibrator, le bouton Créer nouveau profil permettant
de lancer CPS est masqué. Ce probléme est résolu apreés la mise a niveau vers CPS 5.1.

Chemin d'accés a I'emplacement du modéle Impose

Le chemin d'accés a I'emplacement du modéle Impose a été supprimé des préférences des Fiery Hot Folders. A la
place, les Fiery Hot Folders utilisent le chemin d’accés du modéle Impose utilisé par Fiery Impose, défini dans Fiery
Impose > Modifier > Préférences.

Améliorations de Définir les parameétres par défaut
e Dans Définir les paramétres par défaut, un nouveau Format de sortie papier par défaut nommé Identique a la
taille de la tache est disponible.

¢ Leverrouillage de I'option Identique a la taille de la tache provoque des résultats indésirables et I'état verrouillé
est donc ignoré.

¢ L'option Identique a la taille de la tache pour le Format de sortie papier n’est pas disponible pour les supports
mixtes, 'imposition ou les flux de production Booklet Maker.


http://fiery.efi.com/cws-specifications
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Amélioration des Propriétés de la tache

Dans Fiery Command WorkStation 6.4, vous pouvez démarrer les Propriétés de la tache en 2 secondes ou moins.

Lorsque vous ouvrez la fenétre des Propriétés de la tache pour n'importe quelle tiche, elle affiche toutes les
valeurs par défaut. Lorsque vous cliquez sur des fonctions comme Paper Catalog, FreeForm, ou la barre de
controéle, les paramétres de ces zones seront remplis.

Lorsque les Propriétés de la tache doivent afficher plus de 500 entrées de Paper Catalog, la fenétre de la liste des
entrées de Paper Catalog met environ 8 a 80 secondes a s'actualiser. Pour 5 000 entrées, attendez-vous a un délai
de 80 secondes.

Lorsque vous ajoutez une courbe a une tache dans Fiery ImageViewer, supprimez la courbe, puis inspectez les
propriétés de la tache, le nom de la courbe supprimée est toujours affiché comme étant associé a la tache.
Toutefois, lorsque vous cliquez sur la liste des Modifications de ImageViewer, elle devient vide. Si vous ne
sélectionnez pas de courbe Fiery ImageViewer disponible, les parameétres de la tiche d’origine de la courbe seront
conservés.

e Un comportement similaire a la liste vide Fiery ImageViewer se produit également dans d'autres zones des
Propriétés de la tache : Profil de sortie, Source RGB, Source CMYK, Utiliser le groupe de tons directs, la Barre de
contrdle, Créer une maquetteet Utiliser une maquette.

Meéme si une option ou un parametre Paper Catalog est non valide, aucun message d’erreur ne s’affiche dans les
cas suivants :

e Connectez-vous a Fiery Command WorkStation et affichez les propriétés d’'une tache disposant de parametres
de tache Paper Catalog valides.

¢ Cliquez sur la liste des entrées de Paper Catalog dans la fenétre des Propriétés de la tiche et sélectionnez
l'option Paper Catalog de la liste.

* Vous avez réinitialisé Paper Catalog avec les paramétres d'usine de Fiery Command WorkStation.

e Vous sélectionnez les propriétés d'une tiche qui dispose déja des parameétres de la tiche de Paper Catalog.

Problémes résolus dans Fiery Command WorkStation Package v6.4.0.512

Fiery Command WorkStation

Un modele Impose avec le nom de préréglage Repéres contenant I'un des nombreux caractéres multioctets
provoquait l'arrét de la réponse de la Fiery Command WorkStation.

Sur les ordinateurs macOS, lorsque la langue du systéme d’exploitation était définie a Francais ou Allemand,
Fiery Calibrator cessait de répondre avant de terminer le calibrage.

Problémes résolus dans Fiery Command WorkStation Package v6.4.0.500

Fiery Command WorkStation

Sur un systéme en langue japonaise, lorsque vous imprimiez une page de test de calibrage, lors de la création d’'un
nouveau calibrage ou a partir du Gestionnaire de calibrage, le nom du calibrage et celui du profil de sortie dans la
page de test semblaient brouillés.

Vous ne pouviez pas créer de données de calibrage avec une entrée du Catalogue papier comme source de papier.
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e Sur un systéme en langue japonaise, si vous redémarriez le Fiery server, vous ne pouviez pas enregistrer les
préréglages créés a partir de la Vue périphérique.

o Lorsque vous effectuiez un recalibrage, la page de test de calibrage commencait a étre traitée, mais n'était jamais
imprimée.

Fiery Command WorkStation Package v6.4.0.471

Problémes résolus dans Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

o L’affichage des miniatures a été retardé dans les volets Affichage des pages et Affichage des feuilles de la Fiery
Impose et Fiery Compose.

¢ Sivous disposez de plus de 300 modeles de Fiery Impose, la sélection d'un modele Impose a partir de Propriétés
de la tache > Options de > Impose > Modéles a provoqué I'arrét de la réponse de Fiery Command
WorkStation 6.4.

e Vous ne pouviez pas utiliser 'option de Recherche avancée dans Fiery Command WorkStation pour rechercher
des taches ayant des types de supports couchés ou non couchés.

Fiery XF

e Pour imprimer une tiche a I'échelle avec des reperes de coupe, vous deviez déplacer manuellement la tiche dans
le supports dans Editeur des taches et modifier les positions X et Y de la tache.

Probléme connu dans Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

o Les tons directs définis a I'aide de caracteres non ASCII ne sont pas pris en charge par les imprimantes a feuille.

Problemes résolus dans Fiery Command WorkStation Package v6.4.0.434
Fiery Command WorkStation

e Apres la mise a niveau vers Fiery Command WorkStation 6.4, vous ne pouviez pas imprimer une tache a partir
de la Fiery Command WorkStationavec du format de papier personnalisé créé sur l'imprimante.

e Apres la mise a niveau vers Fiery Command WorkStation6.4, vous ne pouviez pas insérer de puces dans les
documents Microsoft Word.

o Un message d’erreur s'affichait lors du lancement de Fiery Impose, Fiery Compose, ou Fiery JobMaster, et le
dossier de base de l'utilisateur était défini sur un dossier réseau.

o Fiery Hot Folderssupprimait I'arborescence des dossiers lors de la sauvegarde et la restauration, a partir de
plusieurs niveaux d'arborescences de dossiers profondes. L'arborescence des dossiers de Fiery Hot Foldersest
désormais conservée apres la restauration a partir d’'une sauvegarde.
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Fiery XF

Le nombre de mises a jour Fiery XF par jour augmenterait en cas d’exécution continue de Fiery Command
WorkStation sur un ordinateur client Windows.

Dans Color Tools > Parametres, le parameétre de tramage de la trame stochastique (SE2) revenait toujours a la
Diffusion d'erreur (SE2).

Dans Color Tools > Limite totale d'encrage, aprés avoir configuré le diagramme personnalisé, vous ne pouviez pas
imprimer le diagramme des limites totales d'encrage (TIL). Un message d’erreur indiquait que les parameétres
dépassaient la taille du support.

La mise a niveau vers Fiery Command WorkStation 6.4 engendrait la suppression du dossier C:\Program Data
\Fiery\Fiery XF\Client\Working.

Remarque : Ne supprimez aucune des préférences lors de la désinstallation de la version actuelle de la Fiery
Command WorkStation et la mise a niveau vers la derniére version. La suppression des préférences entrainera la
désinstallation du dossier C:\programdata\fiery\fiery XF\Client\Working, ce qui peut entrainer une perte
importante des données des taches (applicables 8 Windows uniquement).

Problémes résolus dans Fiery Command WorkStation Package v6.4.0.358

Fiery Command WorkStation

Dans Fiery Impose, avec une valeur de offset spécifiée, si vous avez basculé de cropmark standard a cropmark
japonais, une seule marque de découpe a été appliquée dans les fenétres apercu de la tache et affichage feuille .

Dans Fiery Impose, lorsque vous avez créé un modeéle pour un page mixte taille PDF avec alignement au
positionnement central , les parameétres du modeéle n’ont pas été appliqués correctement a la tiche. Pour utiliser
le modeéle avec succés avec la sortie attendue, recréez le modeéle.

Les onglets inutilisés d'une tache JobMaster n’ont pas été éjectés dans le bac spécifié.

Lorsque vous avez créé un nouveau profil de calibrage en dupliquant et en renommant un profil existant, les
propriétés du nouveau profil ne correspondent pas a celles du profil d’origine.

Les chemins de fer page prévisualisation n’ont pas été générés dans Fiery prévisualisation, Fiery Impose, Fiery
Compose et Fiery JobMaster.

Fiery XF

Lorsque vous utilisez le massicot MATIC avec les taches en répétition, les positions de la marque de découpe
affichées dans Job Editor ne correspondent pas aux positions de la marque de découpe dans la sortie.

Un nom d’utilisateur systéme contenant des caractéres accentués (comme avec l'accent aigu) entrainait parfois
I'arrét de la réponse du serveur Manager. En outre, si vous avez modifié le dossier de travail en un nom de dossier
contenant des caractéres cyrilliques, le nouveau dossier n’était pas situé.

La carte NVIDIA GeForce GTX1660 graphiques a incité Server Manager et Job Editor a cesser de répondre.

Fiery Command WorkStation Package v 6.4.0.321

Problémes résolus dans Fiery Command WorkStation Package v6.4.0.321

Les problemes suivants sont résolus :
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Fiery Command WorkStation

Lorsque vous modifiiez les courbes de couleur d’'un profil de sortie existant dans Vue périphérique > Ressources
> Profils > Profils de sortie, les modifications n’étaient pas conservées.

Lorsque vous restauriez les Hot Folders a partir d’'un fichier de sauvegarde, les Hot Folders ne parvenaient pas a
traiter certains fichiers.

Fiery XF

Dans Job Editor, les repéres de coupe pour les imbrications et les tiches de répétition ne s’affichent plus dans les
marges non imprimables de 'imprimante.

Vous pouvez maintenant enregistrer correctement les sources et méthodes de contour de découpe sous forme de
préréglages.

Le bouton Contour de découpe est maintenant disponible pour les périphériques d'impression et de découpe sur
les systémes d’exploitation MacOS.

Lorsqu’une tiche était rognée apres la rotation, les dimensions étaient inversées.

La marge de rognage était auparavant limitée a 1000 cm. La marge de rognage maximale est maintenant
identique a la largeur/hauteur de la tache.

Lorsque vous modifiiez un fichier VPC dans Color Tools, les courbes de tous les canaux de couleur étaient
affichées, méme si vous sélectionniez un seul canal de couleur.

Probléme connu dans Fiery Command WorkStation Package v 6.4.0.321

Fiery Command WorkStation

Sur les ordinateurs MacOS, les bulles d’aide ne sont pas affichées pour les icones de controle de Fiery Preview,
Fiery Impose, Fiery Compose et Fiery JobMaster.

Problemes résolus dans Fiery Command WorkStation Package v 6.4.0.261 SP1

Si vous démarriez Fiery Command WorkStation immédiatement aprés que le Fiery server ait démarré puis
sélectionniez un réceptacle empilage (ou une autre option disponible) dans Propriétés de la tiche, I'option
apparaissait parfois comme non installée. Désormais les parametres corrects sont affichés.

Une fois que vous aviez mis a jour vers Fiery Command WorkStation 6.4 sur macOS et que vous vous connectiez
au Fiery server pour la premiére fois, Fiery Command WorkStation cessait parfois de répondre puis quittait. Ce
probléme a été résolu.

Lorsque vous tentiez d'ouvrir Propriétés de la tache, elle quittait inopinément si Finition > Faux pli avait été
ajouté a l'onglet Acces rapide avant que vous ne mettiez a jour vers Fiery Command WorkStation 6.4. Ce
probléme a été résolu.
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Questo documento contiene importanti informazioni su questa release. Distribuire una copia di questo documento a
tutti gli utenti prima di procedere con l'installazione.

Informazioni su questa release
Questa release comprende le seguenti applicazioni:
o Fiery Command WorkStation Package v6.4.0.512

* Fiery Command WorkStation v6.4.00.62
 Fiery Hot Folders per Mac v4.00.0.31
e Fiery Hot Folders per Windows v4.00.0.31

o Fiery Software Manager v4.3.0.13

Aggiornamento

Questo programma di installazione aggiornera qualsiasi Fiery Command WorkStation Package esistente all'ultima
versione del pacchetto contenente Fiery Command WorkStation e Fiery Hot Folders. Facoltativamente, & possibile
installare Fiery Remote Scan utilizzando Fiery Software Manager.

Nota: Fiery Command WorkStation Package v6.4.0.512 non & supportato su macOS Catalina 10.15. Per utilizzare
Fiery Command WorkStation su macOS Catalina 10.15, non aggiornare la versione esistente di Fiery Command
WorkStation Package al pacchetto pili recente o utilizzare Fiery Command WorkStation Package 6.5.

Per aggiornamenti da Fiery Command WorkStation 5.x alla versione 6.4, effettuare prima l'aggiornamento a
Command WorkStation 6.3 (disponibile nel Fiery Software Manager) e successivamente effettuare I'aggiornamento
alla versione 6.4.

Fiery Command WorkStation Package supporta Fiery servers che eseguono FS100 e versioni successive, Fiery
proServer e Fiery XF 7.0 e versioni successive. Non si collega a:

o Fiery servers con software Fiery System 9/9e Rel2, System 10 e versioni precedenti
o Server Fiery XF 6.x e versioni precedenti

o Server Fiery Central
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Se & necessario accedere a questi prodotti, non eseguire l'aggiornamento. Fiery Extended Applications Il pacchetto ¢
disponibile all'indirizzo www.efi.com/cws. Per I'elenco completo delle stampanti a foglio singolo supportate, vedere
http://fiery.efi.com/CWS/supported-printers.

Per ulteriori informazioni sulle specifiche tecniche, vedere www.efi.com/cws.

Novita

Per ulteriori informazioni sulle nuove funzionalita, visitare http://Fiery. EFL.com/CWS/Whats-New.

Informazioni su macOS 10.15 (Catalina)

Anteprima Fiery, Fiery Impose, Fiery Compose o Fiery JobMaster su macOS 10.15

Kit applicazioni di supporto PDF

I kit di applicazioni di supporto PDF (fornito da EFI), composto da Adobe Acrobat ed Enfocus PitStop, non &
compatibile con macOS 10.15 (Catalina). Se si usano Acrobat e/o PitStop, non eseguire I'aggiornamento a
macOS 10.15. Per le nuove installazioni, il programma di installazione delle applicazioni di supporto PDF non
viene eseguito.

L'aggiornamento a macOS 10.15, mentre si utilizza il kit di applicazioni di supporto PDF corrente, puo causare i
seguenti problemi:

e Se Acrobat DC e gia stato installato prima di eseguire 1'aggiornamento a macOS 10.15, verra eseguito
normalmente. Tuttavia, il programma di installazione di Acrobat DC non é compatibile con macOS 10.15,
quindi non sono possibili nuove installazioni di Acrobat DC. Inoltre, la versione di Enfocus PitStop inclusa
non & supportata da macOS 10.15.

e Se Acrobat XI e gia stato installato prima di eseguire 1'aggiornamento a macOS 10.15, non verra eseguito e
non ¢ supportato per macOS 10.15. Si consiglia di disinstallare Acrobat XI prima di eseguire I'aggiornamento
amacOS 10.15. Acrobat XI Uninstaller non viene eseguito su macOS 10.15, quindi, se si esegue
l'aggiornamento a macOS 10.15 con Acrobat XI ancora installato, il sistema si trovera in uno stato in cui
Acrobat XI non funziona e non puo essere disinstallato.

Se non ¢ installata una versione compatibile di Acrobat, si verificano i seguenti problemi:

¢ La funzione Modifica in Acrobat non e disponibile su Fiery Impose, Fiery Compose e Fiery JobMaster.

e L'apertura di un lavoro PostScript con Anteprima Fiery, Fiery Impose, Fiery Compose o Fiery JobMaster
potrebbe causare un errore.

e Imodelli di Fiery Impose che utilizzano i flussi di lavoro Formato di finitura definito dall’'utente o Basato su
riquadro di rifilatura potrebbero non funzionare correttamente con i lavori PostScript.

o Fiery Hot Folders non fornisce I'opzione per convertire i file PostScript in PDF.

Altri problemi

Dopo aver eseguito l'aggiornamento a macOS 10.15 da una versione macOS precedente, il lancio di Anteprima
Fiery, Fiery Impose, Fiery Compose o Fiery JobMaster potrebbe causare la visualizzazione di uno dei seguenti
messaggi:

e "ICUConverter.framework" danneggia il computer. E necessario spostarlo nel Cestino.

e "ICUData.framework" danneggia il computer. E necessario spostarlo nel Cestino.


HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWS/Whats-New
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macOS 10.15 identifica erroneamente questi file come malware. Per risolvere questi problemi, reinstallare la
versione 6.4.0.358 o successiva di Fiery Command WorkStation Package, compatibile con macOS 10.15.

Quando si passa il mouse sopra i pulsanti per le icone di controllo in Anteprima Fiery, Fiery Impose, Fiery
Compose o Fiery JobMaster, i suggerimenti per gli strumenti non vengono visualizzati.

Accesso completo al disco

A causa delle modifiche apportate alla modalita in cui macOS 10.15 gestisce la sicurezza, sono necessari altri
passaggi per consentire il corretto funzionamento delle applicazioni Fiery.

E necessario apportare modifiche alla funzionalita di sicurezza dell’Accesso completo al disco in macOS per
consentire alle applicazioni Fiery di gestire gli aggiornamenti e accedere ai file come i modelli Impose e le
cartelle automatiche. Abilitare I'Accesso completo al disco per le applicazioni Fiery quali Fiery Command
WorkStation.

1 Chiudere tutte le applicazioni Fiery.
2 Vai a Preferenze di sistema > Sicurezza e Privacy > Privacy > Accesso completo al disco.

Fare clic sul lucchetto nell'angolo in basso a sinistra e immettere la propria password.

H W

Fare clic sul pulsante +.

5 Aprire la cartella Applicazioni, selezionare Fiery Software Manager e Fiery Software Uninstaller e fare clic su
Apri.

Queste applicazioni richiedono l'accesso completo al disco per poter mantenere e aggiornare le applicazioni
Fiery sul computer.

6 Selezionare l'applicazione Fiery Command WorkStation nella cartella Applicazioni e fare clic su Apri.

7 Sesiusa Fiery Hot Folders o Fiery Remote Scan, selezionare ogni applicazione e fare clic su Apri.

Quando Fiery Hot Folders rileva che vengono utilizzate le cartelle Documenti, Desktop e Download, invia un
messaggio con la richiesta di accesso completo al disco. Questo messaggio viene ancora visualizzato anche
dopo che & stato concesso 'accesso. E possibile ignorare questo messaggio e continuare a lavorare.

Errori del browser Safari su macOS 10.15

Se si utilizza Safari su macOS 10.15, si verificheranno errori ripetitivi del browser quando si provano ad aprire le
seguenti pagine web da Fiery Command WorkStation Centro periferica > Generale > Scheda:

¢ Ripristino sistema Fiery
e Immagine di Fiery System
¢ Risorse e impostazioni Fiery

Questi errori possono verificarsi anche quando si apre Fiery WebTools nel browser Safari.

Usare Chrome o Firefox per accedere a queste pagine Web.

Fiery XF su macOS 10.15

Se si utilizza Fiery XF con Color Verifier, non eseguire 1'aggiornamento a macOS 10.15.

Quando ci si collega a un server di Fiery XF, l'applicazione di Color Verifier non ¢ compatibile con macOS 10.15.
Sebbene un messaggio chieda di aggiornare Color Verifier, al momento non ¢ disponibile alcun aggiornamento.
Fare clic su OK per ignorare il messaggio.
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Fiery Spot Pro

22

Fiery Command WorkStation 6.4 consente di gestire le tinte piatte con Fiery Spot Pro, che sostituisce Fiery Spot-on.

Fiery Spot Pro include i seguenti miglioramenti e permette le seguenti opzioni:

o Esportare le tinte piatte come formato ASE da usare come libreria campione nella suite di applicazioni Adobe
Creative come Adobe Photoshop.

o Applicare facilmente modifiche colore alle tinte piatte a tutti i profili.

o Creare libri campione personalizzati per adattarsi alle dimensioni pagina desiderate.
Per un elenco completo dei miglioramenti, vedere https://www.EFI.com/spotpro.

Fiery Spot Pro é disponibile per i server selezionati con i seguenti requisiti:

o Software FS200 Pro e versioni successive

o Fiery Graphic Arts Package, Premium Edition

Ulteriori informazioni disponibili su http://fiery.efi.com/spotpro/supported-printers.

Se il vostro Fiery server non dispone di Fiery Spot Pro abilitato, Fiery Command WorkStation continuera a
supportare Fiery Spot-on.

Considerazioni sull'uso di Fiery Spot Pro

e Non usare il simbolo "@" nei nomi di tinte piatte.

e Dopo aver avviato Spot Pro, attendere circa 60-120 secondi prima di usare la funzione di ricerca o cambiare i
profili di destinazione.

e L'ottimizzazione delle tinte piatte dopo diverse iterazioni potrebbe causare differenze piu evidenti tra la tinta
piatta originale e una tinta piatta convertita.

e Vieé unleggero arrotondamento numerico dei valori L*a*b* convertiti e dei valori CMYK del dispositivo.

e Due istanze di Spot Pro su diversi sistemi utente che si collegano allo stesso Fiery server potrebbero causare
errori se entrambi gli utenti eseguono operazioni di modifica.

Aggiornare Fiery Command WorkStation Package indipendentemente dal software di
sistema Fiery

Il software Fiery Command WorkStation ora si comporta proprio come un'applicazione standard durante
l'installazione.

L'installazione di Fiery Command WorkStation Package su un Fiery server & ora identica all'installazione su un client

remoto. Cio significa che, se il software Fiery Command WorkStation Package installato su un Fiery server richiede

una reinstallazione o aggiornamento, gli analisti o i tecnici non avranno bisogno dei DVD del software di sistema per

farlo.

Quando si installa Fiery Command WorkStation sul Fiery server, l'installazione non aggiornera i pacchetti software

condivisi tramite WebTools o SMB. Inoltre, il servizio Fiery non verra interrotto durante l'installazione/
aggiornamento/disinstallazione di Fiery Command WorkStation 6.4.


https://www.efi.com/spotpro
http://fiery.efi.com/spotpro/supported-printers
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Installazione su server Fiery XF

Quando si installa Fiery Command WorkStation Package versione 6.4 su server Fiery XF 7., il server Fiery XF viene
arrestato mentre l'installazione € in corso. Al termine dell'installazione, Fiery XF si riavvia automaticamente.

Applicazione a 64 bit

Fiery Command WorkStation 6.4 (CWS) & un'applicazione nativa a 64 bit per piattaforme Mac OS e Windows.

I sistemi operativi a 32 bit non sono supportati per CWS 6.4. Se Fiery Software Manager € gia in esecuzione su un
sistema operativo a 32 bit, ad esempio Windows 7 a 32 bit, non verranno visualizzate le notifiche di aggiornamento
per il pacchetto CWS 6.4. Se si tenta di eseguire questa versione di Fiery Software Manager su un sistema operativo a
32 bit, verra visualizzato un errore di compatibilita e Fiery Software Manager non verra eseguito. Per visualizzare i
sistemi operativi supportati, vedere http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite e Fiery Command WorkStation 6.4

Fiery Color Profiler Suite 5.0 (CPS) e versioni precedenti non sono totalmente compatibili con Fiery Command
WorkStation Package 6.4 (CWS) per stampanti a foglio singolo. Si consiglia di eseguire 'aggiornamento a Fiery Color
Profiler Suite 5.1.

Quando si usa Color Profiler Suite 5.0 con CWS 6.4, si potrebbero verificare i seguenti problemi:

e Sein CWS viene visualizzato il messaggio "Connetti lo spettrofotometro al computer” mentre Color Profiler
Suite & aperto, chiudere l'applicazione e fare clic su OK per continuare.

e Dopo aver creato una nuova impostazione di calibrazione in Calibrazione, il pulsante Crea nuovo profilo per
avviare Color Profiler Suite & nascosto. Tale problema viene risolto dopo l'aggiornamento a Color Profiler Suite
5.1.

Percorso della posizione del modello Impose

11 percorso della posizione del modello Impose ¢ stato rimosso dalle preferenze di Fiery Hot Folders. Al suo posto,
Fiery Hot Folders utilizza il percorso del modello Impose usato da Fiery Impose, definito in Fiery Impose >
Modifica > Preferenze.

Miglioramenti su Imposta valori predefiniti
e InImposta valori predefiniti, & disponibile un nuovo Formato carta di destinazione predefinito denominato
Uguale a formato lavoro.

e Il blocco dell'opzione Uguale a formato lavoro comporta risultati indesiderati e lo stato di blocco viene quindi
ignorato.

e L'opzione Uguale a formato lavoro per Formato carta di destinazione non ¢ disponibile per Supporti misti,
imposizioni o flussi di lavoro di Booklet Maker.


http://fiery.efi.com/cws-specifications
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Miglioramenti delle proprieta del lavoro

In Fiery Command WorkStation 6.4, & possibile avviare le Proprieta del lavoro in due secondi o meno.

Quando si apre la finestra Proprieta del lavoro per qualsiasi lavoro, vengono visualizzati tutti i valori predefiniti.
Quando si fa clic su funzioni quali Catalogo carta, FreeForm, barra di controllo, le impostazioni di queste aree
saranno popolate.

Quando le Proprieta del lavoro devono visualizzare piu di 500 voci di Paper Catalog, se si fa clic sull'elenco di
Paper Catalog si verifichera un ritardo di circa 8-80 secondi affinché la finestra venga aggiornata. Se vi sono 5.000
voci, si preveda un ritardo di 80 secondi.

Quando si applica una curva a un lavoro in Fiery ImageViewer, eliminare la curva, quindi controllare le proprieta
del lavoro, il nome della curva eliminata viene ancora visualizzato come associato al lavoro. Tuttavia, quando si fa
clic sull'elenco Modifiche ImageViewer, diventa vuoto. Se non si seleziona una curva disponibile di Fiery
ImageViewer, le impostazioni del lavoro originali per la curva verranno mantenute.

e Un comportamento simile a quello dell'elenco vuoto di Fiery ImageViewer si verifica anche in altre aree di
Proprieta del lavoro: Profilo di destinazione, Origine RGB, Origine CMYK, Usa gruppo di tinte piatte, Barra di
controllo, Crea master e Usa master.

Anche se un'opzione o un'impostazione di Catalogo carta potrebbe non essere valida, in questi scenari non viene
visualizzato un messaggio di errore:

* Quando si accede a Fiery Command WorkStation e si visualizzano le proprieta di un lavoro che contiene
impostazioni di lavoro per Catalogo carta valide.

¢ Quando si fa clic sull'elenco delle voci Catalogo carta nelle proprieta lavoro e si seleziona un'opzione Catalogo
carta nell'elenco.

¢ Quando si reimposta il Paper Catalog alle impostazioni di fabbrica da Fiery Command WorkStation.

¢ Quando si selezionano le proprieta per un lavoro che contiene gia delle impostazioni di lavoro per Paper
Catalog.

Problemi risolti in Fiery Command WorkStation Package v6.4.0.512

Fiery Command WorkStation

Un modello Impose con nome di preimpostazione con Segni contenente uno qualsiasi dei molti caratteri a pitt
byte talvolta causa la cessazione del funzionamento di Fiery Command WorkStation.

Sui computer macOS, con la lingua del sistema operativo impostata su francese o tedesco, Fiery Calibrator ha
cessato di funzionare prima di completare la calibrazione.

Problemi risolti in Fiery Command WorkStation Package v6.4.0.500

Fiery Command WorkStation

In un sistema in lingua giapponese, quando si stampa una pagina di test calibrazione durante la creazione di una
nuova calibrazione o quando si stampa una pagina di test calibrazione da Gestione calibrazione, il nome della
calibrazione e il nome del profilo di destinazione nella pagina di test apparivano illeggibili.

Non é stato possibile creare un set di calibrazione con una voce di Paper Catalog come fonte di alimentazione.



Note di release per l'utente | 25
Fiery Command WorkStation Package, v6.4

¢ Inun sistema in lingua giapponese, se si riavviava Fiery server, non era possibile salvare le preimpostazioni del
lavoro create da Centro periferica.

¢ Quando si eseguiva una ricalibrazione, la pagina di test di calibrazione iniziava ad essere elaborata, ma non
veniva mai stampata.

Fiery Command WorkStation Package v6.4.0.471

Problemi risolti in Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

o Lavisualizzazione delle anteprime ¢ stata ritardata nelle aree Vista pagina e Vista foglio di Fiery Impose e Fiery
Compose.

¢ Sesidispone di pitt di 300 modelli di Fiery Impose, selezionare un modello Impose da Proprieta del lavoro >
Layout > Impose > Modelli causa la cessazione del funzionamento di Fiery Command WorkStation 6.4.

* Non e stato possibile utilizzare 1'opzione Ricerca avanzata in Fiery Command WorkStation per cercare i lavori
con supporto patinato o non patinato.

Fiery XF

e Per stampare un lavoro ridimensionato con segni di taglio, era necessario spostare manualmente il lavoro
all'interno del supporto in Job Editor e modificare le posizioni X e Y del lavoro.

Problema noto in Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

o Le tinte piatte definite con caratteri non ASCII non sono supportate per le stampanti foglio singolo.

Problemi risolti in Fiery Command WorkStation Package v6.4.0.434
Fiery Command WorkStation

¢ Dopo l'aggiornamento a Fiery Command WorkStation 6.4, non era possibile stampare un lavoro da Fiery
Command WorkStation utilizzando formati carta personalizzati creati sulla stampante.

e Dopo l'aggiornamento a Fiery Command WorkStation 6.4, non era possibile applicare elenchi puntati nei
documenti di Microsoft Word.

e Al momento dell'avvio di Fiery Impose, Fiery Compose o Fiery JobMaster, viene visualizzato un messaggio di
errore con la cartella iniziale dell'utente impostata su una cartella di rete.

o DPrecedentemente, Fiery Hot Folders scartava la struttura della cartella quando si eseguiva il backup e il ripristino
da strutture di cartelle profonde a pit livelli. La struttura della cartella di Fiery Hot Folders viene ora mantenuta
dopo il ripristino da un backup.
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Fiery XF

II conteggio giornaliero degli aggiornamenti Fiery XF aumenterebbe se Fiery Command WorkStation venisse
eseguito in modo continuo su un computer client Windows.

Nella Strumenti colore > Impostazioni, I'impostazione mezzitoni retino stocastico (SE2) si modificava sempre in
correzione automatica (SE1).

Nella Strumenti colore > Limite inchiostro totale, dopo aver definito la configurazione personalizzata del grafico,
non era possibile stampare il grafico del limite di inchiostro totale (TIL). Un messaggio di errore indicava che le
impostazioni superavano il formato supporto.

L'aggiornamento a Fiery Command WorkStation 6.4 causava l'eliminazione della cartella C:\ProgramData\Fiery
\Fiery XF\Client\Working.

Nota: Non eliminare una qualsiasi delle preferenze quando si disinstalla la versione corrente di Fiery Command
WorkStation e si esegue l'aggiornamento all'ultima versione. Se si eliminano le preferenze, la cartella C:
\programdata\fiery\fiery XF\Client\Working deve essere disinstallata e cid potrebbe causare la perdita di dati
importanti di lavoro (applicabile solo a Windows).

Problemi risolti in Fiery Command WorkStation Package v6.4.0.358

Fiery Command WorkStation

In Fiery Impose, con un valore di offset specificato, se si & passati dall'indicatore di ritaglio standard all'indicatore
di ritaglio giapponese, € stato applicato un singolo segno di rifilatura nelle finestre Anteprima lavoro e Vista
foglio.

In Fiery Impose, quando é stato creato un modello di un PDF con formati pagina misti con il posizionamento
Allinea al centro, le impostazioni del modello non sono state applicate correttamente al lavoro. Per usare
correttamente il modello con il risultato previsto, ricreare il modello.

I separatori inutilizzati di un lavoro JobMaster non sono stati espulsi nel cassetto specificato.

Quando ¢ stato creato un nuovo profilo calibrazione duplicando e rinominando un profilo esistente, le proprieta
del nuovo profilo non hanno corrisposto a quelle del profilo originale.

L'anteprima della pagina non é stata generata in Anteprima Fiery, Fiery Impose, Fiery Compose e Fiery
JobMaster.

Fiery XF

Quando si usa la taglierina MATIC con i lavori step and repeat, le posizioni del segno di taglio visualizzate in Job
Editor non hanno corrisposto alle posizioni del segno di taglio in uscita.

Un nome utente del sistema contenente caratteri accentati (come I'accento acuto) talvolta ha causato
linterruzione del Server Manager. Inoltre, se il nome della cartella di lavoro é stato cambiato in un nome di
cartella contenente caratteri cirillici, la nuova cartella non é stata individuata.

La scheda grafica NVIDIA GeForce GTX1660 ha fatto si che Server Manager e Job Editor smettessero di
rispondere.

Fiery Command WorkStation Package v6.4.0.321

Problemi risolti in Fiery Command WorkStation Package v6.4.0.321

I seguenti problemi sono stati risolti:
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Fiery Command WorkStation

Quando sono state modificate le curve di colore di un profilo di destinazione esistente in Centro periferica >
Risorse > Profili > Profili di destinazione, le modifiche non sono state mantenute.

Quando é stato ripristinato Hot Folders da un file di backup, Hot Folders non ¢ riuscito a elaborare alcuni file.

Fiery XF

In Job Editor, i segni di taglio per piazzamento e i lavori step and repeat non sono piu visualizzati nei margini non
stampabili della stampante.

E ora possibile salvare correttamente le sorgenti e i metodi di contorno di taglio come preimpostazione.
11 pulsante per il taglio Contour ¢ ora disponibile per i dispositivi di stampa e taglio sui sistemi operativi MacOS.
Quando un lavoro e stato ritagliato dopo la rotazione, le dimensioni sono state invertite.

Il margine di ritaglio e stato precedentemente limitato a 1000 cm. Il margine di ritaglio massimo ¢ ora lo stesso
della larghezza/altezza del lavoro.

Quando si modifica un file VPC in Color Tools, vengono visualizzate le curve di tutti i canali colore, anche se ¢
stato selezionato un solo canale colore.

Problema noto in Fiery Command WorkStation Package v6.4.0.321

Fiery Command WorkStation

Nei computer macOS, i consigli per gli strumenti non vengono visualizzati per nessuna delle icone di controllo in
Fiery Preview, Fiery Impose, Fiery Compose e Fiery JobMaster.

Problemi risolti in Fiery Command WorkStation Package v6.4.0.261 SP1

Se si inizia Fiery Command WorkStation subito dopo aver avviato Fiery server e poi selezionato un vassoio
impilatore (o un'altra opzione installabile) in Proprieta del lavoro, talvolta l'opzione viene visualizzata come non
installata. Ora vengono visualizzate le impostazioni corrette.

Dopo aver eseguito l'aggiornamento a Fiery Command WorkStation 6.4 su macOS e essersi collegati per la prima
volta a Fiery server, a volte Fiery Command WorkStation non risponde e si chiude. Questo problema ¢ stato
risolto.

Quando si prova ad aprire Proprieta del lavoro, questa si chiude inaspettatamente se Finitura > Scanalatura &
stato aggiunto alla scheda Accesso rapidoprima di aver eseguito I'aggiornamento a Fiery Command WorkStation
6.4. Questo problema é stato risolto.
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Dieses Dokument enthilt wichtige Informationen zu diesem Release. Stellen Sie diese Informationen allen Benutzern
zur Verfiigung, bevor Sie die Installation vornehmen.

Informationen zum Release
Diese Release-Version umfasst die folgenden Anwendungen:
o Fiery Command WorkStation Package v6.4.0.512

* Fiery Command WorkStation v6.4.00.62
e Fiery Hot Folders fiir Mac v4.00.0.31
e Fiery Hot Folders fiir Windows v4.00.0.31

o Fiery Software Manager v4.3.0.13

Aktualisieren

Dieses Installationsprogramm aktualisiert jedes vorhandene Fiery Command WorkStation Package auf die aktuelle
Version, die Fiery Command WorkStation und Fiery Hot Folders beinhaltet. Mithilfe von Fiery Software Manager
kénnen Sie optional Fiery Remote Scan installieren.

Hinweis: Fiery Command WorkStation Package v6.4.0.512 wird unter macOS Catalina 10.15 nicht unterstiitzt. Um
Fiery Command WorkStation unter macOS Catalina 10.15 verwenden zu konnen, aktualisieren Sie das vorhandene
Fiery Command WorkStation Package nicht auf das neueste Package, oder verwenden Sie Fiery Command
WorkStation Package 6.5.

Fiir ein Upgrade von Fiery Command WorkStation Version 5.x auf 6.4 aktualisieren Sie zuerst auf Command
WorkStation 6.3 (verfiigbar in Fiery Software Manager) und dann auf Version 6.4.

Fiery Command WorkStation Package unterstiitzt Fiery servers bei der Ausfithrung von FS100 und héher sowie
Fiery proServer und Fiery XF 7.0 und hoher. Es stellt keine Verbindung zu folgenden Systemen her:

o Fiery servers, das Fiery System 9/9e Rel2 sowie System 10-Software und frithere Versionen ausfiihrt
o Fiery XF 6.x Server und frithere Versionen

o Fiery Central Server



Release-Informationen | 29
Fiery Command WorkStation Package, v6.4

Wenn Sie weiterhin auf diese Produkte zugreifen miissen, diirfen Sie das Upgrade nicht vornehmen. Fiery Extended
Applications Das Paket ist weiterhin auf www.efi.com/cws verfiigbar. Eine vollstindige Liste der unterstiitzten
digitalen Bogendruckmaschinen finden Sie unter http://fiery.efi.com/CWS/supported-printers.

Weitere Informationen zu den technischen Spezifikationen finden Sie unter www.efi.com/cws.

Neuerungen

Weitere Informationen zu neuen Funktionen finden Sie unter http://fiery.efi.com/CWS/Whats-New.

macOS 10.15 (Catalina)-Informationen

Fiery Preview, Fiery Impose, Fiery Compose oder Fiery JobMaster unter macOS 10.15

PDF-Supportanwendungs-Kit

Das PDF-Supportanwendungs-Kit (bereitgestellt von EFI) besteht aus Adobe Acrobat und Enfocus PitStop und
ist nicht mit macOS 10.15 (Catalina) kompatibel. Wenn Sie Acrobat und/oder PitStop verwenden, sollten Sie
das Upgrade auf macOS 10.15 unterlassen. Bei neuen Installationen wird das Installationsprogramm fiir die PDF
Support Applications nicht ausgefiihrt.

Das Upgrade auf macOS 10.15 bei Verwendung des aktuellen PDF-Supportanwendungs-Kits kann zu folgenden
Problemen fiihren:

Wenn Sie Acrobat DC bereits installiert haben, bevor Sie auf macOS 10.15 aktualisieren, wird es normal
ausgefiithrt. Das Installationsprogramm von Acrobat DC ist jedoch nicht mit macOS 10.15 kompatibel,
sodass neue Installationen von Acrobat DC nicht méglich sind. Dariiber hinaus wird das mitgelieferte
Enfocus PitStop unter macOS 10.15 nicht unterstiitzt.

Wenn Sie Acrobat XI bereits installiert haben, bevor Sie auf macOS 10.15 aktualisieren, wird es nicht
ausgefithrt und wird unter macOS 10.15 nicht unterstiitzt. Es wird empfohlen, Acrobat XI vor dem Upgrade
auf macOS 10.15 zu deinstallieren. Das Deinstallationsprogramm von Acrobat XI wird unter macOS 10.15
nicht ausgefiihrt. Wenn Sie also die Aktualisierung auf macOS 10.15 durchfiihren, wihrend Acrobat XI noch
installiert ist, befindet sich Thr System in einem Zustand, in dem Acrobat XI nicht funktioniert und nicht
deinstalliert werden kann.

Wenn eine kompatible Version von Acrobat nicht installiert ist, gelten die folgenden Probleme:

Die Funktion In Acrobat bearbeiten ist in Fiery Impose, Fiery Compose und Fiery JobMaster nicht verfiigbar.

Das Offnen eines PostScript-Auftrags mit Fiery Preview, Fiery Impose, Fiery Compose oder Fiery JobMaster
kann zu einem Fehler fiithren.

Fiery Impose Schablonen, die die Workflows Eigene Endgréf3e oder Auf Basis des Endformatrahmens
verwenden, funktionieren mit PostScript-Auftragen moglicherweise nicht ordnungsgemafs.

Die Option PostScript Dateien in PDF-Dateien umzuwandeln wird von Fiery Hot Folders nicht angeboten.


HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWS/Whats-New
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Andere Probleme

Nach dem Upgrade von einer &lteren macOS-Version auf macOS 10.15 kann das Starten von Fiery Preview,
Fiery Impose, Fiery Compose oder Fiery JobMaster dazu fithren, dass eine der folgenden Meldungen angezeigt
wird:

e ICUConverter.framework” wird Ihren Computer beschiddigen. Verschieben Sie die Datei in den Papierkorb.
e ,ICUData.framework” wird Ihren Computer beschiddigen. Verschieben Sie die Datei in den Papierkorb.

macOS 10.15 identifiziert diese Dateien falschlicherweise als Malware. Um diese Probleme zu beheben,
installieren Sie Fiery Command WorkStation Package Version 6.4.0.396 oder hoher neu. Diese Versionen sind
mit macOS 10.15 kompatibel.

Wenn Sie mit der Maus iiber die Schaltflichen der Steuersymbole in Fiery Preview, Fiery Impose, Fiery
Compose oder Fiery JobMaster bewegen, wird die QuickInfo nicht angezeigt.

Festplattenvollzugriff

Aufgrund von Anderungen in der Art und Weise, wie macOS 10.15 die Sicherheit verwaltet, sind jetzt
zusdtzliche Schritte erforderlich, um die ordnungsgemaifie Funktion von Fiery Anwendungen zu gewéhrleisten.
Sie miissen Anderungen an der Sicherheitsfunktion Festplattenvollzugriff in macOS vornehmen, damit Fiery
Anwendungen Updates verwalten und auf Dateien wie Impose Schablonen und Hot Folders zugreifen konnen.
Aktivieren Sie den Festplattenvollzugriff fiir Fiery Anwendungen wie Fiery Command WorkStation.

1 Schlieflen Sie alle Fiery Anwendungen.
2 Navigieren Sie zu Systemeinstellungen > Sicherheit und Datenschutz > Datenschutz > Festplattenvollzugriff.
Klicken Sie in der unteren linken Ecke auf das Schloss-Symbol und geben Sie Thr Kennwort ein.

Klicken Sie auf die Schaltfliche +.

u A W

Wéhlen Sie im Ordner Anwendungen Fiery Software Manager und Fiery Software Uninstaller und klicken
Sie auf Offnen.

Diese Anwendungen benétigen Festplattenvollzugriff, um Fiery Anwendungen auf Ihrem Computer zu
verwalten und zu aktualisieren.

6 Wibhlen Sie im Ordner Anwendungen die Anwendung Fiery Command WorkStation und klicken Sie auf
Offnen.

7 Wenn Sie Fiery Hot Folders oder Fiery Remote Scan verwenden, wihlen Sie jede Anwendung aus und
klicken Sie auf Offnen.

Wenn Fiery Hot Folders erkennt, dass die Ordner ,Dokumente®, ,Desktop” und ,Downloads” verwendet
werden, wird eine Meldung ausgegeben, in der der Festplattenvollzugriff angefordert wird. Diese Meldung
wird weiterhin angezeigt, auch nachdem der Zugriff erteilt wurde. Sie konnen diese Meldung schliefSen und
weiterarbeiten.

Fehler mit Safari-Browser unter macOS 10.15

Wenn Sie Safari unter macOS 10.15 verwenden, treten beim Versuch folgende Webseiten iiber Fiery Command
WorkStation zu 6ffnen, sich wiederholende Browser-Fehler auf. Geratecenter > Allgemein > Werkzeuge:

o Fiery Systemwiederherstellung
o Fiery Systemabbild

o Fiery Ressourcen und Einstellungen
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Diese Fehler konnen auch auftreten, wenn Sie Fiery WebTools im Safari-Browser 6ffnen.

Verwenden Sie Chrome oder Firefox, um auf diese Webseiten zuzugreifen.

Fiery XF unter macOS 10.15

Wenn Sie Fiery XF mit Color Verifier verwenden, aktualisieren Sie nicht auf macOS 10.15.

Wenn Sie eine Verbindung zu einem Fiery XF Server herstellen, ist die Color Verifier Anwendung nicht mit
macOS 10.15 kompatibel. Obwohl Sie in einer Meldung aufgefordert werden, Color Verifier zu aktualisieren, ist
derzeit kein Update verfiigbar. Klicken Sie auf OK, um die Meldung zu schlief3en.

Fiery Spot Pro

Mit der Fiery Command WorkStation 6.4 haben Sie die Moglichkeit, Spot-Farben mit Fiery Spot Pro zu verwalten.
Fiery Spot Pro ersetzt Fiery Spot-On. Fiery Spot Pro umfasst die folgenden Verbesserungen und mehr:

e Export von Spot-Farben im ASE-Format, um sie als Farbmusterbibliothek in Adobe Creative Suite-
Anwendungen wie Adobe Photoshop zu verwenden.

e Problemlose Anwendung von bearbeiteten Spot-Farben auf alle Profile.

o Erstellung benutzerdefinierter Farbmusterbiicher, die der gewiinschten Seitengrofie entsprechen.
Eine vollstindige Liste der Verbesserungen finden Sie unter https://www.efi.com/spotpro.

Fiery Spot Pro ist fiir ausgewihlte Server mit den folgenden Anforderungen verfiigbar:

e FS200 Pro und neuere Software

o Fiery Graphic Arts Package, Premium Edition

Weitere Informationen unter http://fiery.efi.com/spotpro/supported-printers.

Wenn Fiery Spot Pro auf Ihrem Fiery server nicht aktiviert ist, wird Fiery Spot-On weiterhin von der Fiery
Command WorkStation unterstiitzt.

Uberlegungen zur Verwendung von Fiery Spot Pro

e Verwenden Sie das ,@“-Symbol nicht in Namen von Spot-Farben.

e Warten Sie nach dem Start von Spot Pro ca. 60-120 Sekunden, bevor Sie die Suchfunktion verwenden oder
Ausgabeprofile wechseln.

o Die Optimierung von Spot-Farben nach mehreren Iterationen kann zu deutlicheren Unterschieden zwischen der
urspriinglichen Spot-Farbe und einer konvertierten Spot-Farbe fiithren.

o Esgibt eine leichte numerische Rundung bei konvertierten L*a*b*-Werten und gerateabhdngigen CMYK-
Werten.

e Zwei Instanzen von Spot Pro auf verschiedenen Anwendersystemen, die mit demselben Fiery server verbunden
sind, konnen zu Fehlern fithren, wenn beide Anwender Bearbeitungsvorgénge durchfiihren.

Fiery Command WorkStation Package unabhangig von der Fiery Systemsoftware
aktualisieren

Die Software der Fiery Command WorkStation verhlt sich bei der Installation nun wie eine Standardanwendung.
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Die Installation des Fiery Command WorkStation Package auf dem Fiery server ist jetzt identisch mit der Installation
auf einem Remote-Client. Das bedeutet, dass Analysten oder Techniker die DVDs mit der Systemsoftware nicht
benétigen, wenn die Software des auf einem Fiery server installierten Fiery Command WorkStation Package neu
installiert oder aktualisiert werden muss.

Wenn Sie die Fiery Command WorkStation auf dem Fiery server installieren, werden die iiber Webtools oder SMB
freigegebenen Softwarepakete bei der Installation nicht aktualisiert. Auflerdem wird der Fiery Dienst wiahrend der
Installation/Aktualisierung/Deinstallation von Fiery Command WorkStation 6.4 nicht angehalten.

Installation auf dem Fiery XF-Server

Wenn Sie das Fiery Command WorkStation Package Version 6.4 auf dem Fiery XF-Server 7.x installieren, wird der
Fiery XF-Server wihrend der Installation angehalten. Nach Abschluss der Installation wird der Fiery XF-Server
automatisch neu gestartet.

64-Bit-Anwendung

Fiery Command WorkStation 6.4 (CWS) ist eine native 64-Bit-Anwendung fiir Mac OS- und Windows-Plattformen.

32-Bit-Betriebssysteme werden fiir CWS 6.4 nicht unterstiitzt. Wenn Fiery Software Manager bereits auf einem 32-
Bit-Betriebssystem wie Windows 7, 32-Bit-Version, ausgefiithrt wird, werden die Update-Benachrichtigungen fiir das
Paket CWS 6.4 nicht angezeigt. Wenn Sie versuchen, diese Version von Fiery Software Manager auf einem 32-Bit-
Betriebssystem zu installieren, wird ein Kompatibilitatsfehler angezeigt und Fiery Software Manager kann nicht
ausgefithrt werden. Informationen zu den unterstiitzten Betriebssystemen finden Sie unter http://fiery.efi.com/cws-
specifications.

Fiery Color Profiler Suite und Fiery Command WorkStation 6.4

Fiery Color Profiler Suite 5.0 (CPS) und frithere Versionen sind nicht vollstindig mit dem Fiery Command
WorkStation Package 6.4 (CWS) fiir digitale Bogendruckmaschinen kompatibel. Wir empfehlen die Aktualisierung
auf Fiery Color Profiler Suite 5.1.

Bei der Verwendung von CPS 5.0 mit CWS 6.4, konnen die folgenden Probleme auftreten:

e Wenn in CWS die Meldung ,Spektralfotometer mit Ihrem Computer verbinden” angezeigt wird, wahrend CPS
geoffnet ist, schlieflen Sie CPS und klicken Sie zum Fortfahren auf OK.

e Nachdem Sie in Calibrator eine neue Kalibrierungseinstellung erstellt haben, wird die Schaltfliche Neues Profil
erstellen fiir den Start von CPS ausgeblendet. Dieses Problem wird nach dem Upgrade auf CPS 5.1 behoben.

Speicherortpfad fiir Impose Schablonen

Der Speicherortpfad fiir Impose Schablonen wurde aus den Voreinstellungen von Fiery Hot Folders entfernt. Fiery
Hot Folders nutzt stattdessen den Pfad fiir Impose Schablonen, der auch von Fiery Impose selbst genutzt wird und
festgelegt ist unter Fiery Impose > Bearbeiten > Voreinstellungen.
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Festlegen von Standardverbesserungen

Unter Standardeinstellungen festlegen ist fiir die Ausgabepapiergrofe eine neue Standardeinstellung mit dem
Namen Wie Auftragsgrof3e verfiigbar.

Die Option Wie Auftragsgrof3e zu sperren, fithrt zu unerwiinschten Ergebnissen, und der gesperrte Zustand wird
daher ignoriert.

Die Option Wie Auftragsgro3e fiir Ausgabepapiergrof3e ist fiir gemischte Medien, Ausschiefien oder Booklet
Maker Workflows nicht verfiigbar.

Verbesserungen bei den Auftragseigenschaften

In der Fiery Command WorkStation 6.4 konnen Sie Auftragseigenschaften in 2 Sekunden oder weniger starten.

Wenn Sie das Fenster Auftragseigenschaften fiir einen beliebigen Auftrag 6ffnen, werden alle
Standardeinstellungen angezeigt. Wenn Sie auf Funktionen wie Papierkatalog, FreeForm oder Kontrollstreifen
klicken, werden die Einstellungen fiir diese Bereiche automatisch eingesetzt.

Wenn in den Auftragseigenschaften mehr als 500 Papierkatalog-Eintrige angezeigt werden miissen und Sie auf
die Papierkatalog-Liste klicken, kommt es zu einer Verzogerung von ca. 8 - 80 Sekunden, bis das Fenster
aktualisiert ist. Wenn es um die 5.000 Eintrége gibt, ist von einer Verzégerung von 80 Sekunden auszugehen.

Wenn Sie in Fiery ImageViewer eine Kurve auf einen Auftrag anwenden, die Kurve anschliefiend 16schen und
dann die Eigenschaften fiir den Auftrag tiberpriifen, wird der Name der geldschten Kurve weiterhin als dem
Auftrag zugeordnet angezeigt. Wenn Sie jedoch auf die Liste ImageViewer Bearbeitungen klicken, wird die Liste
geleert. Wenn Sie keine verfiigbare Fiery ImageViewer Kurve auswihlen, werden die urspriinglichen
Auftragseinstellungen fiir die Kurve beibehalten.

e Das Verhalten, das der leeren Fiery ImageViewer Liste dhnelt, tritt auch in folgenden Bereichen der
Auftragseigenschaften auf: Ausgabeprofil, RGB-Quelle, CMYK-Quelle, Spot-Farbgruppe verwenden,
Kontrollstreifen, Master-Datei erstellenund Master-Datei verwenden.

Obwohl eine Option oder Einstellung fiir den Papierkatalog moglicherweise ungiiltig ist, wird in folgenden
Féllen keine Fehlermeldung angezeigt:

 Sie melden sich bei der Fiery Command WorkStation an und rufen die Eigenschaften fiir einen Auftrag mit
giiltigen Auftragseinstellungen fiir den Papierkatalog auf.

e Sie klicken in den Auftragseigenschaften auf die Liste der Papierkatalog-Eintrige und wahlen in der Liste eine
beliebige Papierkatalog-Option aus.

* Sie setzen den Papierkatalog iiber die Fiery Command WorkStation auf die Werkseinstellungen zuriick.

¢ Sie wihlen Eigenschaften fiir einen Auftrag aus, der bereits Auftragseigenschaften fiir den Papierkatalog hat.

Probleme in Fiery Command WorkStation Package v6.4.0.512 behoben

Fiery Command WorkStation

Eine Impose Vorlage mit dem voreingestellten Namen Marken, der eine beliebige Anzahl von Multibyte-Zeichen
enthilt, fiihrte manchmal dazu, dass Fiery Command WorkStation nicht mehr reagierte.

Auf macOS Computern, bei denen die OS-Sprache auf Franzosisch oder Deutsch eingestellt ist, reagierte der
Fiery Kalibrator vor Beendigung der Kalibrierung nicht mehr.
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Behobene Probleme in Fiery Command WorkStation Package v6.4.0.500
Fiery Command WorkStation

e Wenn Sie auf einem japanischen System beim Erstellen einer neuen Kalibrierung eine Kalibrierungstestseite
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oder eine Kalibrierungstestseite tiber die Kalibrierungsverwaltung druckten, wurden der Kalibrierungsname und

der Name des Ausgabeprofils auf der Testseite entstellt angezeigt.
o Sie konnten keinen Kalibrierungssatz mit einem Paper Catalog-Eintrag als Papierzufuhr erstellen.

e Wenn Sie auf einem japanischen System den Fiery server neu starteten, konnten Sie die im Gerétecenter
erstellten Auftragsvorgaben nicht speichern.

e Wenn Sie eine Nachkalibrierung durchfiihrten, wurde die Kalibrierungstestseite zwar verarbeitet, jedoch nie
gedruckt.

Fiery Command WorkStation Package v6.4.0.471

Behobene Probleme in Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

o Die Anzeige der Miniaturansichten wurde in den Fensterbereich ,Seitenansicht“ und ,Bogenansicht“ in Fiery
Impose und Fiery Compose verzogert.

e Wenn Sie mehr als 300 Fiery Impose Vorlagen haben, fithrte die Auswahl einer Impose Schablone aus den
Auftragseigenschaften > Layout > Impose > Vorlagen dazu, dass Fiery Command WorkStation 6.4 nicht mehr
reagierte.

o Die Option Erweiterte Suche konnte in Fiery Command WorkStation nicht verwendet werden, um nach
Auftrigen zu suchen, die gestrichene und ungestrichene Medien verwenden.

Fiery XF

e Um einen skalierten Auftrag mit Schnittmarkierungen zu drucken, mussten Sie den Auftrag manuell im Medium

in Job Editor verschieben und die X- und Y-Positionen des Auftrags éndern.

Bekannte Problemsituation in Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

o Sonderfarben, die mit Nicht-ASCII-Zeichen definiert sind, werden von digitalen Bogendruckmaschinen nicht
unterstitzt.
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Behobene Probleme in Fiery Command WorkStation Package v6.4.0.434

Fiery Command WorkStation

Nach dem Upgrade auf Fiery Command WorkStation 6.4 war es nicht moglich, Auftrige mit eigenen
Papiergrofien, die auf dem Drucker erstellt wurden, von der Fiery Command WorkStation aus zu drucken.

Nach dem Upgrade auf Fiery Command WorkStation 6.4 konnten keine Aufzéhlungspunkte in Microsoft Word-
Dokumente eingefiigt werden.

Eine falsche Fehlermeldung trat auf, wenn Sie Fiery Impose, Fiery Compose oder Fiery JobMaster gestartet haben
und der Anwender-Home-Folder auf ein Netzwerk-Folder festgelegt ist.

Wenn Fiery Hot Folders zum Sichern und Wiederherstellen von Ordnerstrukturen mit mehreren Ebenen
verwendet wurden, wurde die Ordnerstruktur geloscht. Die Ordnerstruktur von Fiery Hot Folders wird jetzt
beibehalten, wenn Sie Wiederherstellungen von einer Sicherung vornehmen.

Fiery XF

Die tagliche Anzahl Fiery XF Aktualisierungen wiirde ansteigen, wenn die Fiery Command WorkStation auf
einem Client-Computer unter Windows kontinuierlich ausgefiihrt wiirde.

In Color Tools > Einstellungenwurde die Rastereinstellung Stochastische Rasterung (SE2) immer auf
Fehlerdiffusion (SE1) geéndert.

In Color Tools > Gesamttintenlimitkonnte das Diagramm Gesamttintenbegrenzung nach dem Definieren der
benutzerdefinierten Diagrammkonfiguration nicht gedruckt werden. In einer Fehlermeldung wurde angegeben,
dass die Einstellungen die Mediengrof3e tiberschritten haben.

Bei einem Upgrade auf Fiery Command WorkStation 6.4 wurde der Ordner C:\ProgramData\Fiery\Fiery XF
\Client\Working geloscht.

Hinweis: Loschen Sie keine der Voreinstellungen, wenn Sie die aktuelle Version von Fiery Command
WorkStation deinstallieren und auf die neueste Version aktualisieren. Das Loschen von Voreinstellungen fiihrt
dazu, dass der Ordner C:\ProgramData\Fiery\Fiery XF\Client\Folder deinstalliert wird, was zu einem Verlust
wichtiger Auftragsdaten fiihren kann (nur unter Windows).

Probleme in Fiery Command WorkStation Package V6.4.0.358 behoben

Fiery Command WorkStation

Wenn Sie in Fiery Impose mit einem festgelegten Versatzwert von der Standard-Schnittmarke zur japanischen
Schnittmarke gewechselt haben, wurde in den Fenstern Auftragsvorschau und Bogenansicht eine einzelne
Schnittmarke angewendet.

In Fiery Impose wurden die Vorlageneinstellungen beim Erstellen einer Vorlage fiir eine PDF-Datei mit
Ausrichtung an der Mittelposition gemischter SeitengréfSe und Ausrichtung an der Mittelposition nicht
ordnungsgemif auf den Auftrag angewendet. Um die Vorlage erfolgreich mit der erwarteten Ausgabe zu
verwenden, erstellen Sie die Vorlage neu.

Die nicht verwendeten Registerkarten eines JobMaster Auftrags wurden nicht in das angegebene Fach
ausgeworfen.

Wenn Sie ein neues Kalibrierungsprofil durch Duplizieren und Umbenennen eines vorhandenen Profils erstellt
haben, stimmten die Eigenschaften des neuen Profils nicht mit denen des urspriinglichen Profils iiberein.

Die Miniaturansichten der Seitenvorschau wurden in Fiery Preview, Fiery Impose, Fiery Compose und Fiery
JobMaster nicht erstellt.
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Fiery XF

Wenn Sie das MATIC Schneidsystem mit Step- und Repeat-Auftrigen verwenden, stimmen die im Job Editor
angezeigten Schnittmarkenpositionen nicht mit den Schnittmarkenpositionen in der Ausgabe iiberein.

Ein Systemanwendername mit akzentuierten Zeichen (z. B. mit Akut-Akzent) fithrte manchmal dazu, dass der
Server Manager nicht mehr reagierte. Wenn Sie den Arbeitsordner in einen Ordnernamen geéndert haben, der
kyrillische Zeichen enthielt, wurde der neue Ordner ebenfalls nicht gefunden.

Die Grafikkarte NVIDIA GeForce GTX1660 verursachte, dass Server Manager und Job Editor nicht mehr
reagierten.

Fiery Command WorkStation Package v6.4.0.321

In Fiery Command WorkStation Package V6.4.0.321 behobene Probleme

Folgende Probleme wurden behoben:

Fiery Command WorkStation

Wenn Sie die Farbkurven einem vorhandenen Ausgabeprofil im Gerate Center > Resourcen > Profile >
Ausgabeprofile bearbeitet haben, wurden die Anderungen nicht beibehalten.

Wenn Sie tiberwachte Ordner aus einer Sicherungsdatei wiederhergestellt haben, konnten die tiberwachten
Ordner einige Dateien nicht verarbeiten.

Fiery XF

In Job Editor werden Schnittmarken fir Sammelform- und Step & Repeat-Auftrage nicht mehr in den nicht
druckbaren Randern des Drucker angezeigt.

Sie konnen nun Schnittkonturquellen und -methoden korrekt als Voreinstellung speichern.

Die Schaltflache Kontur schneiden ist jetzt fiir Druck- und Schneidegerite unter macOS-Betriebssystemen
verfiigbar.

Wenn eine Auftrag nach der Drehung abgeschnitten wurde, wurden die Mafle riickgéngig gemacht.

Die Schnittkante war bisher auf 1000 cm beschrankt. Der maximale Beschnittrand entspricht nun der Breite/
Hohe des Auftrag.

Beim Bearbeiten einer VPC-Datei in Color Tools wurden die Kurven aller Farbkanile angezeigt, selbst wenn Sie
nur einen Farbkanal ausgewéhlt haben.

Bekannte Problemsituation in Fiery Command WorkStation Package v6.4.0.321

Fiery Command WorkStation

Auf macOS-Computern werden die Tooltipps fiir keines der Steuerelementsymbole in Fiery Preview, Fiery
Impose, Fiery Compose und Fiery JobMaster angezeigt.

36
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Behobene Probleme im Fiery Command WorkStation Package v6.4.0.261 SP1

Wenn Sie Fiery Command WorkStation gleich nach dem Starten des Fiery server starten und eine Staplerablage
(oder eine andere installierbare Option) in Auftragseigenschaften auswahlen, wird die Option moglicherweise als
nicht installiert angezeigt. Nun werden die richtigen Einstellungen angezeigt.

Nach der Aktualisierung auf Fiery Command WorkStation 6.4 auf macOS und der ersten Verbindung zum Fiery
server, stoppte die Fiery Command WorkStation zu reagieren und wurde dann beendet. Dieses Problem wurde
behoben.

Wenn Sie versuchten, die Auftragseigenschaften zu 6ffnen, wurden sie unerwartet beendet, wenn Finishing >
Rillen zur Registerseite Schnellzugriff hinzugefiigt haben, bevor Sie die Aktualisierung auf Fiery Command
WorkStation 6.4 vorgenommen haben. Dieses Problem wurde behoben.
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Notas de la versién para el cliente
Fiery Command WorkStation Package, v6.4

Este documento contiene informacién importante acerca de esta version. Asegtirese de proporcionar esta
informacidn a todos los usuarios antes de continuar con la instalacién.

Acerca de esta version
En esta version se incluyen las siguientes aplicaciones:
o Fiery Command WorkStation Package 6.4.0.512

* Fiery Command WorkStation 6.4.00.62
e Fiery Hot Folderspara Mac 4.00.0.31
e Fiery Hot Folderspara Windows 4.00.0.31

o Fiery Software Manager 4.3.0.13

Actualizaciones

El instalador actualizara cualquier Fiery Command WorkStation Package existente al ultimo paquete que contenga
Fiery Command WorkStation y Fiery Hot Folders. Opcionalmente, puede instalar Fiery Remote Scan mediante Fiery
Software Manager.

Nota: Fiery Command WorkStation Package 6.4.0.512 no es compatible con macOS Catalina 10.15. Para utilizar
Fiery Command WorkStation en macOS Catalina 10.15, no actualice el Fiery Command WorkStation Package
existente al ultimo paquete ni utilice Fiery Command WorkStation Package 6.5.

Para actualizar Fiery Command WorkStation desde la version 5.x a la version 6.4, actualice primero a Command
WorkStation 6.3 (disponible en Fiery Software Manager) y, a continuacién, actualice a la versién 6.4.

Fiery Command WorkStation Package es compatible con Fiery servers con FS100 y posteriores, Fiery proServer y
Fiery XF 7.0 y posteriores. No se conectard a:

o Fiery servers con Fiery System 9/9e Rel2 y el software System 10 y versiones anteriores
e Servidores Fiery XF 6.x y anteriores

e Servidores de Fiery Central

Si necesita tener acceso a estos productos no actualice. Fiery Extended Applications Package sigue estando
disponible en www.efi.com/cws. Para obtener una lista completa de las impresoras de hojas admitidas, consulte
http://fiery.efi.com/CWS/supported-printers.
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Para obtener mds informacién acerca de las especificaciones técnicas, consulte www.efi.com/cws.

Novedades

Para obtener mds informacién acerca de las nuevas funciones, visite http://Fiery.EFl.com/CWS/Whats-New.

Informacion de macOS 10.15 (Catalina)

Presentacion preliminar de Fiery, Fiery Impose, Fiery Compose o Fiery JobMaster en MacOS 10.15

Kit de aplicaciones de compatibilidad con PDF

El kit de aplicaciones de compatibilidad con PDF (proporcionado por EFI), que consiste en Adobe Acrobat y
Enfocus PitStop, no es compatible con macOS 10.15 (Catalina). Si utiliza Acrobat o PitStop, no actualice a
macOS 10.15. Para nuevas instalaciones, el instalador de aplicaciones de compatibilidad con PDF no se
ejecutara.

La actualizacién a macOS 10.15 mientras utiliza el kit de aplicaciones de compatibilidad con PDF actual puede
generar los siguientes problemas:

¢ Sitiene Acrobat DC instalado antes de actualizar a macOS 10.15, se ejecutara normalmente. Sin embargo, el
instalador de Acrobat DC no es compatible con macOS 10.15, de forma que no es posible instalar Acrobat
DC después de la actualizacion. Ademds, Enfocus PitStop no es compatible con macOS 10.15.

e Sitiene Acrobat XI instalado antes de actualizar a macOS 10.15, no se ejecutard, ya que no es compatible con
este sistema operativo. Le recomendamos que desinstale Acrobat XI antes de actualizar a macOS 10.15. La
desinstalacidon de Acrobat XI no se puede ejecutar en macOS 10.15, de forma que si actualiza a esa versién
con Acrobat XI aun instalado, Acrobat XI no funcionara y no podra desinstalarse.

Si no hay una versién compatible de Acrobat instalada, se generaran los siguientes problemas:

¢ Lafuncién Editar en Acrobat no estara disponible en Fiery Impose, Fiery Compose ni Fiery JobMaster.

e Abrir un trabajo de PostScript con Presentacion preliminar de Fiery, Fiery Impose, Fiery Compose o Fiery
JobMaster puede provocar errores.

o Las plantillas de Fiery Impose que utilicen flujos de trabajo de Tamafio de terminacién definido por el
usuario o Basado en Cuadro de guillotinado podrian generar errores con los trabajos de PostScript.

o Fiery Hot Folders no permite convertir archivos de PostScript a PDF.

Otros problemas

Después de actualizar a MacOS 10.15 desde una version anterior, ejecutar Presentacién preliminar de Fiery,
Fiery Impose, Fiery Compose o Fiery JobMaster puede provocar que aparezca uno de los siguientes mensajes:

e "ICUConverter.framework" dafiard su equipo. Debe moverlo a la Papelera.

e "ICUData.framework" dafiard su equipo. Debe moverlo a la Papelera.

macOS 10.15 identifica erréneamente estos archivos como malware. Para resolver estos problemas, vuelva a
instalar la versién 6.4.0.396 o posterior de Fiery Command WorkStation Package, que es compatible con MacOS
10.15.

Al colocar el ratén sobre los botones de cualquiera de los iconos de control en Presentacién preliminar de Fiery,
Fiery Impose, Fiery Compose o Fiery JobMaster, las sugerencias de la herramienta no se muestran.
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Acceso al disco completo

Debido a los cambios en la forma en que macOS 10.15 gestiona la seguridad, ahora se necesitan mas pasos para
permitir que las aplicaciones de Fiery funcionen correctamente.

Es necesario realizar cambios en la funcién de seguridad de Acceso al disco completo en macOS para que las
aplicaciones Fiery administren las actualizaciones y los archivos de acceso, como las plantillas de Impose y las
carpetas de proceso. Habilite la opcién Acceso al disco completo para las aplicaciones Fiery, como, por ejemplo,
Fiery Command WorkStation.

1 Cierre todas las aplicaciones Fiery.
2 Ir a Preferencias del sistema > Seguridad y privacidad > Privacidad > Acceso al disco completo.

Haga clic en el icono de candado de la esquina inferior izquierda y escriba su contrasena.

H W

Haga clic en el botén +.

5 En la carpeta Aplicaciones, seleccione Fiery Software Manager y Fiery Software Uninstaller y haga clic en
Abrir.

Estas aplicaciones requieren acceso al disco completo para poder mantener y actualizar las aplicaciones Fiery
de su equipo.

6 En la carpeta Aplicaciones, seleccione la aplicacién Fiery Command WorkStation y haga clic en Abrir.

7 Si utiliza Fiery Hot Folders o Fiery Remote Scan, seleccione cada aplicacién y haga clic en Abrir.

Cuando Fiery Hot Folders detecta que se utilizan las carpetas Documentos, Escritorio y Descargas, envia un
mensaje en el que solicita el acceso completo al disco. Este mensaje se sigue mostrando después de que se
haya concedido el acceso. Puede descartar este mensaje y seguir trabajando.

Errores del explorador Safari en macOS 10.15

Si utiliza Safari en macOS 10.15, encontrard errores repetitivos en el explorador al intentar abrir las siguientes
paginas web desde Fiery Command WorkStation. Centro de dispositivo > General > Herramientas:

¢ Restauracion del sistema Fiery
¢ Imagen del sistema Fiery
e Recursos y configuracién de Fiery

Estos errores también pueden producirse al abrir Fiery WebTools en el explorador Safari.

Utilice Chrome o Firefox para acceder a estas paginas web.

Fiery XF en macOS 10.15

Si utiliza Fiery XF con Color Verifier, no actualice a macOS 10.15.

Al conectarse a un servidor Fiery XF, la aplicacién Color Verifier no es compatible con macOS 10.15. Aunque un
mensaje le pida que actualice Color Verifier, no hay ninguna actualizacién disponible en este momento. Haga
clic en Aceptar para cerrar el mensaje.



Notas de la version para el cliente | 41
Fiery Command WorkStation Package, v6.4

Fiery Spot Pro

Fiery Command WorkStation 6.4 le permite administrar colores planos con Fiery Spot Pro, que sustituye a Fiery
Spot-On. Fiery Spot Pro incluye, entre otras, las siguientes mejoras:

o Exportacién de colores planos como formato ASE para utilizarlos como biblioteca de muestras en aplicaciones
de Adobe Creative Suite como Adobe Photoshop.

e Aplicacidn sencilla de ediciones de colores planos a todos los perfiles.

e Creacion de libros de muestras personalizados que se ajusten al tamaio de pagina deseado.

Para ver una lista completa de las mejoras, consulte https://www.efi.com/spotpro.

Fiery Spot Pro se puede instalar en determinados servidores con los siguientes requisitos:

o Software FS200 Pro y posterior

o Fiery Graphic Arts Package, Premium Edition

Mas informacidn en http://fiery.efi.com/spotpro/supported-printers
Si su Fiery server no tiene Fiery Spot Pro habilitado, Fiery Command WorkStation seguira siendo compatible con

Fiery Spot-On.

Consideraciones para el uso de Fiery Spot Pro

e No utilice el simbolo "@" en ningin nombre de color plano.

e Después de iniciar Spot Pro, espere aproximadamente entre 60-120 segundos antes de utilizar la funcién de
btisqueda o cambiar entre perfiles de salida.

e La optimizacién de los colores planos después de varias iteraciones puede dar lugar a diferencias més
pronunciadas entre el color plano original y el color plano convertido.

e Hay un ligero redondeo numérico de los valores L*a*b* convertidos y los valores de CMYK de dispositivo.

o Sihay dos instancias de Spot Pro en diferentes sistemas de usuarios que se conectan al mismo Fiery server
pueden producirse errores si ambos usuarios realizan actividades de edicién.

Actualizar Fiery Command WorkStation Package de forma independiente del software del
sistema Fiery

El software Fiery Command WorkStation se comporta ahora como una aplicacién estandar durante la instalacién.

La instalacién de Fiery Command WorkStation Package en Fiery server es ahora la misma que la que se produce en
un cliente remoto. Esto significa que si es necesario reinstalar o actualizar el software de Fiery Command
WorkStation Package instalado en un Fiery server, los analistas o técnicos no necesitaran el DVD del software del
sistema para hacerlo.

Al instalar Fiery Command WorkStation en Fiery server, no se actualizardn los paquetes de software que se
comparten a través de WebTools o SMB. Ademds, el servicio Fiery no se detiene durante la instalacién/
actualizacién/desinstalacién de Fiery Command WorkStation 6.4.


https://www.efi.com/spotpro
http://fiery.efi.com/spotpro/supported-printers

Notas de la version para el cliente | 42
Fiery Command WorkStation Package, v6.4

Instalacion en un servidor Fiery XF

Al instalar la versién 6.4 de Fiery Command WorkStation Package en un servidor 7. x de Fiery XF, el servidor Fiery
XF se detiene durante la instalacién. Una vez terminada la instalacidn, el Fiery XF se reiniciarad automdticamente.

Aplicacion de 64 bits

Fiery Command WorkStation 6.4 (CWS) es una aplicacién nativa de 64 bits para las plataformas MacOS y Windows.

No se admiten los sistemas operativos de 32 bits en CWS 6.4. Si Fiery Software Manager ya se estd ejecutando Fiery
Software Manager en un sistema operativo de 32 bits, como la version de 32 bits de Windows 7, no se mostraran las
notificaciones de actualizacién del paquete 6.4. Si intenta instalar esta versién de Fiery Software Manager en un
sistema operativo de 32 bits, se producira un error de compatibilidad y Fiery Software Manager no se ejecutara. Para
ver los sistemas operativos admitidos, consulte http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite y Fiery Command WorkStation 6.4

Fiery Color Profiler Suite 5.0 (CPS) y versiones anteriores no son plenamente compatibles con Fiery Command
WorkStation Package 6.4 (CWS) en impresoras de hojas. Le recomendamos que se actualice a Fiery Color Profiler
Suite 5.1.

Al utilizar CPS 5.0 con CWS 6.4, puede experimentar los siguientes problemas:

e Siaparece en CWS el mensaje “Conecte el espectrofotémetro a su ordenador” mientras CPS estd abierto, cierre
CPS y haga clic en Aceptar para continuar.

e Después de crear una nueva configuracién de calibracién en Calibrator, el botén Crear nuevo perfil para iniciar
CPS se encuentra oculto. Este problema se soluciona al actualizarse a CPS 5.1.

Ruta de ubicacion de plantilla Impose

La ruta de ubicacién de la plantilla Impose se ha eliminado de las preferencias de Fiery Hot Folders. En su lugar,
Fiery Hot Folders utiliza la ruta de plantilla Impose que usa Fiery Impose, y que esta definida en Fiery Impose >
Editar > Preferencias.

Mejoras al definir valores por omision
o En Definir valores por omision, hay un nuevo tamafo de papel de salida por omisién denominado Igual que el
tamano de trabajo.

¢ Al bloquear la opcién Igual que el tamafio de trabajo se produce un resultado no deseados, lo que provoca que se
omita el estado bloqueado.

¢ La opcidn Igual que el tamano de trabajo para el Tamafio de papel de salida no esta disponible para papeles
mezclados, imposicidn ni flujos de trabajo de Booklet Maker.
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Mejoras en las propiedades del trabajo

En Fiery Command WorkStation 6.4, puede iniciar las Propiedades del trabajo en dos segundos o menos.

Al abrir la ventana Propiedades del trabajo de cualquier trabajo, se muestran todos los valores por omisién. Al
hacer clic en funciones como Paper Catalog, FreeForm y la barra de control, la configuracién de estas areas se
rellenara automadticamente.

Cuando las propiedades del trabajo tienen que mostrar mas de 500 entradas de Paper Catalog, al hacer clic en la
lista de Paper Catalog hay un retraso de aproximadamente 8-80 segundos hasta que la ventana se actualiza. Si
hay més de 5000 entradas, el retraso sera de unos 80 segundos.

Al aplicar una curva a un trabajo en Fiery ImageViewer, eliminar la curva y, a continuacién, examinar las
propiedades del trabajo, el nombre de la curva eliminada seguira apareciendo como asociado al trabajo. Sin
embargo, al hacer clic en la lista Ediciones de ImageViewer, se queda vacia. Si no selecciona una curva disponible
de Fiery ImageViewer, se conservaran los valores de trabajo originales de la curva.

e También se produce un comportamiento similar al de la lista de Fiery ImageViewer vacia en otras dreas de
Propiedades del trabajo: Perfil de salida, Origen RGB, Origen CMYK, Utilizar grupo de colores planos, Barra de
control, Crear maestroy Utilizar maestro.

Aunque una opcién o configuracién de Paper Catalog no sea valida, no aparecerd ningiin mensaje de error en
estas situaciones:

e Al iniciar sesién en Fiery Command WorkStation y ver las propiedades de un trabajo que tenga una
configuracion de trabajo Paper Catalog vélida.

e Al hacer clic en la lista de entradas de Paper Catalog en las propiedades del trabajo y seleccione cualquier
opcion de Paper Catalog de la lista.

e Al restablecer Paper Catalog a la configuracion de fabrica desde Fiery Command WorkStation.

e Al seleccionar las propiedades de un trabajo que ya tiene la configuracion de trabajo de Paper Catalog.

Problemas solucionados en Fiery Command WorkStation Package v6.4.0.512

Fiery Command WorkStation

Una plantilla de Impose con el nombre predefinido Marcas con un gran nimero de caracteres de varios bytes a
veces provocaba que Fiery Command WorkStation dejara de responder.

En los equipos macOS, con el idioma del sistema operativo configurado como francés o alemdn, Fiery Calibrator
dejaba de responder antes de terminar la calibracion.

Problemas solucionados en Fiery Command WorkStation Package 6.4.0.500

Fiery Command WorkStation

En un sistema en japonés, al imprimir una pagina de prueba de calibracién mientras creaba una nueva
calibracién, o al imprimir una pagina de prueba de calibracién desde el Administrador de calibraciones, el
nombre de la calibracién y el nombre del perfil de salida de la pagina de prueba eran ilegibles.

No podia crear un conjunto de calibracién con una entrada Paper Catalog como origen de papel.
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e En un sistema en japonés, si reiniciaba el Fiery server, no podia guardar los valores predefinidos del trabajo
creados en el Centro de dispositivo.

e Al realizar una recalibracion, la pagina de prueba de calibracién comenzaba a procesarse, pero nunca se
imprimia.

Fiery Command WorkStation Package 6.4.0.471

Problemas solucionados en Fiery Command WorkStation Package 6.4.0.471

Fiery Command WorkStation

e Lavisualizacién de las miniaturas se retardé en los paneles Vista de paginas y Vista de hojas de Fiery Impose y

Fiery Compose.

¢ Sitiene mas de 300 plantillas de Fiery Impose, la seleccién de una plantilla Impose desde Propiedades del
trabajo > Disefio > Impose > Plantillas hizo que Fiery Command WorkStation 6.4 dejara de responder.

44

e No se podia utilizar la opcién de Busqueda avanzada en Fiery Command WorkStation para buscar trabajos que

tuvieran tipos de soportes estucados o no estucados.

Fiery XF

e Para imprimir un trabajo escalado con marcas de corte, tuvo que mover el trabajo manualmente en el papel en

Job Editor y cambiar las posiciones X e Y del trabajo.

Problema conocido en Fiery Command WorkStation Package 6.4.0.471

Fiery Command WorkStation

e Los colores planos que se definen mediante caracteres no ASCII no son compatibles con las impresoras de hojas.

Problemas solucionados en Fiery Command WorkStation Package 6.4.0.434
Fiery Command WorkStation

¢ Después de actualizar a Fiery Command WorkStation 6.4, no se podia imprimir un trabajo desde Fiery
Command WorkStation utilizando tamafos de papel personalizados creados en la impresora.

e Después de actualizar a Fiery Command WorkStation 6.4, no podia aplicar vifietas en documentos de Microsoft

Word.

e Aparecia un mensaje de error incorrecto cuando iniciaba Fiery Impose, Fiery Compose o Fiery JobMaster con la

carpeta de inicio del usuario establecida como carpeta de red.

o Fiery Hot Folders solia descartar la estructura de carpetas al realizar copias de seguridad y restaurar desde
estructuras de carpeta de multiples niveles. Actualmente, la estructura de carpetas de Fiery Hot Folders se
mantiene después de restaurar desde una copia de seguridad.
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Fiery XF

El ndmero de actualizaciones de Fiery XF al dia aumentaba si Fiery Command WorkStation se ejecutaba
continuamente en un ordenador cliente con Windows.

En Color Tools > - Configuracion, el valor de medias tintas Tramado estocastico (SE2) siempre cambiaba a
Difusién de errores (SE1).

En Color Tools > - Limite total de tinta, después de definir la configuracién de grafico personalizado, no se podia
imprimir el grafico de Limite total de tinta (TIL). Aparecia un mensaje de error que indicaba que los valores de la
configuracion sobrepasaban el tamaiio del soporte.

Al actualizar a Fiery Command WorkStation 6.4, se eliminaba la carpeta C:\ProgramData\Fiery\Fiery XF\Client
\Working.

Nota: No elimine ninguna de las preferencias definidas cuando desinstale la versién actual de Fiery Command
WorkStation y actualice a la versién mds reciente. Si se eliminan las preferencias, se desinstalara la carpeta C:
\ProgramData\Fiery\Fiery XF\Client\Xorking, que puede provocar la pérdida de datos de trabajo importantes
(solo en Windows).

Problemas solucionados en la version 6.4.0.358 de Fiery Command WorkStation
Package

Fiery Command WorkStation

En Fiery Impose, con un valor de desplazamiento especificado, si cambié de la marca de corte estandar a la
japonesa, se aplic6 una sola marca de recorte en las ventanas Presentacion preliminar del trabajo y Vista de hojas.

En Fiery Impose, cuando creé una plantilla para un PDF de tamaio de pagina mezclado con posicionamiento de
Alinear al centro, la configuracién de la plantilla no se aplicé correctamente al trabajo. Para utilizar la plantilla
correctamente con la salida prevista, vuelva a crear la plantilla.

Las pestarias no utilizadas de un trabajo JobMaster no se expulsaron por la bandeja especificada.

Cuando creé un nuevo perfil de calibracién mediante la duplicacién y el cambio de nombre de un perfil
existente, las propiedades del nuevo perfil no coincidian con las del perfil original.

Las miniaturas de presentacion preliminar de paginas no se generan en Fiery Preview, Fiery Impose, Fiery
Compose ni Fiery JobMaster.

Fiery XF

Cuando se utiliza el cortador MATIC con trabajos de Pasar a siguiente y repetir, las posiciones de las marcas de
corte que aparecen en Job Editor no coinciden con las posiciones de marca de corte de la salida.

Un nombre de usuario del sistema que contenia caracteres acentuados (como el acento agudo) solia provocar
que Server Manager dejara de responder. Ademds, si cambi la carpeta de trabajo a un nombre de carpeta que
contenia caracteres cirilicos, no se podia ubicar la nueva carpeta.

La tarjeta grafica NVIDIA GeForce GTX1660 provocé que Server Manager y Job Editor dejaran de responder.

Fiery Command WorkStation Package 6.4.0.321

Problemas solucionados en Fiery Command WorkStation Package 6.4.0.321

Se han corregido los problemas siguientes:
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Fiery Command WorkStation

Al editar las curvas de color de un perfil de salida existente en el Centro de dispositivo > Recursos > Perfiles >
Perfiles de salida, no se conservaban los cambios.

Al restaurar Hot Folders desde un archivo de copia de seguridad, Hot Folders no podia procesar algunos
archivos.

Fiery XF

En Job Editor, las marcas de corte de los trabajos de anidamiento y fotoimpresién de repeticion ya no aparecen
en los méargenes no imprimibles de la impresora.

Ahora puede guardar correctamente las fuentes y métodos de contorno de corte como un valor predefinido.

El botén de corte Contorno ahora esté disponible para los dispositivos de impresion y corte en los sistemas
operativos MacOS.

Cuando se recorta un trabajo después de la rotacidn, las dimensiones se invierten.

El margen del recorte se limité previamente a 1000 cm. El margen maximo del recorte ahora es el mismo que la
anchura/altura del trabajo.

Al editar un archivo VPC en Color Tools, se muestran las curvas de todos los canales de color, aunque haya
seleccionado solo una canal de color.

Problema conocido en Fiery Command WorkStation Package 6.4.0.321

Fiery Command WorkStation

En los equipos macOS, no se muestran sugerencias de herramientas para ninguno de los iconos de control de
Fiery Preview, Fiery Impose, Fiery Compose y Fiery JobMaster.

Problemas solucionados en Fiery Command WorkStation Package v6.4.0.261 SP1

Antes, al iniciar Fiery Command WorkStation inmediatamente después de Fiery server y seleccionar una bandeja
apiladora (u otra opcién instalable) en Propiedades del trabajo, la opcion a veces no se mostraba como instalada.
Ahora se muestra la configuracion correcta.

Tras actualizar a Fiery Command WorkStation 6.4 en macOS y al conectar con el Fiery server por primera vez,
Fiery Command WorkStation a veces dejaba de responder y se cerraba. Este problema se ha solucionado.

Al intentar abrir las Propiedades del trabajo, estas se cerraban de forma inesperada si Terminacién > Hendidura
se habia agregado a la pestaia Acceso rapido antes de actualizar a Fiery Command WorkStation 6.4. Este
problema se ha solucionado.
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Este documento contém informagdes importantes sobre esta versdo. Certifique-se de fornecer essas informacoes a
todos os usudrios antes de prosseguir com a instalacéo.

Sobre esta versao
Os aplicativos a seguir estdo incluidos nesta versao:
o Fiery Command WorkStation Package v6.4.0.512

* Fiery Command WorkStation v6.4.00.62
e Fiery Hot Folders para Mac v4.00.0.31
e Fiery Hot Folders para Windows v4.00.0.31

o Fiery Software Manager v4.3.0.13

Upgrade

Esse instalador fard o upgrade de qualquer Fiery Command WorkStation Package existente para o pacote mais
recente contendo a Fiery Command WorkStation e o Fiery Hot Folders. Opcionalmente, vocé pode instalar o Fiery
Remote Scan usando o Fiery Software Manager.

Nota: A Fiery Command WorkStation Package v6.4.0.512 ndo é compativel com o macOS Catalina 10.15. Para usar a
Fiery Command WorkStation no macOS Catalina 10.15, nio atualize o Fiery Command WorkStation Package
existente para o pacote mais recente ou use a Fiery Command WorkStation Package 6.5.

Para fazer o upgrade da Fiery Command WorkStation versdo 5.x para 6.4, primeiro faca o upgrade para a Command
WorkStation 6.3 (disponivel no Fiery Software Manager) e, em seguida, faga o upgrade para a versdo 6.4.

O Fiery Command WorkStation Package é compativel com Fiery servers que executam o FS100 e versoes
posteriores, o Fiery proServer e o Fiery XF 7.0 e versoes posteriores. O pacote nio se conecta a:

o Fiery servers que executam o Fiery System 9/9e Rel2 e o software System 10 e versoes anteriores.
o Servidores Fiery XF 6.x e versdes anteriores

e Servidores Fiery Central

Se vocé precisa ter acesso a esses produtos, ndo faga a atualizagdo. O pacote do Fiery Extended Applications ainda
estd disponivel em www.efi.com/cws. Para obter uma lista completa de impressoras compativeis com cutsheet,
consulte http://fiery.efi.com/CWS/supported-printers.
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Para obter mais informacoes sobre as especificacoes técnicas, consulte www.efi.com/cws.

O que ha de novo?

Para obter mais informagdes sobre os novos recursos, acesse http://fiery.efi.com/CWS/Whats-New.

Informacgoes do macOS 10.15 (Catalina)

Visualizacao do Fiery, Fiery Impose, Fiery Compose ou Fiery JobMaster no macOS 10.15

Kit de aplicativos de suporte em PDF
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O kit de aplicativos de suporte em PDF (fornecido pela EFI), que consiste no Adobe Acrobat e Enfocus PitStop,

ndo é compativel com o macOS 10.15 (Catalina). Se vocé usa o Acrobat e/ou o PitStop, ndo atualize para o
macOS 10.15. Nas novas instalacoes, o instalador de Aplicativos de suporte em PDF nio é executado.

Fazer a atualizacdo do macOS 10.15 enquanto o kit de aplicativos de suporte em PDF atual estiver em uso pode

resultar nos seguintes problemas:

e Sevocé ja tiver instalado o Acrobat DC antes de fazer a atualizacdo para o macOS 10.15, ele serd executado

normalmente. Entretanto, o instalador do Acrobat DC néo é compativel com o macOS 10.15, portanto, ndo

é possivel fazer novas instalagdes do Acrobat DC. Além disso, o Enfocus PitStop incluido ndo é compativel
com o macOS 10.15.

e Sevocé ja tiver instalado o Acrobat XI antes de fazer a atualizagdo para o macOS 10.15, ele ndo sera
executado pois ndo é compativel com o macOS 10.15. Recomendamos desinstalar o Acrobat XI antes de

atualizar para o macOS 10.15. O desinstalador do Acrobat XI ndo funcionard no macOS 10.15. Portanto, se
vocé atualizar para o macOS 10.15 com o Acrobat XI ainda instalado, o sistema ficard em um estado em que

o Acrobat XI ndo funciona e nio pode ser desinstalado.
Se uma versdo compativel do Acrobat ndo estiver instalada, os seguintes problemas acontecerio:

¢ A funcéo Editar no Acrobat néo esta disponivel no Fiery Impose, Fiery Compose e Fiery JobMaster.

e Abrir uma tarefa do PostScript com a Visualizagdo Fiery na Fiery Impose, Fiery Compose ou Fiery JobMaster

pode resultar em um erro.

e Os modelos do Fiery Impose que utilizam os fluxos de trabalho Tamanho do acabamento definido pelo
usudrio ou Baseado na caixa de aparamento podem néo funcionar corretamente com as tarefas do
PostScript.

e O Fiery Hot Folders nio oferece a op¢io de converter arquivos do PostScript em PDF.

Outros problemas

Depois de atualizar para o MacOS 10.15 de uma versdo mais antiga do MacOS, iniciar a visualiza¢do Fiery, Fiery

Impose, Fiery Composeou Fiery JobMaster pode fazer com que uma das seguintes mensagens seja exibida:

e "ICUConverter.framework" danificara o computador. Vocé deve mové-lo para o lixo.

e "ICUData.framework" danificard o computador. Vocé deve mové-lo para o lixo.

O macOS 10.15 identifica equivocadamente esses arquivos como malware. Para resolver esses problemas,

reinstale a Fiery Command WorkStation Package versdo 6.4.0.396 ou posterior, que é compativel com o MacOS

10.15.
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Ao passar o mouse sobre os botdes de qualquer um dos icones de controle na Visualizagdo Fiery, Fiery Impose,
Fiery Compose ou Fiery JobMaster, as dicas de ferramenta nio sdo exibidas.

Acesso total ao disco
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Devido a alteragdes no modo como o macOS 10.15 gerencia a seguranca, agora hd etapas adicionais necessérias

para permitir que os aplicativos do Fiery funcionem corretamente.

Vocé precisa fazer alteragdes no recurso de seguranca Acesso total ao disco no MacOS para que os aplicativos
do Fiery gerenciem atualiza¢des e acessem arquivos, como modelos do Impose e Hot Folders. Ative o Acesso
total ao disco para abrir aplicativos do Fiery como o Fiery Command WorkStation.

1 Feche todos os aplicativos do Fiery.

2 V4 para Preferéncias do sistema > Seguranca e privacidade > Privacidade > Acesso total ao disco.
3 Clique no icone do cadeado no canto inferior esquerdo e digite sua senha.

4 Clique no botéo +.
5

Na pasta Aplicativos, selecione Fiery Software Manager e o Fiery Software Uninstaller e clique em Abrir.

Esses aplicativos exigem acesso total ao disco para manter e atualizar os aplicativos do Fiery no seu
computador.

6 Na pasta Aplicativos, selecione o aplicativo Fiery Command WorkStation e clique em Abrir.

7 Sevocé usar o Fiery Hot Folders ou Fiery Remote Scan, selecione cada aplicativo e clique em Abrir.

Quando o Fiery Hot Folders detecta que as pastas Documentos, Desktop e Downloads estdo sendo usadas,

ele envia uma mensagem solicitando acesso total ao disco. Essa mensagem é exibida mesmo apds o acesso ter

sido concedido. Vocé pode descartar essa mensagem e continuar trabalhando.

Erros do browser Safari no macOS 10.15

Ao usar o Safari no macOS 10.15, vocé encontrara erros de browser repetitivos ao tentar abrir as seguintes
paginas da Web no Fiery Command WorkStation Centro de dispositivos > Geral > Ferramentas:

e Restauracgdo do sistema Fiery
e Imagem do sistema Fiery
e Recursos e configuragdes do Fiery

Esses erros também podem ocorrer ao abrir o Fiery WebTools no navegador Safari.

Use o Chrome ou o Firefox para acessar essas paginas da Web.

Fiery XF no macOS 10.15

Se vocé usa a Fiery XF com o Color Verifier, ndo atualize para o MacOS 10.15.

Ao conectar-se a um servidor Fiery XF, o aplicativo Color Verifier ndo sera compativel com o MacOS 10.15.
Embora uma mensagem solicite a atualiza¢do do Color Verifier, ndo hd nenhuma atualizacéo disponivel no
momento. Clique em OK para fechar a mensagem.
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Fiery Spot Pro

A Fiery Command WorkStation 6.4 permite gerenciar cores especiais com o Fiery Spot Pro, que substitui o Fiery
Spot-On. O Fiery Spot Pro inclui as seguintes melhorias:

o Exporta cores especiais como formato ASE para usar como uma biblioteca de amostras no pacote de aplicativos
Adobe Creative, como o Adobe Photoshop.

e Aplica facilmente modificagdes de cores especiais a todos os perfis.

e Cria livros de amostras personalizados para ajustar o tamanho desejado da pagina.

Para ver uma lista completa de melhorias, consulte https://www.efi.com/spotpro.

O Fiery Spot Pro esta disponivel para alguns servidores com os seguintes requisitos:

o Software FS200 Pro e posterior

o Fiery Graphic Arts Package, Premium Edition

Saiba mais em http://fiery.efi.com/spotpro/supported-printers.

Se o Fiery Spot Pro néo estiver habilitado no Fiery server, a Fiery Command WorkStation continuara sendo
compativel com o Fiery Spot-On.

Consideragdes sobre como usar o Fiery Spot Pro

e Nio use o simbolo "@" no nome de cores especiais.

e Depois de iniciar Spot Pro, aguarde aproximadamente 60-120 segundos antes de usar a funcéo de pesquisa ou
alternar os perfis de saida.

e A otimizacio de cores especiais ap0s virias iteracdes pode resultar em diferencas mais pronunciadas entre a cor
especial original e a cor especial convertida.

e H& um pequeno arredondamento numérico de valores L*a*b* convertidos e valores de CMYK do dispositivo.

e Duas instancias do Spot Pro em sistemas de usudrio diferentes conectando-se ao mesmo Fiery server podem
causar erros se os dois usudrios executarem operagoes de edigéo.

Atualizar o Fiery Command WorkStation Package independentemente do software de
sistema Fiery

O software do Fiery Command WorkStation agora se comporta como um aplicativo padrdo durante a instalacao.

Agora, instalar o Fiery Command WorkStation Package em um Fiery server é semelhante a instalacdo em um cliente
remoto. Isso significa que, se o software do Fiery Command WorkStation Package instalado em um Fiery server
exigir uma reinstalacdo ou upgrade, os analistas ou técnicos néo precisardo dos DVDs do software de sistema.

Ao instalar o Fiery Command WorkStation na Fiery server, a instalagdo néo atualizara os pacotes de software que sdo
compartilhados por meio de WebTools ou SMB. Além disso, o servi¢o do Fiery ndo serd interrompido durante a
instalacdo/upgrade/desinstalacdo da Fiery Command WorkStation 6.4.


https://www.efi.com/spotpro
http://fiery.efi.com/spotpro/supported-printers

Notas de Versdo do Cliente | 51
Fiery Command WorkStation Package, v6.4

Instalacao no servidor Fiery XF

Ao instalar a Fiery Command WorkStation Package versdo 6.4 em um servidor Fiery XF 7.x, o servidor Fiery XF para
de funcionar enquanto a instalagdo estd em andamento. Apés a concluséo da instalacéo, o Fiery XF é reinicializado
automaticamente.

Aplicativo de 64 bits

A Fiery Command WorkStation 6.4 (CWS) é um aplicativo de 64 bits nativo para as plataformas Windows e macOS

Sistemas operacionais de 32 bits ndo sdo compativeis com a CWS 6.4. Se o Fiery Software Manager ja estiver sendo
executado em um sistema operacional de 32 bits, como o Windows 7, ele nido exibir4 as notificacdes sobre a
atualizagdo do pacote CWS 6.4. Ao tentar executar essa versio do Fiery Software Manager em um sistema
operacional de 32 bits, vocé verd um erro de compatibilidade e o Fiery Software Manager nio sera executado. Para
ver os sistemas operacionais compativeis, consulte http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite e Fiery Command WorkStation 6.4

O Fiery Color Profiler Suite 5.0 (CPS) e as versdes anteriores ndo sdo totalmente compativeis com o Fiery Command
WorkStation Package 6.4 (CWS) para impressoras de folhas soltas. Recomendamos atualizar para o Fiery Color
Profiler Suite 5.1.

Ao usar o CPS 5.0 com a CWS 6.4, vocé pode enfrentar os seguintes problemas:

e Sevocé visualizar a mensagem na CWS “Conecte o espectrofotometro ao seu computador” enquanto o CPS
estiver aberto, feche o CPS e clique em OK para continuar.

e Depois de criar uma nova configuracio de calibragem no Calibrator, o botdo Criar novo perfil que inicia o CPS
ficard oculto. Esse problema é resolvido apds a atualizacdo para o CPS 5.1.

Rota de localizacao do modelo do Impose

A rota de localizagdo do modelo do Impose foi removida das preferéncias da Fiery Hot Folders. Em vez disso, o Fiery
Hot Folders usa a rota do modelo do Impose usada pelo Fiery Impose, que é definida em Fiery Impose > Editar >
Preferéncias.

Melhorias da opcao Definir padroes

e Em Definir padrdes, um novo padriao de Tamanho do papel de saida nomeado Igual ao tamanho da tarefa esta
disponivel.

» Bloquear a op¢do Igual ao tamanho da tarefa causa resultados indesejaveis e o estado bloqueado é ignorado.

e A opc¢ido tamanho da tarefa para o tamanho do papel de saida néo estd disponivel para midia mista, imposi¢do
Booklet Maker ou fluxos de trabalho.


http://fiery.efi.com/cws-specifications
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Melhorias nas Propriedades da tarefa

Na Fiery Command WorkStation 6.4, vocé pode iniciar as Propriedades da tarefa em 2 segundos ou menos.

Ao abrir a janela Propriedades da tarefa para qualquer tarefa, ela exibe todos os padrdes. Ao clicar em fungdes
como Paper Catalog, FreeForm e barra de controle, as configuracdes dessas dreas serdo preenchidas.

Quando as Propriedades da tarefa precisam exibir mais de 500 entradas do Paper Catalog, clicar nos resultados
da lista do Paper Catalog resulta em um atraso de aproximadamente 8 a 80 segundos para que a janela seja
atualizada. Se houver mais de 5.000 entradas, o atraso serd de 80 segundos.

Ao aplicar uma curva no Fiery ImageViewer a uma tarefa, exclua a curva e, em seguida, inspecione as
propriedades da tarefa e se 0 nome da curva excluida ainda é exibido como estando associado a tarefa.
Entretanto, ao clicar na lista Edi¢des do ImageViewer, ela fica em branco. Se vocé néo selecionar uma curva do
Fiery ImageViewer disponivel, as configuragoes originais da tarefa para a curva serdo mantidas.

e Um comportamento semelhante a lista do Fiery ImageViewer em branco também ocorre nessas outras dreas
das Propriedades da tarefa: Perfil de saida, Origem RGB, Origem CMYK, Usar grupo especial, Barra de controle,
Criar mestre e Usar mestre.

Mesmo que uma op¢ao ou configuracdo do Paper Catalog seja invdlida, uma mensagem de erro nio ser4 exibida
nestes casos:

* Vocé faz logon na Fiery Command WorkStation e visualiza propriedades de uma tarefa que tenha
configuragdes vélidas do Paper Catalog.

¢ Clique na lista de entradas do Paper Catalog nas propriedade da tarefa e selecione qualquer op¢io do Paper
Catalog na lista.

e Vocé restaura o Paper Catalog para as configuragdes de fibrica na Fiery Command WorkStation.

e Vocé seleciona propriedades de uma tarefa que ji tem configuragoes de tarefa do Paper Catalog.

Problemas corrigidos na Fiery Command WorkStation Package v6.4.0.512

Fiery Command WorkStation

Um modelo do Impose com o nome da predefini¢cdo Marcas contendo um grande niimero de caracteres de varios
bytes as vezes fazia com que o Fiery Command WorkStation parasse de responder.

Em computadores com macOS, com o idioma do sistema operacional definido como francés ou alemio, o Fiery
Calibrator parava de responder antes de concluir a calibragem.

Problemas corrigidos na Fiery Command WorkStation Package v6.4.0.500

Fiery Command WorkStation

Em um sistema no idioma japonés, quando vocé imprimia uma pégina de teste de calibragem ao criar uma nova
calibragem ou quando imprimia uma pagina de teste de calibragem no Gerenciador de calibragem, o nome da
calibragem e o nome do perfil de saida na pagina de teste apareciam ilegiveis.

Naio era possivel criar um conjunto de calibragem com uma entrada do Paper Catalog como origem do papel.
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e Em um sistema no idioma japonés, se vocé reinicializasse a Fiery server, ndo era possivel salvar as predefini¢oes
de tarefa criadas no Centro de dispositivos.

e Quando vocé realizava uma recalibragem, a pagina de teste de calibragem comecava a ser processada, mas ndo
era impressa.

Fiery Command WorkStation Package v6.4.0.471

Problemas corrigidos no Fiery Command WorkStation Package no v6.4.0.471

Fiery Command WorkStation

e As miniaturas apareciam com atraso nos painéis Visualizacdo da pagina e Visualizacdo da folha do Fiery Impose
e do Fiery Compose.

¢ Sevocé tiver mais de 300 modelos do Fiery Impose, selecione um modelo de imposi¢do em Propriedades da
tarefa > Layout > Impose > Modelos faziam a Fiery Command WorkStation 6.4 parar de responder.

o Nao era possivel usar a opc¢éo Pesquisa avancada na Fiery Command WorkStation para pesquisar trabalhos com
tipos de midia revestidos ou néo revestidos.

Fiery XF

e Para imprimir uma tarefa dimensionada com marcas de corte, era preciso mover a tarefa manualmente na midia
em Job Editor e alterar as posicoes X e Y da tarefa.

Problema conhecido no Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

e As cores especiais definidas com caracteres ndo ASCII ndo sdo compativeis com impressoras de folhas soltas.

Problemas corrigidos na Fiery Command WorkStation Package v6.4.0.434
Fiery Command WorkStation

¢ Depois de atualizar para a Fiery Command WorkStation 6.4, ndo era possivel imprimir uma tarefa a partir do
Fiery Command WorkStation usando tamanhos de papel personalizados criados na impressora.

o Depois de atualizar para a Fiery Command WorkStation 6.4, ndo era possivel aplicar marcadores em documentos
do Microsoft Word.

o Uma mensagem de erro incorreta ocorria ao iniciar o Fiery Impose, Fiery Compose ou o Fiery JobMaster com a
pasta inicial do usudrio definida como uma pasta de rede.

e O Fiery Hot Folders descartava a estrutura de pasta ao fazer backup e restaurar de estruturas de pastas profundas
de vérios niveis. A estrutura de pasta do Fiery Hot Folders agora é mantida ap6s a restauragdo de um backup.

Fiery XF

e A contagem de atualizag¢des do Fiery XF por dia aumentaria se o Fiery Command WorkStation estivesse sendo
executado continuamente em um computador cliente Windows.

e Em Color Tools > Configuragées, a configuracdo de meio-tom Triagem Estocdstica (SE2) sempre voltava para
Difuséo de erro (SE1).
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Em Color Tools > Limite total de tinta, depois de definir a configuracéo do gréfico personalizado, ndo era possivel
imprimir o gréfico Limite total de tinta (TIL). Uma mensagem de erro afirmava que as configuragdes excediam o
tamanho da midia.

A atualizagéo para a Fiery Command WorkStation 6.4 fazia com que a pasta C:\ProgramData\Fiery\Fiery XF
\Client\Working fosse excluida.

Nota: Nao exclua nenhuma das preferéncias ao desinstalar a versdo atual da Fiery Command WorkStation e
atualizar para a versdo mais recente. A exclusdo de preferéncias fard com que a pasta C:\ProgramData\Fiery\Fiery
XF\Client\Working seja desinstalada, o que pode resultar na perda de dados importantes da tarefa (aplicavel
somente para Windows).

Problemas corrigidos no Fiery Command WorkStation Package v6.4.0.358

Fiery Command WorkStation

No Fiery Impose, com um valor de offset especificado, se vocé mudasse da marca de corte padrdo para a marca
de corte japonesa, uma tinica marca de aparagem era aplicada nas janelas Visualizacdo da tarefa e Visualizacao da
folha.

No Fiery Impose, quando um modelo de PDF de tamanho de pagina misto com o posicionamento Alinhar ao
centro era criado, as configuragdes do modelo ndo eram aplicadas corretamente a tarefa. Para usar o modelo com
sucesso com a saida esperada, recrie o modelo.

Os separadores ndo usados de uma tarefa do JobMaster ndo foram ejetados na bandeja especificada.

Quando um novo perfil de calibragem era criado duplicando e renomeando um perfil existente, as propriedades
do novo perfil ndo correspondiam as do perfil original.

As miniaturas de visualizacdo da pagina ndo eram geradas no Fiery Preview, Fiery Impose, Fiery Compose e Fiery
JobMaster.

Fiery XF

Ao usar a guilhotina MATIC com tarefas Avancar e repetir, as posi¢des da marca de corte exibidas no Job Editor
nio correspondem as posi¢des da marca de corte na saida.

Um nome de usudrio do sistema contendo caracteres acentuados (como acento agudo) por vezes fazia com que o
Server Manager parasse de responder. Além disso, se vocé alterasse a pasta de trabalho com um nome de pasta
contendo caracteres cirilicos, a nova pasta nio era localizada.

A placa grafica NVIDIA GeForce GTX1660 fazia com que o Server Manager e o Job Editor parassem de
responder.

Fiery Command WorkStation Package v6.4.0.321

Problemas corrigidos no Fiery Command WorkStation Package v6.4.0.321

Os seguintes problemas foram corrigidos:

Fiery Command WorkStation

Ao editar as curvas de cor de um perfil de saida existente em Centro de dispositivos > Recursos > Perfis > Perfis
de saida, as alteragdes ndo foram mantidas.

Ao restaurar Hot Folders de um arquivo de backup, o Hot Folders falhou ao processar alguns arquivos.
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Fiery XF

No Job Editor, as marcas de corte para tarefas de encaixar e avancar e repetir ndo sdo mais exibidas nas margens
nio imprimiveis da impressora.

Agora vocé pode salvar corretamente as origens e métodos de contorno de corte como uma predefinicio.

O botdo de corte Contorno agora esta disponivel para dispositivos de impressao e corte em sistemas operacionais
MacOS.

Quando uma tarefa for cortada apéds a rotacio, as dimensdes foram invertidas.

A margem de corte foi previamente limitada a 1000 cm. A margem de corte maxima agora é igual a largura/
altura da tarefa.

Ao editar um arquivo VPC no Color Tools, as curvas de todos os canais de cor foram exibidas, mesmo se vocé
selecionou apenas um canal de cor.

Problema conhecido no Fiery Command WorkStation Package v6.4.0.321

Fiery Command WorkStation

Nos computadores macOS, as dicas de ferramenta néo sdo exibidas para nenhum dos icones de controle no Fiery
Preview, no Fiery Impose, no Fiery Compose e no Fiery JobMaster.

Problemas corrigidos no Fiery Command WorkStation Package v6.4.0.261 SP1

Quando vocé iniciava a Fiery Command WorkStation imediatamente apoés a inicializacdo do Fiery server e
selecionava uma bandeja do empilhador (ou outra opgéo instalédvel) nas Propriedades da tarefa, as vezes a opgéo
aparecia como ndo instalada. Agora, as configuragdes corretas sdo exibidas.

Quando vocé atualizava para a Fiery Command WorkStation 6.4 no macOS e a conectava ao Fiery server pela
primeira vez, as vezes a Fiery Command WorkStation parava de responder e fechava. Esse problema ja foi
corrigido.

Quando vocé tentava abrir as Propriedades da tarefa, a janela fechava inesperadamente se Acabamento > Vinco
fossem adicionados a guia Acesso rapido antes da atualizacdo para a Fiery Command WorkStation 6.4. Esse
problema jé foi corrigido.
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Versienotities voor de klant
Fiery Command WorkStation Package, v6.4

Dit document bevat belangrijke informatie over deze versie. Zorg dat deze informatie bij alle gebruikers bekend is
voordat u doorgaat met de installatie.

Over deze release
Deze release bestaat uit de volgende toepassingen:
o Fiery Command WorkStation Package v6.4.0.512

* Fiery Command WorkStation v6.4.00.62
e Fiery Hot Folders voor Mac v4.00.0.31
e Fiery Hot Folders voor Windows v4.00.0.31

o Fiery Software Manager v4.3.0.13

Bezig met upgraden

Dit installatieprogramma zal een bestaand Fiery Command WorkStation Package upgraden naar het meest recente
pakket met Fiery Command WorkStation en Fiery Hot Folders. U kunt Fiery Remote Scan ook installeren met
behulp van Fiery Software Manager.

Opmerking: Fiery Command WorkStation Package v6.4.0.512 wordt niet ondersteund op macOS Catalina 10.15. Als
u Fiery Command WorkStation op macOS Catalina 10.15 wilt gebruiken, moet u het bestaande Fiery Command
WorkStation Package niet upgraden naar het nieuwste pakket of Fiery Command WorkStation Package 6.5
gebruiken.

Als u wilt upgraden van Fiery Command WorkStation versie 5.x naar 6.4, moet u eerst upgraden naar Command
WorkStation 6.3 (beschikbaar in Fiery Software Manager) en vervolgens upgraden naar versie 6.4.

Fiery Command WorkStation Package ondersteunt Fiery servers met FS100 en hoger, en Fiery proServer en Fiery XF
7.0 en hoger. Het programma maakt geen verbinding met:

o Fiery servers met Fiery System 9/9e Rel2- en System 10-software en vorige versies
o Fiery XF 6.x-servers en eerder

o Fiery Central-servers
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Als u toegang tot deze producten nodig hebt, moet u de upgrade niet uitvoeren. Fiery Extended Applications-pakket
is nog steeds beschikbaar op www.efi.com/cws. Raadpleeg http://fiery.efi.com/CWS/supported-printers voor een
volledige lijst met ondersteunde printers.

Ga voor meer informatie over de technische specificaties naar www.efi.com/cws.

Wat is nieuw?

Ga voor meer informatie over nieuwe functies naar http://Fiery.efi.com/cws/Whats-New.

Informatie over macOS 10.15 (Catalina)

Fiery-voorbeeld, Fiery Impose, Fiery Compose of Fiery JobMaster op macOS 10.15

Pakket met PDF-ondersteuningstoepassingen

Het pakket met PDF-ondersteuningstoepassingen (geleverd door EFI) bestaat uit Adobe Acrobat en Enfocus
PitStop en is niet compatibel met macOS 10.15 (Catalina). Voer geen upgrade uit naar macOS 10.15 als u
Acrobat en/of PitStop gebruikt. Voor nieuwe installaties werkt het installatieprogramma voor PDEF-
ondersteuningstoepassingen niet.

Bij gebruik van het huidige pakket van PDF-ondersteuningstoepassingen kan het uitvoeren van een upgrade naar
macOS 10.15 leiden tot de volgende problemen:

e Acrobat DC zal normaal functioneren als dit al is geinstalleerd voordat u een upgrade uitvoert naar macOS
10.15. Het Acrobat DC-installatieprogramma is echter niet compatibel met macOS 10.15, zodat nieuwe
installatie van Acrobat DC niet mogelijk is. Bovendien wordt de meegeleverde Enfocus PitStop niet
ondersteund op macOS 10.15.

e Acrobat XI zal niet functioneren als dit al is geinstalleerd voordat u een upgrade uitvoert naar macOS 10.15
en wordt hierdoor niet ondersteund. We raden u aan Acrobat XI te verwijderen voordat u de upgrade naar
macOS 10.15 uitvoert. Het Acrobat XI-deinstallatieprogramma werkt niet op macOS 10.15, dus als u een
upgrade uitvoert naar macOS 10.15 terwijl Acrobat XI nog is geinstalleerd, zal Acrobat XI niet werken en
kan dit ook niet worden verwijderd.

Als er geen compatibele versie van Acrobat is geinstalleerd, zijn de volgende problemen mogelijk:

¢ De functie Bewerken in Acrobat is niet beschikbaar in Fiery Impose, Fiery Compose en Fiery JobMaster.

e Bij het openen van een PostScript-taak met Fiery-voorbeeld kan Fiery Impose, Fiery Compose of Fiery
JobMaster een fout veroorzaken.

e Fiery Impose-sjablonen die de workflows Door gebruiker ingesteld afwerkformaat of Op basis van snijkader
gebruiken, werken mogelijk niet goed bij PostScript-taken.

o Fiery Hot Folders biedt niet de mogelijkheid om PostScript-bestanden om te zetten naar PDF.

Overige problemen

Na het bijwerken van een oudere macOS-versie naar macOS 10.15 kan Fiery Impose, Fiery Compose of Fiery
JobMaster een van de volgende berichten veroorzaken bij het opstarten van Fiery-voorbeeld:

e "ICUConverter. framework" zal uw computer beschadigen. Verplaats het naar de prullenmand.

"ICUData.framework" zal uw computer beschadigen. Verplaats het naar de prullenmand.


HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWS/Whats-New
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macOS 10.15 identificeert deze bestanden ten onrechte als malware. U kunt deze problemen oplossen door Fiery
Command WorkStation Package versie 6.4.0.358 of hoger opnieuw te installeren. Deze versie is compatibel met
macOS 10.15.

Wanneer u in Fiery-voorbeeld met de muis over bedieningsknoppen Fiery Impose, Fiery Compose of Fiery
JobMaster beweegt, wordt de knopinfo niet weergegeven.

Volledige schijftoegang

Als gevolg van wijzigingen in de manier waarop macOS 10.15 de beveiliging beheert, zijn er nu extra stappen
nodig om Fiery-toepassingen goed te laten werken.

U moet wijzigingen aanbrengen in de beveiligingsfunctie Volledige schijftoegang in macOS, zodat Fiery-
toepassingen updates kunnen beheren en toegang hebben tot bestanden zoals Impose-sjablonen en
overdrachtmappen. Volledige schijftoegang inschakelen voor Fiery-toepassingen zoals Fiery Command
WorkStation.

1 Sluit alle Fiery-toepassingen.
2 Ga naar Systeemvoorkeuren > Beveiliging en privacy > Privacy > Volledige schijftoegang.

Klik op het slotje linksonder in de hoek en voer uw wachtwoord in.

H W

Klik op de +-knop.

5 Selecteer Fiery Software Manager en de Fiery Software Uninstaller in de map Toepassingen en klik
vervolgens op Openen.

Voor deze toepassingen hebt u volledige schijftoegang nodig om Fiery-toepassingen op uw computer te
kunnen onderhouden en bijwerken.

6 Selecteer de Fiery Command WorkStation-toepassing in de map Toepassingen en klik op Openen.

7 Als u Fiery Hot Folders of Fiery Remote Scan gebruikt, selecteert u elke toepassing en klikt u op Openen.

Wanneer Fiery Hot Folders detecteert dat de mappen Documenten, Bureaublad en Downloads in gebruik
zijn, wordt er een bericht weergegeven waarin volledige schijftoegang wordt gevraagd. Zelfs nadat toegang is
verleend, wordt dit bericht nog steeds weergegeven. U kunt dit bericht negeren en doorgaan met werken.

Browserfouten Safari in macOS 10.15

Als u Safari gebruikt op macOS 10.15, zult u terugkerende browserfouten tegenkomen wanneer u de volgende
pagina's probeert te openen vanaf Fiery Command WorkStation Apparaatcentrum > Algemeen >
Gereedschappen:

o Fiery-systeem herstellen
o Fiery-systeemkopie
e Fiery-hulpbronnen en -instellingen

Deze fouten kunnen ook optreden wanneer u Fiery WebTools opent in de Safari-browser.

Gebruik Chrome of Firefox om deze pagina's te openen.

Fiery XF op macOS 10.15

Voer geen upgrade uit naar macOS 10.15 indien u Fiery XF met Color Verifier gebruikt.



Versienotities voor de klant | 59
Fiery Command WorkStation Package, v6.4

Wanneer u verbinding maakt met een Fiery XF-server, is de toepassing Color Verifier niet compatibel met
macOS 10.15. Hoewel er een bericht wordt weergegeven waarin u wordt gevraagd om Color Verifier bij te
werken, is er op dit moment geen update beschikbaar. Klik op OK om het bericht te sluiten.

Fiery Spot Pro

Met Fiery Command WorkStation6.4 kunt u steunkleuren beheren met Fiery Spot Pro, de vervanger van Fiery Spot-
On. Fiery Spot Pro bevat de volgende verbeteringen en meer:

o Exporteer steunkleuren als ASE-indeling om te gebruiken als stalenbibliotheek in Adobe Creative Suite-
toepassingen zoals Adobe Photoshop.

e Bewerk eenvoudig steunkleuren op alle profielen.

e Maak aangepaste kleurstalen op het door u gewenste paginaformaat.

Voor een volledige lijst met verbeteringen gaat u naarhttps://www.efi.com/spotpro.

Fiery Spot Pro is beschikbaar voor geselecteerde servers met de volgende vereisten:

e FS200 Pro en nieuwere software

o Fiery Graphic Arts Package, Premium Edition

Vind meer informatie ophttp://fiery.efi.com/spotpro/supported-printers.

Als op uw Fiery server Fiery Spot Pro niet is ingeschakeld, blijft Fiery Command WorkStation Fiery Spot-On
ondersteunen.

Overwegingen voor het gebruik van Fiery Spot Pro

e Gebruik het "@"-symbool niet in een steunkleurnaam.

e Wacht na het starten van Spot Pro ongeveer 60-120 seconden voordat u de zoekfunctie gebruikt of van
uitvoerprofiel wisselt.

o Het herhaaldelijk optimaliseren van steunkleuren kan leiden tot grotere verschillen tussen de oorspronkelijke
steunkleur en een geconverteerde steunkleur.

e Geconverteerde L*a*b*-waarden en CMYK-waarden van het apparaat worden licht numeriek afgerond.

e Het gebruik van Spot Pro op twee verschillende gebruikerssystemen die verbinding maken met dezelfde Fiery
server kan tot fouten leiden als beide gebruikers bewerkingen uitvoeren.

Fiery Command WorkStation Package onafhankelijk van Fiery-systeemsoftware bijwerken

Fiery Command WorkStation-software werkt tijdens de installatie nu net als een standaardtoepassing.

Het Fiery Command WorkStation Package installeren op een Fiery server is nu hetzelfde als op een externe client
installeren. Dit betekent dat als de Fiery Command WorkStation Package-software die op de Fiery server is
geinstalleerd een herinstallatie of upgrade vereist, analisten of technici de systeemsoftware-dvd's niet nodig hebben
om dit te doen.

Wanneer u de Fiery Command WorkStation installeert op de Fiery server, verwerkt de installatie geen updates van
de softwarepakketten die worden gedeeld via WebTools of SMB. Ook wordt de Fiery-service niet onderbroken
tijdens de installatie/upgrade/de-installatie van Fiery Command WorkStation 6.4.


https://www.efi.com/spotpro
http://fiery.efi.com/spotpro/supported-printers
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Op de Fiery XF-server installeren

Wanneer u de Fiery Command WorkStation Package versie 6.4 op een Fiery XF 7.X-server installeert, wordt de Fiery
XF-server onderbroken terwijl de installatie wordt uitgevoerd. Nadat de installatie is voltooid, wordt Fiery XF
automatisch opnieuw gestart.

64-bits toepassing

Fiery Command WorkStation 6.4 (CWS) is een systeemeigen 64-bits applicatie voor zowel macOS- als Windows-
platforms.

32-bits besturingssystemen worden niet ondersteund voor CWS 6.4. Als Fiery Software Manager al wordt uitgevoerd
op een 32-bits besturingssysteem zoals Windows 7 32-bit, worden de updatemeldingen voor het CWS 6.4-pakket
niet weergegeven. Als u deze versie van Fiery Software Manager op een 32-bits besturingssysteem probeert te
installeren, ziet u een compatibiliteitsfout en werkt Fiery Software Manager niet. Raadpleeg http://fiery.efi.com/cws-
specifications voor meer informatie over ondersteunde besturingssystemen.

Fiery Color Profiler Suite en Fiery Command WorkStation 6.4

Fiery Color Profiler Suite 5.0 (CPS) en eerdere versies zijn niet volledig compatibel met Fiery Command
WorkStation-pakket 6.4 (CWS) voor cut-sheetprinters. Wij raden u aan de update naar Fiery Color Profiler Suite 5.1
uit te voeren.

Wanneer u CPS 5.0 gebruikt met CWS 6.4, kunt u de volgende problemen ondervinden:

e Als u het bericht "Connect the spectrophotometer to your computer” (Sluit de spectrofotometer aan op uw
computer) in CWS ziet terwijl CPS is geopend, sluit CPS dan en klik op OK om door te gaan.

e Nadat u een nieuwe kalibratie-instelling hebt gemaakt in Calibrator, is de knop Nieuw profiel maken om CPS te
starten, verborgen. Dit probleem is opgelost na het upgraden naar CPS 5.1.

Pad naar locatie sjabloon Inslaan

Het pad naar de locatie sjabloon Inslaan is verwijderd uit de Fiery Hot Folders-voorkeuren. Fiery Hot Folders
gebruikt in plaats daarvan het pad van het sjabloon Inslaan dat gebruikt wordt door Fiery Impose, dat is gedefinieerd
in Fiery Impose > Bewerken > Voorkeuren.

Verbeteringen standaardwaarden instellen
e In Standaardwaarden instellen is er een nieuw standaard Uitvoer papierformaat met de naam Gelijk aan
taakgrootte beschikbaar.

o Alsu de optie Gelijk aan taakgrootte vergrendelt, veroorzaakt dit ongewenste resultaten en de vergrendelde
status wordt daarom genegeerd.

¢ De optie Gelijk aan taakgrootte voor Uitvoer papierformaat is niet beschikbaar voor Gemengde media, Inslag of
Booklet Maker-workflows.
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Verbeteringen aan taakeigenschappen

In Fiery Command WorkStation 6.4kunt u Taakeigenschappen binnen 2 seconden of minder starten.

Wanneer u het venster Taakeigenschappen opent voor een taak, worden alle standaardwaarden weergegeven.
Wanneer u op functies zoals Papiercatalogus, FreeForm, Bedieningsbalk klikt, worden de instellingen voor deze
gebieden ingevuld.

Wanneer in Taakeigenschappen meer dan 500 Papiercatalogus-ingangen moeten worden weergegeven,
resulteert het klikken in de Papiercatalogus-lijst in een vertraging van ongeveer 8 - 80 seconden om het venster
te verversen. Als er meer dan 5.000 ingangen zijn, verwacht dan een vertraging van 80 seconden.

Wanneer u een curve aan een taak in Fiery ImageViewer toepast, de curve verwijdert en vervolgens de
eigenschappen van de taak inspecteert, wordt de naam van de verwijderde curve nog steeds weergegeven alsof
deze gekoppeld is aan de taak. Wanneer u echter op de lijst Bewerkingen ImageViewer klikt, wordt deze blanco.
Als u geen beschikbare Fiery ImageViewer-curve selecteert, blijven de oorspronkelijke taakinstellingen voor de
curve behouden.

* Gedrag dat lijkt op de blanco lijst van Fiery ImageViewer komt ook voor in deze overige gebieden van
Taakeigenschappen: Uitvoerprofiel, RGB-bron, CMYK-bron, Steunkleurgroep gebruiken, Bedieningsbalk,
Master maken en Master gebruiken.

Hoewel een optie of instelling van Papiercatalogus ongeldig kan zijn, wordt er geen foutbericht weergegeven in
de volgende gevallen:

e U meldt zich aan bij Fiery Command WorkStation en bekijkt de eigenschappen voor een taak met geldige
Papiercatalogus-taakinstellingen.

U klikt op de lijst met Papiercatalogus-ingangen in de taakeigenschappen en selecteert een Papiercatalogus-
optie in de lijst.

e U kunt Papiercatalogus terugzetten naar de fabrieksinstellingen vanaf een Fiery Command WorkStation.

e U selecteert Eigenschappen voor een taak die al Papiercatalogus-taakinstellingen heeft.

Problemen opgelost in Fiery Command WorkStation Package v6.4.0.512

Fiery Command WorkStation

Een Impose-jabloon met de voorkeuzenaam Markeringen dat een groot aantal multi-byte tekens bevat, zorgde er
soms voor dat Fiery Command WorkStation niet meer reageert.

Op macOS-computers met besturingssysteemtaal Frans of Duits, stopte Fiery Calibrator voordat de kalibratie
voltooid was.

Problemen opgelost in Fiery Command WorkStation Package v6.4.0.500

Fiery Command WorkStation

Bij het afdrukken van een kalibratietestpagina op een Japans systeem tijdens het aanmaken van een nieuwe
kalibratie of bij het afdrukken van een kalibratietestpagina vanaf Kalibratiebeheer, werden kalibratienaam en
uitvoerprofielnaam op de testpagina vervormd weergegeven.

U kon geen kalibratie aanmaken met een Paper Catalog-item ingesteld als papierbron.
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o Bij het opstarten van de Fiery server op een Japans systeem, kon u de taakvoorkeuzen die vanuit
Apparaatcentrum waren aangemaakt niet opslaan.

e Bij het uitvoeren van een herkalibratie, werd de kalibratietestpagina wel verwerkt, maar nooit afgedrukt.

Fiery Command WorkStation Package v6.4.0.471

Problemen opgelost in Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

e Weergave van miniaturen werd vertraagd in de deelvensters Paginaweergave en Velweergave van Fiery Impose
en Fiery Compose.

¢ Als umeer dan 300 Fiery Impose-sjablonen hebt en een Impose-sjabloon selecteert uit Taakeigenschappen >
Opmaak > Impose > Sjablonen reageert Fiery Command WorkStation 6.4 niet meer.

e U kon de optie Geavanceerd zoeken niet gebruiken in Fiery Command WorkStation om te zoeken naar taken
met gecoate of niet-gecoate mediatypen.

Fiery XF

e Om een geschaalde taak met snijmarkeringen af te drukken, moest u de taak handmatig verplaatsen binnen het
medium in Job Editor en de X- en Y-positie van de taak wijzigen.

Bekend probleem in Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

e Steunkleuren die zijn gedefinieerd met niet-ASCII-tekens worden niet ondersteund door cut-sheetprinters.

Problemen opgelost in Fiery Command WorkStation Package v6.4.0.434
Fiery Command WorkStation

e Na een upgrade naar Fiery Command WorkStation 6.4 was het niet mogelijk een taak af te drukken vanaf Fiery
Command WorkStation met aangepaste papierformaten die op de printer zijn gemaakt.

e Na een upgrade naar Fiery Command WorkStation 6.4 was het niet mogelijk om opsommingstekens toe te
passen in Microsoft Word-documenten.

o Er werd een onjuist foutbericht weergegeven bij het opstarten van Fiery Impose, Fiery Compose of Fiery
JobMaster als de standaard gebruikersmap was ingesteld als netwerkmap.

o Fiery Hot Folders verwijderde de mapstructuur bij mappen met meervoudig diepteniveau bij het maken en
herstellen van een back-up. De mapstructuur van Fiery Hot Folders wordt nu bewaard nadat u een reservekopie
hebt teruggezet.

Fiery XF

e Het aantal Fiery XF-updates per dag liep op als Fiery Command WorkStation doorlopend op een Windows-
clientcomputer actief was.

e In Color Tools > Instellingenveranderde de rasterinstelling Stochastische Screening (SE2) altijd terug naar
Foutdiffusie (SE1).
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In Color Tools > Totaal inktlimiet, nadat u de aangepaste grafiekconfiguratie had gedefinieerd, was het niet
mogelijk de totale inktlimietgrafiek (TIL) af te drukken. Er werd een foutbericht weergegeven dat de instellingen
het mediaformaat hadden overschreden.

Bij een upgrade naar Fiery Command WorkStation 6.4 werd de map C:\ProgramData\Fiery\Fiery XF\Client
\Working verwijderd.

Opmerking: Verwijder geen van de voorkeuren bij het verwijderen van de huidige versie van Fiery Command
WorkStation en upgraden naar de nieuwste versie. Als u voorkeuren verwijdert, wordt de map C:\ProgramData
\Fiery\Fiery XF\Client\Working verwijderd, wat kan leiden tot het verlies van belangrijke taakgegevens (alleen van
toepassing op Windows).

Problemen opgelost Fiery Command WorkStation Package v6.4.0.358

Fiery Command WorkStation

Wanneer u in Fiery Impose met een opgegeven verschuivingswaarde de standaard bijsnijdmarkering omzette
naar de Japanse bijsnijdmarkering, werd er een enkele bijsnijdmarkering toegepast in de vensters Taakvoorbeeld
en Velweergave.

In Fiery Impose werden bij het maken van een sjabloon voor een PDF met gemengde paginaformaten en de
positie-instelling Centreren de sjablooninstellingen niet correct toegepast op de taak. Om de sjabloon met de
verwachte uitvoer te gebruiken, moest de sjabloon opnieuw worden gemaakt.

De ongebruikte tabbladen van een JobMaster-taak werden niet uitgeworpen naar de opgegeven lade.

Wanneer u een nieuw kalibratieprofiel maakte door een bestaand profiel te dupliceren en te hernoemen,
kwamen de eigenschappen van het nieuwe profiel niet overeen met die van het oorspronkelijke profiel.

De miniatuurweergaven van de pagina werden niet gegenereerd in Fiery-voorbeeld, Fiery Impose, Fiery Compose
en Fiery JobMaster.

Fiery XF

Bij gebruik van het MATIC-mes bij stap-en-herhaal-taken, kwamen de posities van de snijmarkeringen in Job
Editor niet overeen met de posities van de snijmarkeringen in de uitvoer.

Een systeemgebruikersnaam met speciale tekens (bijvoorbeeld met een accent aigu) veroorzaakte soms dat
Server Manager niet meer reageerde. Wanneer u de naam van de werkmap wijzigde in een mapnaam met
Cyrillische tekens, werd de nieuwe map niet gevonden.

De NVIDIA GeForce GTX1660-grafische kaart veroorzaakte dat Server Manager en Job Editor niet meer
reageerden.

Fiery Command WorkStation Package v6.4.0.321

Problemen opgelost in Fiery Command WorkStation Package v6.4.0.321

De volgende problemen zijn opgelost:
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Fiery Command WorkStation

Bij het bewerken van de kleurcurven van een bestaand uitvoerprofiel in Device Center > Hulpbronnen > Profielen
> Uitvoerprofielen, werden de wijzigingen niet behouden.

Wanneer u Hot Folders van een back-upbestand hebt hersteld, kunnen de Hot Folders sommige bestanden niet
verwerken.

Fiery XF

In Job editorworden snijmarkeringen voor nesting- en stap-en-herhaal-taken niet meer weergegeven in de niet-
afdrukbare marges van de printer.

U kunt snijcontourbronnen en -methoden nu op de juiste wijze opslaan als voorkeuze.
De snijknop Contour is nu beschikbaar voor afdruk- en snijapparaten op Mac-besturingssystemen.
Wanneer een taak na rotatie is bijgesneden, werden de afmetingen omgekeerd.

De bijsnijmarge was voorheen beperkt tot 1000 cm. De maximale bijsnijmarge is nu gelijk aan de breedte/hoogte
van de taak.

Bij het bewerken van een VPC-bestand in Color Tools werden de curven van alle kleurkanalen weergegeven, zelfs
als u slechts één kleurkanaal had geselecteerd.

Bekend probleem in Fiery Command WorkStation Package v 6.4.0.321

Fiery Command WorkStation

Op MacOS-computers wordt de knopinfo niet weergegeven voor een van de besturingspictogrammen in Fiery-
voorbeeld, Fiery impose, Fiery Compose en Fiery JobMaster.

Problemen opgelost in Fiery Command WorkStation Package v6.4.0.261 SP1

Als u Fiery Command WorkStation hebt gestart onmiddellijk nadat de Fiery server is gestart en vervolgens een
stapellade (of andere installeerbare optie) hebt geselecteerd in Taakeigenschappen, dan werd de optie soms
weergegeven als niet geinstalleerd. Nu worden de correcte instellingen weergegeven.

Nadat u was bijgewerkt naar Fiery Command WorkStation 6.4 op macOS en voor de eerste keer verbinding had
gemaakt met de Fiery server, stopte Fiery Command WorkStation soms met reageren en werd dit vervolgens
afgesloten. Dit probleem is opgelost.

Wanneer u Taakeigenschappen probeerde te openen, werd dit onverwacht afgesloten als Voltooien > Plooien
werd toegevoegd aan het tabblad Snelle toegang voordat u een upgrade had uitgevoerd naar Fiery Command
WorkStation 6.4. Dit probleem is opgelost.
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DTa nmporpaMma yCTaHOBKM 0OHOBUT Bce cyiecTByoye makeTsl Fiery Command WorkStation Package Ao
HOBeli1IIel Bepcuu makeTa, copepskaitero Fiery Command WorkStation u Fiery Hot Folders. ITpu Heo6xoaumocTu
MOXXHO ycTaHOBUTD Fiery Remote Scan ¢ momouibio Fiery Software Manager.

Mpumeuanne: Fiery Command WorkStation Package v6.4.0.512 He nopaep>xusaercst B macOS Catalina 10.15. Aas
ucnoabsoBanust Fiery Command WorkStation B macOS Catalina 10.15 He o6HOBAstIITE CylecTBytomuii maker Fiery
Command WorkStation Package oo HoBeriiteit Bepcuu uau ucnoansyiire Fiery Command WorkStation Package 6.5.

Yro6sr neperitu ¢ Fiery Command WorkStation 5.x Ha Bepcuto 6.4, cHauaaa 06HOBuUTe A0 Bepcun Command
WorkStation 6.3 (soctynHa B Fiery Software Manager), a 3aTem 06HOBUTe A0 Bepcuu 6.4.

Fiery Command WorkStation Package moaaepsxuBaeT cepBeps! Fiery servers, paboTaroiiue moa yrnpaBaeruem FS100
nau 6oAee mo3pHeN Bepcuy, a Takke Fiery proServer u Fiery XF 7.0 uau 60Aee o3AHUX Bepcuil. ITa Bepcus He
ITI03BOASIET MIOAKAIOYATBCS K CAEAYIOLVIM CEPBEPAM.

o Cepsepnl Fiery servers, paboTawliue Mo yrpaBAeHreM nporpammuoro obecrieuenus Fiery System 9/9e Rel2,
System 10 1 60Aee paHHUX BepCuil.

o Cepsepnl Fiery XF 6.x 1 60Aee paHHVE BEpCUN.

o Cepsepsl Fiery Central.
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EcAy BamM HEOOXOAMM AOCTYI K 3TUM IPOAYKTaM, He 0OHOBAsiiTe Bepcuio. [Taker Fiery Extended Applications mo-
MpeXXHEMY AOCTYIIEH 1o appecy www.efi.com/cws. [TOAHBII CIIMCOK ITOAAEP>KMBAEMBIX AMCTOBBIX IIPMHTEPOB CM. 110
aapecy http://fiery.efi.com/CWS/supported-printers.

AOHOAHI/ITeAbHYIO I/IH(l)OpMaLU/IIO O TEXHUNYECKNX XapaKTEePpUCTNKaX CM. 11O aApecy www.efi.com/cws.

HoBble BO3MOXXHOCTN

AomoaHuTeabHyI0 MHGOPMALKIO 0 HOBBIX GyHKLMAX cM. 10 appecy http://Fiery.EFL.com/CWS/Whats-New.

NHdpopmauyumsa o macOS 10.15 (Catalina)

Fiery Preview, Fiery Impose, Fiery Compose unu Fiery JobMaster Ha macOS 10.15

KomnnekT npunoxeHuin gna nogaepxku PDF

Kommaekt puaoskeHui pasi mopaepkku PDF (mpepocraBasiembrit kommanueir EFI), kotopslit cocrout us
Adobe Acrobat u Enfocus PitStop, HecoBmectum ¢ macOS 10.15 (Catalina). ITpu ncnoarzoBanuu Acrobat nau
PitStop He 06HOBAstIITE KOMIbIOTEP A0 MacOS 10.15. ITporpaMma yCTaHOBKYM MPUAOSKEHWIT AAST TIOAAEPIKKU
PDF He 3amyckaercs B HOBbIX Bepcusix OC.

O6HoBAeHue A0 macOS 10.15 mpu UCTOAb30BAHMY TEKYILETO KOMITAEKTA IIPUAOXKEHUIT AASI TOAAepKKYU PDF
MO>KET MPUBECTU K CAEAYIOLIVM IIpoOAEMaM.

e Ecau npuaoxenue Acrobat DC 6b1A0 ycTaHOBAEHO ITepes oOHOBAeHMEM A0 macOS 10.15, ono byser
paboTarb B 00b1yHOM pexume. OpHako nporpamma ycraHoBku Acrobat DC HecoBmecTuma ¢ macOS 10.15,
nostroMy HoBas ycraHoBka Acrobat DC HeBoaMorxHa. Kpome Toro, nocraBasieMoe B KOMIIAEKTe
npuaoxenne Enfocus PitStop He mopaepxuBaercs 8 macOS 10.15.

o Ecau npuaoxenue Acrobat XI 6b1A0 ycTaHOBAEHO ITepes 06HOBAeHMEM A0 macOS 10.15, oHo He byaeT
paboraTs, Tak Kak He nmopaepxubaercs B macOS 10.15. Pekomenayercs yaaauts Acrobat XI mepep,
obHoBAeHMeM A0 macOS 10.15. [Tporpamma yaaseHust Acrobat XI He 6yaer paborats B macOS 10.15,
[03TOMY IIpY OOHOBAEHMY CUCTEMBI C YCTAaHOBAEHHBIM npuaokeHneM Acrobat XI po Bepcuu macOS 10.15
TaKast cucTeMa OyAeT HaXOAUTBCS B COCTOSIHMY, B KOTOpOM npuAoxeHue Acrobat XI ve 6yaer paborars u
€ro HeAb3s1 OYAET YAQAUTD.

Ecan coBmectumas Bepcu:Aa Acrobat He YCTaHOBA€HA, BO3MO>XKHbBI CA€AYIOIIINE HPO6AEMIJI.

o Oyukuus Pegaktuposatb B Acrobat HeaoctynHa B Fiery Impose, Fiery Composen Fiery JobMaster.

o OrkpbiTue 3apanus PostScript ¢ momousio Fiery Preview, Fiery Impose, Fiery Compose nau Fiery JobMaster
MOXXeT NPUBECTH K OLIMOKe.

o Illabaons! Fiery Impose, ucroansyrouive paboune npoueccel [Nonb3osatenbckuii dopmar nocne
3aKnounTenbHoM 06paboTky nau Ha ocHoBe 06nacTy 06pe3Kku, MOryT paboTaTh HEIPABUABHO C 3aAAHUSIMU
PostScript.

o Fiery Hot Folders He npepocTaBAsieT BO3MOXXHOCTD npeobpasoBanus ¢paiaos PostScript B popmar PDF.


HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWS/Whats-New
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Apyrue npo6nembli

ITpu o6HOBAEHUM A0 Bepcuu macOS 10.15 ¢ 6oaee crapoit Bepcuu macOS sanyck Fiery Preview, Fiery Impose,
Fiery Compose uau Fiery JobMaster Mo>xeT mpuBeCTH K IOSIBAEHUIO OAHOTO U3 CAEAYIOLINX COOOIeHMIT.

e Vcnoab3oBanue "ICUConverter.framework” npuseaer x moBpe>xxpeHuio kommneioTepa. Ero Heo6xoaumo
MEePEMECTUTD B KOP3UHY.

e Vcnoab3oBanue "[CUData.framework"” npusepet x moBpexxaeHno komnbioTepa. Ero Heobxoaumo
[IepeMEeCTUTD B KOP3UHY.

Cucrema macOS 10.15 oumm604HO vaeHTUGULMPYeET 5T (allAbl KaK BpEAOHOCHBIE IPOrpaMMbL. UTOObI
YCTpaHUTb 3Ty IpobAeMy, TOBTOpHO ycraHoBuTe Fiery Command WorkStation Package Bepcun 6.4.0.396 nau
0oAee MMO3AHIOI0 Bepcuio, KoTopas coBMecTrMa ¢ macOS 10.15.

Ipy HaBepeHUM yKa3aTeAs MbIIIM HA 3HAaYKM dAeMeHTOB ynpaBaeHus B Fiery Preview, Fiery Impose, Fiery
Compose nau Fiery JobMaster oackasku He OTOOPaXKAIOTCS.

MonHbIN gocTyn K ANCKY

B pesyabTaTre n3MeHeHUI1, BHECEHHBIX B yIpaBAeHMe besomacHocThio macOS 10.15, nosiBUAMCH
AOIIOAHUTEABHBIE 1Iary, HEOOXOAVIMBIE AASI TIPABUABHOI PaboThI MpuAoKeHuit Fiery.

YroOb! npuaoKeHus: Fiery Morau ynpaBasitb 0OOHOBAEHMSIMU U ITOAYYATh AOCTYII K TaKMM dailaaM, KakK
ma6AaoHbl Impose 1 Hot Folders, B macOS Heo0xoAMMO BHeCTU M3MeHeHus B GyHKLMIO Oe3omacHoCTy [ONHbIN
[OCTYN K ANCKY. BkatourTe MONHbIN JOCTYN K AUCKY AAs Tpraokenuit Fiery, Takux kak Fiery Command
WorkStation.

1 3akporire Bce npuaoxenus Fiery.

2 Tlepeiipute B CicTeMHble HacTpolikn > besonacHocTb n KoH$uAeHUManbHOCTb > KoHduaeHunanbHoCTb >
MonHbIM BOCTYN K ANCKY.

3 HaxmuTe 3Ha4OK 3aMKa B HVIDKHEM A€BOM YTAY M BBEAUTE ITAPOAb.
4 HaxMmuTe KHOIKY +.
nanke "[Iporpammbl” Boioepute Fiery Software Manager u Fiery Software Uninstaller, a 3aTem Haxxmute
5 B IT § Fiery Soft M Fiery Soft Uninstall
OTKpbITb.
AAst 00CAYKMBaHMS M OOHOBAEHUS IPUAOXKEHMIT Fiery asTuM IprAOXXeHUM TPeOyeTCst MOAHBI AOCTYII K
AVICKY.
6 B manke "TIporpammer” Boibepute npuaoxxenne Fiery Command WorkStation 1 Haxxmure OTKpbITb.
7 Ecau ucnoabsyercs Fiery Hot Folders uau Fiery Remote Scan, Boibeprte KaXkp0€e IPUAOYKEHIE Y HOOKMUTE

OTKpbITb.

Koraa Fiery Hot Folders o6HapyxuBaer, 4T0 UCIIOAB3YIOTCS manku "AokymeHTsr", "Pabounii cToA" nau
"3arpysku’, 6YA€T MOKa3aHo COOOLIeHME C 3aIIPOCOM Ha IIOAHBIN AOCTYII K AUCKY. DTO COObIeHe
0TOOPaXKAETCS AQKe TIOCAE TIPEAOCTABAEHNST AOCTYIA. MOXXHO 3aKPBITh 3TO COODOLIEHME U IIPOAOAXKUTD
pabory.
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Owmn6KM 6paysepa Safari B macOS 10.15

Ecau ucnoabayercs Safari B macOS 10.15, npu MOIMbITKe OTKPBITh CA€AYIOLIVe BeO-cTpaHuLibl u3 Fiery
Command WorkStation 6yAyT Bo3HMKaTh OBTOpsIIOLMecs olmbKy 6paysepa LieHTp ycTpoiicTs > Obwue >
NHCTpyMeHTbI:

e BoccranosaeHue cucremsl Fiery

e OO0pas Fiery System

e Hacrpoiixu u pecypcsi Fiery

Taxue oummbKu TaxKe MOTyT BO3HMKATh Ipu oTKpeiTun Fiery WebTools B 6paysepe Safari.

AASL AOCTYTIa K 9TUM BeO-CTpaHuLaM UCTIOAb3YITe 6payseper Chrome nau Firefox.

Fiery XF B macOS 10.15

IMpu ncnoarsosanuu Fiery XF ¢ Color Verifier ne o6HoBAstitTe KoMmmbioTep A0 macOS 10.15.

IMpu moaxatouenun K cepsepy Fiery XF mpuaosxenne Color Verifier HecoBmectumo ¢ macOS 10.15. Xots
NOABAsSETCA coobleHue o HeobxoanmocTy 06HoBUTh Color Verifier, Ha AAaHHBII MOMEHT OOHOBAEHME
HepaocTynHo. Haxmure OK, 4T06bI 3aKpBITh COOOIEHME.

Fiery Spot Pro

Fiery Command WorkStation6.4 mo3BoAsieT ynpaBAsITb IAALIEYHBIMY LiBeTaMM C ToMolbio ¢pyHKimu Fiery Spot
Pro, xotopas 3ameHuaa Fiery Spot-On. Fiery Spot Pro copep>XuT caeayroluye yAydieHs: 1 MHOTOe APYToe.

e  DKCHOpTHpYIITE MAALIeYHble 1BeTa B popmaTe ASE AASI UCTTOAB30BaHUS B KaueCTBe OMOAMOTEKM 00pa3LioOB B
npuaoxenuax Adobe Creative Suite, Takux kak Adobe Photoshop.

e C AerKoCTbIO IPUMEHANTEe MOAU(UKALMY ITAQLIEYHBIX IBETOB KO BCEM MPODUAIM.

o Co3paBaiiTe IOAb30BaTEAbCKVE KHUIM 00Pa3LIOB B COOTBETCTBUY C TPpeOyeMbIM (POPMATOM CTPaHULIBL
[ToAHBI CTIMCOK YAy4YLIIEHM CM. TIO aapecy https://www.EFL.com/spotpro.

Oyukuus Fiery Spot Pro AocTymHa AASL HEKOTOPBIX CEPBEPOB, COOTBETCTBYIOIIMX CAEAVIOLIMM TPEOOBAHMSIM:
e FS200 Pro u 60Aee mo3AHME BepCUM IPOrPaMMHOrO obecriedeHus

o Fiery Graphic Arts Package, Premium Edition

[ToapobHee cm. o appecy http://fiery.efi.com/spotpro/supported-printers.

Ecan Ha cepBepe Fiery server He BkatoueHa ¢yukuums Fiery Spot Pro, Fiery Command WorkStation 0yaer no-
npexxHeMy nopaep>xnathb Fiery Spot-On.

PekomeHpauun no ncnonbsosaHuio Fiery Spot Pro

e He ucnoab3syiiTe cMMBOA "@" HY B KAKOM MIMEHM ITAQLIEYHOTO LIBETA.

o Tlocae 3amycka Spot Pro moposxkaute npumepHo 60—120 ceKyHA, IPeXAE YeM UCIIOAb30BaTh PYHKLMIO TIOMCKA
VAU TIEPEKAIOYATD BBIXOAHBIE TIPOPUANL.

. OHTI/IMMS&L[I/IH ITAQII€YHBIX IIBETOB ITOCA€ HECKOABKUX I/ITepa]_U/H;I MOXET IIPUBECTU K boaee BbIPpa’)K€HHbIM
Pa3ANINAM MEXAY MCXOAHDBIM ITAALLIEYHbIM IIBETOM U HpeO6paSOBaHHbIM ITAQII€YHBIM LIBETOM.


https://www.efi.com/spotpro
http://fiery.efi.com/spotpro/supported-printers
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e CyuiecTByeT HEOOABIIIOE YMCAOBOE OKPYTA€HMeE ITpeobpasoBaHHbIX 3HaueHuit L*a*b* n snauennit CMYK Ha
YCTPOICTBE.

o lVcnoAb3oBaHMe ABYX 9K3eMIASIPOB Spot Pro B cucreMax pasAMYHBIX IOAB30BATEAEN, OAKAIOYEHHBIX K OAHOMY
cepBepy Fiery server, Mo>xeT MpMBeCTY K BOSHMKHOBEHMIO OLIMOOK, €CAY 002 TOAB30BaTEAS OYAYT BBIIIOAHSTD
ornepaLmn peAaKTUPOBAHMSL

O6HoBneHmne Fiery Command WorkStation Package He3aBucumo ot cucremHoro
nporpammHoro o6ecneyeHus Fiery

ITporpammuoe obecreuenne Fiery Command WorkStation renepp ycraHaBAuBaeTcst Kak 0ObIYHOE IPUAOKEHME.

Ycranoska Fiery Command WorkStation Package Ha cepBepe Fiery server Ternepb BbIIIOAHSIETCSI aHAAOTMYHO
YCTaHOBKE Ha YAQA€HHOM KAMeHTe. DTO 03HAYAET, YTO eCAU IIOTPeOyeTCs MOBTOPHO YCTAHOBUTD UAU OOHOBUTD
nporpammuoe obecreueHue Fiery Command WorkStation Package, ycranoBaeHHoe Ha cepepe Fiery server,
AQHAAUTUKAM VAU TEXHUYECKVM CIIELIMaAMICTaM AASL 3TOro He nmotpebyrorcss DVD-aucku ¢ cucremusim I10.

B npouecce ycranoBku Fiery Command WorkStation Ha cepsepe Fiery server He 6YAYyT OOHOBASITbCSI IIAKETHI
IIPOrPaMMHOT0 00ecIeueH s, KOTOPbIe UCIIOAB3YIOTCsT coBMecTHO Yepe3 WebTools nan SMB. Kpome Toro, cayxba
Fiery He GyaeT ocTaHOBA€HA BO BpeMsI yCTaHOBKY, 0OHOBAeHus uau yaaseHus Fiery Command WorkStation 6.4.

YcraHoBKa Ha cepBepe Fiery XF

ITpu ycranoske Fiery Command WorkStation Package Bepcuu 6.4 Ha cepBepe Fiery XFFiery XF 7.x cepBep
OCTaHABAMBAETCSI BO BPeMsI BBIIIOAHEHMsI YCTaHOBKU. ITocAe 3aBepiuenust ycranoBku cepeep Fiery XF Oyaer
aBTOMAaTMYECKN ITePe3aIyleH.

64-pa3spagHoe npunoxeHune

Fiery Command WorkStation 6.4 (CWS) siBAsieTcst COOCTBEHHBIM IPUAOKEHUEM 64-paspsSIAHON BEPCUU AAST
naardopm macOS u Windows.

CWS 6.4 He mopaepxuBaet 32-paspsipHble onepaunonubie cucrembl. Ecau ITO Fiery Software Manager yxe
paboraeTt B 32-pa3psIAHOI ONEPALMOHHOI CUCTEMe, Hapumep 32-paspsiaHoit Bepcuu Windows 7, oHO He GyAeT
0TOoOpaXaTh YBeAOMAEHMsI 00 00HOBAeHNMsAX AAst TakeTa CWS 6.4. TTpu nonbiTKe ycTaHOBKM 31O Bepcuu Fiery
Software Manager B 32-pa3psiAHO OIEepALIIOHHON CUCTEMeE MOSIBUTCS COO01IeHMe 00 OmnbKe COBMECTUMOCTH U
Fiery Software Manager He 3amycturcs. CIIMCOK IIOAAEP)KUBAEMBIX OITEPALMOHHBIX CUCTEM CM. 110 appecy http://
fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite n Fiery Command WorkStation 6.4

Fiery Color Profiler Suite 5.0 (CPS) u 60Aee paHHue Bepcun He TOAHOCTBIO COBMeCTUMEI ¢ makeToM Fiery Command
WorkStation Package 6.4 (CWS) AAsT AUCTOBBIX IPUMHTEPOB. PekoMeHAYeTCs1 00HOBUTD IporpaMmy A0 Bepcuu Fiery
Color Profiler Suite 5.1.

IMpu ncnioarsosanuu CPS 5.0 ¢ CWS 6.4 MOryT BOSHUKHYTb CA€AYIOLIME IPOOAEMBL.

e Ecau B CWS nosiBuaoch coobienne «ITopkalounTe CrieKTpopOTOMETP K KOMIIBIOTEPY», KOTAQ OTKPbITA
nporpamma CPS, 3akpoitre CPS 1 nHaxxmure OK, 4T00BI IIPOAOAXKUTD.

o Tlocae co3paHuMs HOBOI HACTPOMKM KaAMOPOBKU B KaAnbpaTope KHotka Co3/iaTb HOBbI MPOPUIb AASL 3amycKa
CPS He oTobpaskaercs. AAsL peleHNs 3TOM IPoOAeMbl HEOOXOAMMO BBITOAHUTH 00HOBAeHMe A0 Bepcuu CPS 5.1.


http://fiery.efi.com/cws-specifications
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nyTb K MeCTOMOJIOXKeHMIo WabnoHa Impose

ITyTp K MecTOmOAOKeHMIO I1abAoHa Impose ObIA yaaseH us npepnoutennit Fiery Hot Folders. Bmecto atoro Fiery
Hot Folders ncroabsyer ImyTb K MecTOIoAoXeHMIo mabAoHa Impose, 3apanHblil B Fiery Impose B pasaeae Fiery
Impose > NpaBka > lNpegnouteHuns.

Ynyywenuna ¢yHKunn "3apatb 3Ha4eHUA NO yMmonyaHuio"

e B okHe 3apaTb 3HaUYEHUA NO YMONTYAHMIO AOCTYIIEH HOBBII BbIXOAHOM popMaT Bymar o yMOAYaHUIO C UMEHEM
CoBnapaer c 3agaHuem.

L4 BAOKI/IPOBKa napaMeTpa COBI'Ia):laET C 3ajaHNEeM MIPUBOAUT K HEXXeAAaTE€AbHbIM pe3yAbTaTaM U II0O9TOMY
336AOKI/IpOBaHHO€ COCTOsIHVI€ UTHOPUPYETCA.

o ITapamerp CoBnafaert C 3ajaHneMm B pasaeAe BbixogHol dopmaT byMaru HeAOCTYIIEH AAST CAEAYIOIIMX paboumx

non

npoueccos: "CMelraHHble MaTepuaAbl Aas medatn’, "Criyck moaoc” u Booklet Maker.

YnyuuweHunsa ¢yHkuum "MapameTtpbl 3agaHna"

¢ B Fiery Command WorkStation 6.4 Mo>xHO 3anmycTuThb QyHKLMIO [lapameTpbl 3agaHnNA He 6oaee yeM 3a 2
CEKYHABDL

e Tlpu oTkpbiTuM OKHa [lapameTpbl 3a4aHNA AAS AI0OOTO 3apAaHMs OYAYT ITOKa3aHBI BCe 3HAYEHNS 110 YMOAYAHMIO.
ITpu HaxkaTuM Ha PyHKLMIO, TaKylo Kak Paper Catalog, FreeForm 1 KOHTpoAbHasI IKaAa, HACTPOMKM AAS STHX
obaacTell OyAyT 3alIOAHEHBL.

o Ecau oxno MapameTpbl 3afaHuna copepxut 6oaee 500 samcent Paper Catalog, mpu HaxxaTuu Ha ciicok Paper
Catalog 3apep>xka 0OHOBAEHMSI OKHA COCTaBUT OKOAO 8-80 cexyHA. ITpy Haanyum 5000 3anyiceit BO3MOXKHa
3apepKKa A0 80 CeKyHA.

e Ecau x 3apanmio npumeHuTb KpuByio B Fiery ImageViewer, 3aTeM yaaAUTb KPUBYIO U IPOBEPUTDb CBOMCTBA
3aAaHMS, UM YAQAEHHON KPUBOJ MO-TIPE>XXHEMY OyA€T 0TOOpaXkaThCsl KaK CBsI3aHHOe ¢ 3apaHneM. OAHAKo Impu
Ha)KaTUM Ha CUCOK M3meHeHua ImageViewer oH cTaHOBUTCS IyCThIM. ECAM He BBIOpaTh AOCTYIIHYIO KPUBYIO
Fiery ImageViewer, CXOAHBIe HACTPOVIKY 3aAQHUS AASL KPUBOJ OYAYT COXpaHEHBL

 [ToBepeHMe, aHaAOTMYHOE ITycTOMY cUCKY Fiery ImageViewer, Tak)ke BO3HMKAeT B APYTMX 00AACTSX QYHKLUY
MapameTpbl 3agaHusA: BoixogHol npodunb, MictouHnk RGB, Uctounnk CMYK, Mcnonb3oBatb rpynny
nnaweyHbIX LBeToB, KoHTponbHasa Wwkana, Co3gatb MacTep-4OKYMEHT 1 Micnonb30oBaTb MacTep-AOKYMEHT.

e Hecmortps Ha TO, uro mapamerp Paper Catalog moxeT ObITbh HEAOITYCTUMBIM, COODIIIeHIE 00 ouIbKe He
OTOOPaKAETCS B CAEAVIOIUX CAYYASIX.

» Boitpure B cuctemy Fiery Command WorkStation u mpocMoTpute cBOICTBa 3aAaHMs, KOTOPOE MMEET
AOITYyCTMMbIe HaCTpoMKy 3apanus Paper Catalog.

e Haxxmure crincox 3anuceit Paper Catalog B okue IlapameTpsl 3apaHust U BbiOepuTe AI0O0€ 3HaUY€HME B CIIICKE
Paper Catalog.

e Brinmoanute cOpoc sHauennit Paper Catalog a0 3aBoackux HacTpoek ¢ momoupio Fiery Command
WorkStation.

* BoiOepure cBOIICTBA 3aAaHMs, B KOTOPOM Y>Ke 3aAaHbI HACTpoiiku 3apaHus Paper Catalog.
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Mpo6nembl, ncnpaeneHHble B Fiery Command WorkStation Package v6.4.0.512
Fiery Command WorkStation

o lllabaoH Impose c uMeHeM 11abAOHa 3apaHMsT METKM, COAepIKalLii MHOTOOaiTOBblE CUMBOABL, MHOTAA
MPUBOAUT K ToMy, uTo Fiery Command WorkStation mepecraer orBeyaTh Ha 3ampoCHL.

e Ha xommbioTepax o ynpaBaeHreM macOS, Ha KOTOPBIX B Ka4eCTBE sI3bIKa ONEPALIIOHHOM CUCTEMBI BBIOpaH
¢dpaHLy3CcKMiT MAM HEMeLKMIT s13bIK, mpuAokeHue Fiery Calibrator nepecraeTr oTBeyaTp Ha 3aIIpoOChI A0
3aBeplUeHMsI KaAMOPOBKIL.

MNpobnembl, ncnpaeneHHble B Fiery Command WorkStation Package v6.4.0.500
Fiery Command WorkStation

o Ecau B cucreme C SIMOHCKUM SI3BIKOM BBITIOAHSIETCSI TI€YATh TECTOBO CTPAHULIBI KAAMOPOBKY MPU CO3AAHUU
HOBOJT KaAMOPOBKY AU C TOMOIIbI0 JlncneTyepa KannmbpoBKM, MM KaAMOPOBKY U UM BLIXOAHOTO MPOdMAS Ha
TECTOBOII CTPaHuIie OYAYT ICKa)XKEHBDI.

e HeB03MOXHO CO3AaTb HAOOP KAAMOPOBKY C MCIIOAB30BaHIEM SAEMEHTA KaTaAora OyMary B KaueCcTBe MCTOYHMKA
Oymaru.

o Tlocae mepesanycka cepBepa Fiery server B cucTeMe C SIOHCKUM sI3bIKOM HEBO3MO>KHO COXPaHUTD LIAOAOHBI
3aAaHUI, CO3AaHHbIe B LleHTpe ycTpoIICTB.

. ]_[pI/I BBIITIOAHEHUU KaAI/I6pOBKI/I TECTOBasA CTpaHMLIa KaAI/I6pOBKI/I O6pa6aTbIBaeTCﬂ, HO He rme4vyaTaeTrcs.

Fiery Command WorkStation Package v6.4.0.471

Mpo6nembl, ncnpasneHHblie B Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

e 3apepiKKa IIpU OTOOpaXXeHUM 3CKU30B Ha MaHeAsix «[IpeacTraBaeHue cTpaHuubi» U «IIpepcTaBAeHMe AXCTa» B
Fiery Impose u Fiery Compose.

o Tlpu Haanmuun 60aee 300 mabaoHoB Fiery Impose B pesyabrare Bbibopa mabaoHa Impose B okHe [NapameTpbl
3afjaHuAa > Bknagka > Impose > Labnoxbl ITO Fiery Command WorkStation 6.4 mepectaBaso oTBe4aTh Ha
3aIpoCHL.

¢ Tlapamerp PaclumpeHHbIi TONCK HeAb3s 1croab3oBaTh B Fiery Command WorkStation Aast moucka 3apaHuii,
AASTI KOTOPBIX BbI6paHbI MaTE€pPHAADBI AAA TTEYATU C ITIOKPBITUEM AN 6e3 TIOKPBITU .
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Fiery XF

e AAs meyaTu MacuITabMpPyeMOro 3apaHMsI C MeTKaMu o6pe3ku Heobxoaumo B Job Editor BpyuHyio nepemerats
3aAQHME B IPEAEAAX MATepUaAa AASL TIeYaTH, a TAaKKe BBIOMPATh KOOPAMHATBL X U Y AASL 3aAaHUS.

N3BecTHasa npo6nema B Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

e TlAamreyHble 1jBeTa, ONPEAEAEHHBIE C IOMOLIBI0 CUMBOAOB, OTAMYHBIX OT ASCII, He MOAAEPKUBAIOTCS AAS
AVICTOBBIX IIPUHTEPOB.

MNpobnembl, ncnpaeneHHble B Fiery Command WorkStation Package v6.4.0.434
Fiery Command WorkStation

o Tlocae ooHoBAeHUs a0 Fiery Command WorkStation 6.4 HeBo3MOXXHO HameyaTaTb 3apanue u3 Fiery Command
WorkStation ¢ ncroabsoBaH1eM MOAb30BaTEABCKMX POPMATOB OyMaru, CO3AaHHBIX Ha IPUHTEpe.

o Tlocae obHoBAeHUs a0 Fiery Command WorkStation 6.4 HeBO3MOXXHO IIPMMEHUTb MapKUPOBaHHbIE CIIVICKU B
AokyMmeHTax Microsoft Word.

o EcAu B KayecTBe HaYAABHOJ [TATIKK IIOAB30BaTEASI ObIAA 3aAdHA CeTeBas MAIKa, TO pu 3amycke Fiery Impose,
Fiery Compose uau Fiery JobMaster oTobpakaeTcst HenmpaBUABHOE COO01eHNEe 00 OmmmoKe.

o Ilpu pe3epBHOM KONMPOBAaHUM U BOCCTAHOBAEHMU HECKOABKUX YPOBHEN IAYOOKMX CTPYKTYP IMAIOK C
ucnoab3oBanueM npuaoxenus Fiery Hot Folders mponcxoanao yaaaeHue CTpyKTyps manok. Tenepb cTpykTypa
nanok Fiery Hot Folders coxpansieTcst mocAe BOCCTaHOBAEHMSI U3 Pe3ePBHOI KOIUU.

Fiery XF

o KoanuectBo obHOBAeHMIt B AeHB Fiery XF 6yaer yBeanuusatbcs, ecan Fiery Command WorkStation 6yaer
MOCTOSIHHO paboTaTh Ha KAMEHTCKOM KoMIbioTepe Windows.

e B Color Tools > HacTpoliku aast mapamerpa nepeaaun moayroHoB «CroxacTudeckoe pacrpupoBanue (SE2)»
BCeraa BOCCTaHABAMBAAOCH 3HaueHne «CAydaiiHoe nceBAocMelteHre 1iBeToB (SE1)».

o B Color Tools > MakcumanbHoe obLee KONMYecTBO KPacKm ITOCAE ONpeAeAeHIsT KOHUTYpaLy HaCTpanBaeMoit
AViarpaMMbl HEBO3MOJKHO Hall€edaTaTb AarpaMMy MaKCIMaAbHOTO 06U.I€I’O KOANYECTBa KpaCKU. B COO6LH€HMM
00 o1mmnbKe yKas3aHo, YTO HACTPOVKM IIPEBBICUAY Pa3Mep MaTepuaAa AAS IeYaTu.

e O6HoBAeHMe A0 Bepcuu Fiery Command WorkStation 6.4 mpuBoanao k yaaaenuto nanku C:\ProgramData\Fiery
\Fiery XF\Client\Working.

Mpumeuanme: He ypaasiite Kakue-AnO0 NpeAIOYTEHNSA IPU yaaAeHuH Tekyleli Bepcun Fiery Command
WorkStation 1 06HOBA€HUM AO HOBOJI BepcuM. Y AQA€HIE IPEATTOYTEHUIT IPUBOAUT K yaaAeHuio manky C:
\ProgramData\Fiery\Fiery XF\Client\Working, B pe3yabTaTe uero 6yayT yTepsiHbl Ba)KHble AQHHbIE 3aAaHUS
(ToabKO AAst Windows).
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Mpo6nembl, ncnpaeneHHble B Fiery Command WorkStation Package v6.4.0.358
Fiery Command WorkStation

o B Fiery Impose ¢ 3apaHHBIM 3HaU€HVEM CMELLEHNS IPY TIEPEKAIOYEHNI CO CTAHAAPTHBIX OOPE3HBIX METOK Ha
SIMOHCKMe B oKHax [pocmoTp 3afaHnA u MNpeacTaBneHve NicTa MpUMeHSIAUCh OAMHOYHbIE METKU OOPe3KIL.

e B Fiery Impose mpu cospanum mabaoHa Aast paitaa PDF co cMmelaHHBIM pasMepOM CTPaHULIbI U
BbIpaBHUBaHMeM [10 LLleHTPY HaCTpoViKK 11abAOHA He TIPUMEHSIAVCH [IPABMABHO K 3aAaHMI0. YTOOBI yCIenHo
MCTIOAB30BAaTh LIA0AOH C 0>)KMAAEMBIM PE3YABTATOM, CO3AANTE €ro 3aHOBO.

. HeVICHOAbSY@MbIe Pa3AEAUTEAN 3aAAHUSA ]obMaster He OBIAU U3BAEYEHHI B yKaSaHHbII;I AOTOK.

o Tlpu cospaHuu HOBOro nMpoduasi KAAMOPOBKM IIyTEM AYOAMPOBAHMS U ITEPEUMEHOBAHMS CYILIECTBYIOLIETO
mpo¢uAsI CBOIICTBA HOBOTO PO MAS He COBIIAAAAY C UICXOAHBIM NPoduAeM.

e  DCKU3bI IpeABaPUTEABHOIO MIPOCMOTPA CTPAHULIbI He CO3AaBaANCh B puAaokeHusix Fiery Preview, Fiery Impose,

Fiery Compose u Fiery JobMaster.
Fiery XF

o Ilpu ucnoabsoBauuu ycrporicrsa oopesku MATIC c sapanusimu "lllar u moBTOp" OAOXKEHVE OOPE3HBIX METOK,
otobpaxxaembix B Job Editor, He COOTBETCTBOBAAO IIOAOKEHUIO OOPE3HBIX METOK IPY [TEYATH.

¢ JicroAb3oBaHMe MIMEHU ITOAB30BaTEeAS CUCTEMbI, COAEPIKalLler0 CMBOABI C AMAKPUTUYECKMMM 3HAKaMU
(HampuMep, C aKyTOM), MHOTAA IIPUBOAMAO K TOMY, UTO TIpMAOXKeHMe Server Manager repecTaBaAO OTBeYaThb Ha
3anpocsl. Kpome Toro, npu naMeHeHUM UMeHM paboveit Manky Ha UMsI ¢ KUPUAAUYECKMMU CUMBOAAMM HOBYIO
MAIKy He YAQBaAOCh OOHAPYXXUTb.

e lVicnoabsoBaHue BupeokapTel NVIDIA GeForce GTX1660 npuBoaAMAO K TOMY, UTO IpUAOXKeHUA Server Manager

u Job Editor mepecraBaau oTBeYaTh Ha 3aMPOCHI.

Fiery Command WorkStation Package v6.4.0.321

Mpo6nembl, ncnpasneHHblie B Fiery Command WorkStation Package v6.4.0.321

BeiAM MCTIpaBA€HBI CAEAYIOLIIE IPOOAEMBL.

Fiery Command WorkStation

o Ilpu pepaKTUPOBAaHUM LIBETOBBIX KPUBBIX AASI CYILIECTBYIOLIETO BBIXOAHOTO Npoduas B LieHTp ycTponcTs >
Pecypcbl > Mpodnnm > BbixogHble Npoduv BHeCEHHbIE M3MEHEHNS He COXPAHSIOTCA.

o Ilpu BoccranoBaenuu Hot Folders 13 pesepBHoro ¢aitaa npuaoskenue Hot Folders He moskeT o6paboraTth
HEKOTOpbIe (ailAbL

Fiery XF

e B npuaoxxenun Job Editor meTku 06pe3ku pas 3apaHuil HecTuHra u 3apanHuii "lllar v moBTop" OoAbIIe He
0TOOPaXKAIOTCS Ha HereyaTaeMbIX IIOASX IIPUHTepa.

o Temepb MO>XXHO IPAaBMABHO COXPAaHUTb METOABI 1 MICTOYHMKM OOPE3KM 0 KOHTYPY B KaueCTBe IabAOHa 3aAaHUS.

o Kuomnka o6pesku [10 KOHTYpY Termepb AOCTYITHA AASL YCTPOVCTB [TeYaTy M 00OPe3KH B OIIEPALIMOHHO CUCTEME
macQOS.

. KOI‘Aa 3apaHNe o6pe3aeTCH TIOCA€ ITOBOPOTQ, €ro pasMepbl MEHAITCA MECTAMU.
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o Panee noae o6pe3ku 6b1A0 orpaHuueHo A0 1000 cm. Tenepb MaKCUMaAbHOE ITOAE OOPE3KU MOXKET OBITh TAKUM
JKe, KaK IIMPYHA MAM BbICOTA 3aAAHMAL

o Tlpu pepaxrupoBanuu ¢ariaa VPC B Color Tools oToOpakaroTcst KpyBble BCeX LIBETOBBIX KAHAAOB, AQXKeE €CAV
OBbIA BBIOPaH TOABKO OAVH L[BETOBOU KaHaA.

NsBecTHasa npo6nema B Fiery Command WorkStation Package v6.4.0.321

Fiery Command WorkStation

e Ha xommnbrorepax nop ynpasaenueM macOS B npuaoxenusax Fiery Preview, Fiery Impose, Fiery Compose u Fiery
JobMaster He 0TOOpaXXalOTCsI MOACKA3KU AASI 3HAUKOB SAEMEHTOB YIIPABAEHIUSL.

MNpobnembl, ncnpaeneHHble B Fiery Command WorkStation Package v6.4.0.261 SP1

e EcauITO Fiery Command WorkStation 3amyckaaoch cpasy nocae 3anycka cepsepa Fiery server u B okHe
"TlapameTpbl 3apaHKs" BBIOMPAACS AOTOK YKAQAUMKA (MAM APYTO¥ yCTAaHABAMBAEMBIl KOMIIOHEHT), 9TOT
KOMIIOHEHT IHOTAQ OTOOPaKaACs KaK He YCTaHOBA€HHbII. Tenepb 0TOOpa)kaloTCs TpaBUAbHbIE HACTPOIIKI.

o Tlocae obHOBAeHMS A0 Bepcuu Fiery Command WorkStation 6.4 Ha KoMmIbloTepe oA yrpaBaeHueM macOS u
nepBoro noaxawdeHus K cepsepy Fiery server ITO Fiery Command WorkStation nHorpa nepecraBaso orBevathb
Ha 3aIlpOCHI, a 3aTeM 3aBepllaAo pabory. ITa npobaema Oblaa yCTpaHeHa.

e TlocAe MOMBITKY OTKPBITH OKHO 'TlapaMeTpbl 3apaHMst" OHO HEOXKUAAHHO 3aKPBIBAAOCH, €CAU TTAPAMETPbI
3aknoumTenbHasa 06paboTka > JInHMA crnba ObiAM A0OaBAEHBI Ha BKAAAKE BbICTPbIV JOCTYN A0 OOHOBAEHMSI AO
Bepcuu Fiery Command WorkStation 6.4. 9ta mpobaema Obiaa yCTpaHeHa.
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Niniejszy dokument zawiera wazne informacje dotyczace tej wersji. Informacje te nalezy koniecznie przekazaé
wszystkim uzytkownikom przed kontynuowaniem instalacji.

Informacje dotyczace tej wers;ji
W tej wersji dostepne sa nastepujace aplikacje:
e Fiery Command WorkStation Package w wersji 6.4.0.512

* Fiery Command WorkStation w wersji 6.4.00.62
e Fiery Hot Folders dla komputeréw z systemem Mac w wersji 4.00.0.31

e Fiery Hot Folders dla systemu Windows w wersji 4.00.0.31

o Fiery Software Manager w wersji 4.3.0.13

Uaktualnianie

Za pomocy tego instalatora mozna uaktualni¢ dowolny istniejacy pakiet Fiery Command WorkStation Package do
najnowszej wersji zawierajacej aplikacje Fiery Command WorkStation oraz Fiery Hot Folders. Mozna takze
zainstalowa¢ program Fiery Remote Scan przy uzyciu narzedzia Fiery Software Manager.

Uwaga: Oprogramowanie Fiery Command WorkStation Package w wersji 6.4.0.512 nie jest obslugiwane w systemie
macOS Catalina 10.15. Aby korzysta¢ z oprogramowania Fiery Command WorkStation w systemie macOS Catalina
10.15, nie nalezy uaktualnia¢ Fiery Command WorkStation Package do najnowszego pakietu, ani korzysta¢ z
oprogramowania Fiery Command WorkStation Package w wersji 6.5.

Aby przeprowadzi¢ uaktualnienie aplikacji Fiery Command WorkStation w wersji 5. x do 6.4, nalezy najpierw
przeprowadzi¢ uaktualnienie do aplikacji Command WorkStation 6.3 (dostepnej w programie Fiery Software
Manager), a nastepnie przeprowadzi¢ uaktualnienie do wersji 6.4.

Fiery Command WorkStation Package obsluguje Fiery servers z zainstalowanym oprogramowaniem FS100 lub
nowszym, a takze serwery Fiery proServer i Fiery XF 7.0 lub nowsze. Brak mozliwosci faczenia z serwerami:

o Fiery servers z zainstalowanym oprogramowaniem Fiery System 9/9e Rel2 oraz System 10 i starszymi wersjami
o Serwery Fiery XF 6.x i wcze$niejsze

o Serwery Fiery Central
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Jezeli musisz korzysta¢ z tych produktéw, nie dokonuj uaktualnienia. Pakiet Fiery Extended Applications jest nadal
dostepny na stronie www.efi.com/cws. Pelna liste obstugiwanych arkuszowych maszyn cyfrowych mozna znalez¢ na
stronie http://fiery.efi.com/CWS/supported-printers.

Wiecej informacji na temat specyfikacji technicznych mozna znalez¢ na stronie www.efi.com/cws.

Co nowego?

Aby uzyska¢ wiecej informacji na temat nowych funkcji, odwiedz witryne http://Fiery.EFL.com/CWS/whats-new.

Informacje o systemie macOS 10.15 (Catalina)

Podglad Fiery, Fiery Impose, Fiery Compose lub Fiery JobMaster w systemie macOS 10.15

Zestaw aplikacji do obstugi formatu PDF

Zestaw aplikacji do obslugi formatu PDF (dostarczany przez firme EFI), ktéry sktada sie z programéw Adobe
Acrobat i Enfocus PitStop, nie jest zgodny z systemem macOS 10.15 (Catalina). W przypadku korzystania z
oprogramowania Acrobat i/lub PitStop nie nalezy przeprowadza¢ aktualizacji systemu macOS do wersji 10.15.
W przypadku nowych instalacji nie jest uruchamiany instalator aplikacji do obstugi formatu PDF.

Aktualizacja systemu macOS do wersji 10.15 podczas korzystania z aktualnego zestawu aplikacji do obstugi
formatu PDF moze spowodowa¢ nastepujace problemy:

Jezeli oprogramowanie Acrobat DC jest juz zainstalowane przed uaktualnieniem systemu macOS do wersji
10.15, bedzie ono dziala¢ normalnie. Jednak instalator programu Acrobat DC nie jest zgodny z systemem
macOS 10.15, dlatego nowe instalacje programu Acrobat DC nie sa mozliwe. Ponadto dolaczony program
Enfocus PitStop nie jest obstugiwany przez system macOS 10.15.

Jezeli oprogramowanie Acrobat XI zostalo juz zainstalowane przed uaktualnieniem systemu macOS do
wersji 10.15, nie bedzie ono dzialac i nie jest obslugiwane przez system macOS 10.15. Przed uaktualnieniem
systemu macOS do wersji 10.15 zaleca sie odinstalowanie oprogramowania Acrobat XI. Program Acrobat XI
Uninstaller nie bedzie dziala¢ w systemie macOS 10.15, wiec w przypadku uaktualnienia systemu macOS do
wersji 10.15 z zainstalowanym programem Acrobat XI system znajdzie sie w stanie, w ktérym program
Acrobat XI nie dziata i nie mozna go odinstalowac.

Jezeli nie zainstalowano zgodnej wersji programu Acrobat, pojawiaja sie nastepujace problemy:

Funkcja Edytuj w programie Acrobat jest niedostepna w programach Fiery Impose, Fiery Compose i Fiery
JobMaster.

Otwarcie zadania PostScript za pomoca programu Podglad Fiery, Fiery Impose, Fiery Compose lub Fiery
JobMaster moze spowodowac wystapienie btedu.

Szablony programu Fiery Impose opierajace sie na kolejnosci zadain Rozmiar wykanczania definiowany przez
uzytkownika lub Zaleznie od pola przycinania moga nie dziala¢ prawidlowo w przypadku zadan PostScript.

Fiery Hot Folders nie umozliwia konwersji plikéw PostScript na format PDF.
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Inne problemy

Uruchomienie programu Podglad Fiery, Fiery Impose, Fiery Compose lub Fiery JobMaster po uaktualnieniu
systemu macOS do wersji 10.15 moze spowodowac wyswietlenie jednego z nastepujacych komunikatéw:

e ICUConverter.framework” spowoduje uszkodzenie komputera. Nalezy przenie$¢ go do kosza.
o ,ICUData.framework” spowoduje uszkodzenie komputera. Nalezy przenie$¢ go do kosza.

System macOS 10.15 btednie identyfikuje te pliki jako zlosliwe oprogramowanie. Aby rozwigzac te problemy,
nalezy ponownie zainstalowa¢ oprogramowanie Fiery Command WorkStation Package w wersji 6.4.0.396 lub
nowszej, ktoéra jest zgodna z systemem macOS 10.15.

Po umieszczeniu wskaznika myszy nad przyciskami dowolnych ikon sterowania w programie Podglad Fiery,
Fiery Impose, Fiery Composelub Fiery JobMaster etykietki narzedzi nie sa wyswietlane.

Peiny dostep do dysku

Ze wzgledu na zmiany w sposobie zarzadzania zabezpieczeniami w systemie macOS 10.15 istnieja teraz
dodatkowe kroki wymagane do poprawnego dzialania aplikacji Fiery.

Konieczne jest dokonanie zmian w funkcji zabezpieczenia Petny dostepu do dysku w systemie macOS, aby
aplikacje Fiery zarzadzaly aktualizacjami i uzyskiwaly dostep do plikéw, takich jak szablony Impose i foldery
podreczne. Wiacz petny dostep do dysku dla aplikacji Fiery, w tym Fiery Command WorkStation.

1 Zamknij wszystkie aplikacje Fiery.
2 PrzejdZ do Preferencje systemowe > Bezpieczenstwo i prywatnosc > Prywatnos¢ > Petny dostep do dysku.
Kliknij ikone ktédki w lewym dolnym rogu i wprowadz swoje hasto.

Kliknij przycisk +.

u A W

W folderze Aplikacje wybierz Fiery Software Manager i Fiery Software Uninstaller, a nastepnie kliknij
Otworz.

Aplikacje te wymagaja pelnego dostepu do dysku w celu utrzymania i zaktualizowania aplikacji Fiery na
komputerze.

6 W folderze Aplikacje wybierz aplikacje Fiery Command WorkStation i kliknij Otworz.

7 Jezeli korzystasz z Fiery Hot Folders lub Fiery Remote Scan, wybierz kazda aplikacje i kliknij Otworz.

Jesli Fiery Hot Folders wykryje, ze uzywane sa foldery Dokumenty, Pulpit i Pobrane, zostanie wy$wietlony
komunikat z prosba o pelny dostep do dysku. Ten komunikat jest nadal wyswietlany nawet po przydzieleniu
dostepu. Mozna zignorowac ten komunikat i kontynuowac prace.

Bledy przegladarki Safari w systemie macOS 10.15

Jezeli korzystasz z przegladarki Safari w systemie macOS 10.15, podczas préby otwarcia nastepujacych stron
sieci Web z poziomu aplikacji Fiery Command WorkStation pojawia sie powtarzalne btedy. Centrum urzadzen >
Ogolne > Narzedzia:

e Przywracanie systemu Fiery
e Obraz systemu Fiery
e Zasoby i ustawienia Fiery

Te bledy moga réwniez wystapi¢ po otwarciu narzedzi Fiery WebTools w przegladarce Safari.

Aby uzyska¢ dostep do tych stron, nalezy skorzystaé z przegladarki Chrome lub Firefox.
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Fiery XF w systemie macOS 10.15

W przypadku uzywania Fiery XF z programem Color Verifier nie nalezy przeprowadza¢ aktualizacji do systemu
macOS 10.15.

W przypadku laczenia z serwerem Fiery XF aplikacja Color Verifier nie jest kompatybilna z systemem macOS
10.15. Chociaz wyswietlany jest komunikat z pro$ba o zaktualizowanie programu Color Verifier, w tej chwili nie
jest dostepna zadna aktualizacja. Kliknij przycisk OK, aby zignorowac ten komunikat.

Fiery Spot Pro

Oprogramowanie Fiery Command WorkStation 6.4 umozliwia zarzadzanie kolorami dodatkowymi za pomoca
aplikacji Fiery Spot Pro, ktéra zastepuje aplikacje Fiery spot-on. Aplikacja Fiery Spot Pro zawiera miedzy innymi
nastepujace udoskonalenia:

o Eksportowanie koloréw dodatkowych w formacie ASE do wykorzystania jako biblioteki prébek w aplikacjach
pakietu Adobe Creative Suite, takich jak Adobe Photoshop.

e Latwe wprowadzanie zmian koloréw dodatkowych we wszystkich profilach.
o Tworzenie niestandardowych broszur prébnika, aby dopasowac je do rozmiaru strony.
Aby zobaczy¢ pelna liste ulepszen, odwiedz strone https://www.EFI.com/spotpro.

Aplikacja Fiery Spot Pro jest dostepna dla wybranych kontroleréw spetniajacych nastepujace wymagania:

e Oprogramowanie FS200 Pro lub nowsze

o Fiery Graphic Arts Package, Premium Edition

Wiecej informacji jest dostepnych pod adresem http://fiery.efi.com/spotpro/supported-printers.

Jezeli kontroler Fiery server nie ma wiaczonej aplikacji Fiery Spot Pro, oprogramowanie Fiery Command
WorkStation bedzie nadal obslugiwac aplikacje Fiery Spot-On.

Zagadnienia dotyczace korzystania z aplikacji Fiery Spot Pro

e Nie nalezy umieszczaé symbolu ,@” w nazwach kolor dodatkowych.

e Po uruchomieniu aplikacji Spot Pro nalezy odczekaé okolo 60—120 sekund przed skorzystaniem z funkcji
wyszukiwania lub przetaczeniem profili wydruku.

e Optymalizacja koloréw dodatkowych po wykonaniu kilku iteracji moze spowodowaé powstanie wyraznych
réznic miedzy pierwotnym kolorem dodatkowym a skonwertowanym kolorem dodatkowym.

o Skonwertowane wartos$ci numeryczne L*a*b* i wartosci CMYK urzadzenia sg lekko zaokraglane.

o Dwa wystapienia aplikacji Spot Pro uzywane w réznych systemach taczacych sie z tym samym kontrolerem
druku Fiery server moga powodowac¢ btedy, jesli obaj uzytkownicy wykonuja operacje edycji.

Aktualizacja Fiery Command WorkStation Package niezaleznie od oprogramowania
systemowego Fiery

Oprogramowanie Fiery Command WorkStation zachowuje sie teraz podczas instalacji podobnie do standardowych
aplikacji.

Instalacja Fiery Command WorkStation Package na serwerze druku Fiery server przebiega teraz tak samo jak
instalacja na kliencie zdalnym. Oznacza to, Ze jezeli oprogramowanie Fiery Command WorkStation Package


https://www.efi.com/spotpro
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zainstalowane na serwerze Fiery server wymaga ponownej instalacji lub aktualizacji, analitycy lub technicy nie beda
musieli korzysta¢ z dyskéw DVD z oprogramowaniem systemowym w celu wykonania tej czynno$ci.

Przy instalowaniu Fiery Command WorkStation na serwerze Fiery server, instalacja nie zaktualizuje pakietéw
oprogramowania, ktdére sa udostepniane za posrednictwem narzedzi WebTools lub SMB. Ponadto ustuga Fiery nie
zostanie zatrzymana podczas instalacji/aktualizacji/odinstalowywania oprogramowania Fiery Command
WorkStation 6.4.

Instalacja na serwerze Fiery XF

Przy instalowaniu pakietu Fiery Command WorkStation Package wersji 6.4 na serwerze Fiery XF w wersji 7.x serwer
Fiery XF zostanie zatrzymany na czas instalacji. Po zakoriczeniu instalacji serwer Fiery XF zostanie automatycznie
uruchomiony ponownie.

Aplikacja 64-bitowa

Fiery Command WorkStation 6.4 (CWS) to natywna aplikacja 64-bitowa na urzadzenia z systemami Mac OS i
Windows.

32-bitowe systemy operacyjne nie sa obstugiwane w wersji CWS 6.4. Jesli Fiery Software Manager dziata juz w 32-
bitowym systemie operacyjnym, takim jak 32-bitowy Windows 7, nie beda wyswietlane powiadomienia o aktualizacji
dla pakietu CWS 6.4. W przypadku préby zainstalowania tej wersji Fiery Software Manager w 32-bitowym systemie
operacyjnym zostanie wy$wietlony blad zgodnosci, a program Fiery Software Manager nie zostanie uruchomiony.
Informacje na temat obstugiwanych systemdéw operacyjnych mozna znalez¢ pod adresem http://fiery.efi.com/cws-
specifications.

Fiery Color Profiler Suite i Fiery Command WorkStation 6.4

Pakiet Fiery Color Profiler Suite 5.0 (CPS) i starsze wersje nie sa w pelni zgodne z oprogramowaniem Fiery
Command WorkStation Package 6.4 (CWS) dla arkuszowych maszyn cyfrowych. Zaleca si¢ aktualizacje do pakietu
Fiery Color Profiler Suite 5.1.

W przypadku korzystania z programu CPS 5.0 z programem CWS 6.4 moga wystapi¢ nastepujace problemy:

o Jesli w programie CWS jest wyswietlany komunikat ,Podtacz spektrofotometr do komputera”, gdy pakiet CPS
jest otwarty, nalezy zamkna¢ pakiet CPS i klikna¢ przycisk OK, aby kontynuowac.

e Po utworzeniu nowego ustawienia kalibracji w narzedziu Kalibrator przycisk Utwérz nowy profil pozwalajacy
uruchomic¢ pakiet CPS jest ukryty. Ten problem zostal rozwiazany po uaktualnieniu do wersji CPS 5.1.

Sciezka lokalizacji szablonu Impose

Sciezka lokalizacji szablonu Impose zostata usunigta z okna Preferencje w Fiery Hot Folders. Zamiast tego Fiery Hot
Folders uzywa $ciezki szablonu Impose uzywanej przez Fiery Impose, ktéra jest zdefiniowana w Fiery Impose >
Edytuj > Preferencje.


http://fiery.efi.com/cws-specifications
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Ulepszenia funkcji Ustaw domysine

e W oknie Ustaw domysInemozna skorzysta¢ z nowego domyslnego rozmiaru papieru wyjsciowego o nazwie taki
jak rozmiar zadania.

e Zablokowanie opcji taki jak rozmiar zadania powoduje niepozadane rezultaty, a w zwiazku z tym stan
zablokowany jest ignorowany.

e Opcja taki jak rozmiar zadania dla opcji rozmiar papieru wyjsciowego jest niedostepna w przypadku réznych
no$nikéw, nalozenia Booklet Maker lub kolejnosci zadan.

Ulepszenia w obszarze Wlasciwosci zadania

¢ W programie Fiery Command WorkStation 6.4 mozna uruchomi¢ Wtasciwosci zadania w ciagu 2 sekund lub
kréce;j.

o Po otwarciu okna Wiasciwosci zadania dla dowolnego zadania zostang wy$wietlone wszystkie ustawienia
domyslne. Po kliknieciu funkgji takich jak Wykaz papieru, FreeForm czy pasek kontrolny ustawienia w tych
obszarach zostang podstawione.

e Gdy w oknie Wiasciwosci zadania wymagane jest wyswietlenie ponad 500 wpiséw Wykazu papieru, klikniecie
listy Wykaz papieru powoduje op6Znienie w od$wiezeniu okna wynoszace od 8 do 80 sekund. W przypadku gdy
liczba wpiséw przekracza 5000, nalezy spodziewac si¢ op6znienia okolo 80 sekund.

o Do zastosowaniu krzywej w Fiery ImageViewer do zadania nalezy ja usuna¢, a nastepnie sprawdzi¢ wtasciwosci
zadania. Nazwa usunietej krzywej jest nadal wyéwietlana jako skojarzona z zadaniem. Jednak po kliknieciu listy
Zmiany ImageViewer zostaje ona wyczyszczona. Jezeli nie wybrano dostepnej krzywej Fiery ImageViewer,
zostang zachowane oryginalne ustawienia krzywe;j.

e Zachowanie podobne do pustej listy Fiery ImageViewer wystepuje réwniez w innych obszarach Wtasciwosci
zadania, takich jak: Profil wydruku, Zrédto RGB, Zrédto CMYK, Uzyj grupy koloréw dodatkowych, Pasek
kontrolny, Utworz wzorzec oraz Uzyj wzorca.

¢ Mimo ze opcja lub ustawienie Wykaz papieru moze by¢ nieprawidlowe, w tych scenariuszach nie jest
wyswietlany komunikat o bledzie:

» Logujesz sie w Fiery Command WorkStation i wy$wietlasz wlasciwosci zadania, ktére ma prawidtowe
ustawienia zadania Wykazu papieru.

¢ Klikasz liste wpis6w Wykazu papieru w oknie Wlasciwos$ci zadania i wybierasz dowolna opcje Wykazu papieru
z listy.

 Resetujesz Wykaz papieru do ustawien fabrycznych z poziomu Fiery Command WorkStation.

e Wybierasz wlasciwosci zadania, ktére ma juz ustawienia zadania w Wykazie papieru.
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Problemy rozwigzane w programie Fiery Command WorkStation Package w wersji
6.4.0.512

Fiery Command WorkStation

e Szablon Impose z ustawieniem wstepnym o nazwie Znaczniki, zawierajacy dowolne z duzej liczby znakéw
wielobajtowych, czasami powodowal, ze program Fiery Command WorkStation przestawal odpowiadac.

e Na komputerach z systemem macOS z systemem operacyjnym w jezyku francuskim lub niemieckim program
Fiery Calibrator przestawal odpowiada¢ przed zakonczeniem kalibracji.

Problemy rozwigzane w programie Fiery Command WorkStation Package w wersji
6.4.0.500

Fiery Command WorkStation

e W systemie w jezyku japoniskim podczas drukowania strony testowej kalibracji w trakcie tworzenia nowej
kalibracji lub drukowania strony testowej kalibracji z poziomu Menedzera kalibracji nazwy kalibracji i profilu
wydruku na stronie testowej byly nieczytelne.

o Nie mozna bylo utworzy¢ zestawu kalibracyjnego z Wykazem papieru jako Zrédlem papieru.

e Po ponownym uruchomieniu serwera Fiery server w systemie w jezyku japoriskim nie mozna bylo zapisa¢
ustawien wstepnych zadania z poziomu Centrum urzadzen.

e Do przeprowadzeniu ponownej kalibracji rozpoczynalo sie przetwarzanie strony testowej, ale nie byta ona
drukowana.

Fiery Command WorkStation Package v6.4.0.471

Problemy rozwigzane w wersji 6.4.0.471 aplikacji Fiery Command WorkStation Package

Fiery Command WorkStation

o Wyswietlanie miniatur bylo opéznione w okienkach Widok strony i Widok arkusza w aplikacji Fiery Impose i
Fiery Compose.

o Jesli uzytkownik mial wiecej niz 300 szablonéw aplikacji Fiery Impose, wybér szablonu aplikacji Impose po
kliknieciu kolejno opcji Whasciwosci zadania > Uktad > Impose > Szablony powodowal, ze program Fiery
Command WorkStation 6.4 przestawal odpowiadac.

¢ Nie mozna byto uzy¢ opcji Wyszukiwanie zaawansowane w programie Fiery Command WorkStation w celu
wyszukania zadan, w ktérych zastosowano powlekane lub niepowlekane typy no$nikéw.
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Fiery XF

e Aby wydrukowa¢ skalowane zadanie ze znacznikami ciecia, trzeba bylo recznie przesunac¢ zadanie na nosniku w
oknie Job Editor i zmieni¢ polozenie zadania na osiach X iY.

Znany problem w programie Fiery Command WorkStation Package w wersji 6.4.0.471

Fiery Command WorkStation

e Kolory dodatkowe zdefiniowane przy uzyciu znakéw innych niz ASCII nie sa obstugiwane przez arkuszowe
maszyny cyfrowe.

Problemy rozwigzane w programie Fiery Command WorkStation Package w wersji
6.4.0.434

Fiery Command WorkStation

e Do uaktualnieniu programu Fiery Command WorkStation do wersji 6.4 nie mozna bylo wydrukowacé w
programie Fiery Command WorkStation zadania przy uzyciu niestandardowych rozmiaréw papieru
utworzonych w drukarce.

e Do uaktualnieniu aplikacji Fiery Command WorkStation do wersji 6.4 nie mozna bylo zastosowaé punktoréw w
dokumentach programu Microsoft Word.

o Jezelijako gléwny folder uzytkownika byla ustawiona lokalizacja sieciowa, podczas uruchamiania aplikacji Fiery
Impose, Fiery Compose albo Fiery JobMaster wyswietlal sie nieprawidlowy komunikat o bledzie.

e Podczas tworzenia i przywracania kopii zapasowej z zastosowaniem wielopoziomowej struktury folderéw
aplikacja Fiery Hot Folders ignorowata strukture folderéw. Obecnie w przypadku przywracania kopii zapasowej
struktura folderéw aplikacji Fiery Hot Folders jest zachowywana.

Fiery XF

o Liczba aktualizacji Fiery XF na dzien zwigkszalaby sie, jesli aplikacja Fiery Command WorkStation dzialataby
nieprzerwanie na komputerze klienckim z systemem Windows.

e W sekcji dostepnej po wybraniu kolejno opcji Color Tools > Ustawienia, ustawienie wytwarzania péitonéw
Rastrowanie stochastyczne (SE2) zawsze zmienilo sie z powrotem na Rozpraszanie btedéw (SE1).

o W sekcji dostepnej po wybraniu kolejno opcji Color Tools > Maksymalna suma wartosci tonalnych, po
zdefiniowaniu niestandardowej konfiguracji wykresu nie mozna bylo wydrukowaé wykresu Maksymalna suma
warto$ci tonalnych (TIL). Tre$¢ komunikatu o bledzie sugerowala, ze ustawienia przekroczyly rozmiar nosnika.

e Aktualizacja programu Fiery Command WorkStation do wersji 6.4 powodowata usuniecie folderu C:
\ProgramData\Fiery\Fiery XF\Client\Working.

Uwaga: W przypadku odinstalowywania biezacej wersji programu Fiery Command WorkStation i
aktualizowania do najnowszej wersji nie nalezy usuwac zadnych preferencji. Usuniecie preferencji spowoduje
usuniecie folderu C:\ProgramData\Fiery\Fiery XF\Client\Working w toku dezinstalacji, co moze skutkowa¢ utrata
waznych danych zadan (dotyczy tylko systemu Windows).
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Problemy rozwigzane w pakiecie Fiery Command WorkStation Package w wersji
6.4.0.358

Fiery Command WorkStation

e Do przelaczeniu ze standardowych znacznikéw przyciecia na japonskie przy okreslonej wartosci przesuniecia
w programie Fiery Impose w oknach Podglad zadania i Widok arkusza stosowany byl jeden znacznik przyciecia.

¢ Po utworzeniu szablonu dla pliku PDF z ré6znymi rozmiarami strony przy ustawieniu Wyréwnaj do $rodka
ustawienia szablonu nie byly prawidtowo stosowane w zadaniu. Aby méc skorzystac z szablonu i osiggnac
oczekiwany rezultat, nalezy ponownie utworzy¢ szablon.

o Niewykorzystane zakladki zadania w programie JobMaster nie byly wysuwane na okreslong tace.

e Po utworzeniu nowego profilu kalibracji przez zduplikowanie i zmiane nazwy istniejacego profilu wlasciwosci
tego nowego profilu nie byly zgodne z profilem pierwotnym.

e Miniatury podgladu strony nie byly generowane w programach Podglad Fiery, Fiery Impose, Fiery Compose i
Fiery JobMaster.

Fiery XF

e W przypadku uzywania krajarki MATIC przy zadaniach powtarzalnych pozycje znacznikéw ciecia wyswietlane
w programie Job Editor nie pasowaly do pozycji znacznikéw ciecia na wydruku.

e Nazwa uzytkownika systemu zawierajaca znaki akcentowane (na przyklad z akcentem ostrym) czasami sprawiata,
ze program Server Manager przestawal odpowiada¢. Ponadto po zmianie folderu roboczego na folder, ktérego
nazwa zawierala znaki cyrylicy, system nie mégt odnalez¢é nowego folderu.

o Karta graficzna NVIDIA GeForce GTX1660 sprawiala, ze programy Server Manager i Job Editor przestawaly
odpowiadac.

Fiery Command WorkStation Package v6.4.0.321

Problemy rozwigzane w oprogramowaniu Fiery Command WorkStation Package w wersji
6.4.0.321
Zostaly rozwigzane nastepujace problemy:

Fiery Command WorkStation

e Podczas edycji krzywych koloréw istniejacego profilu wydruku w menu Centrum urzadzen > Zasoby > Profile >
Profile wydruku wprowadzone zmiany nie byly zapamietywane.

e Po przywrdceniu aplikacji Hot Folders z pliku kopii zapasowej nie mogta ona przetworzy¢ niektérych plikow.
Fiery XF

¢ W aplikacji Job Editor znaczniki odciecia w zadaniach zagniezdzania i zadaniach powtarzanych nie sa juz
wyswietlane na obszarach margineséw niedrukowalnych drukarki.

e Teraz mozna poprawnie zapisywac zrédia i metody wycinania konturéw jako ustawienie wstepne.

¢ Przycisk wycinania Kontur jest teraz dostepny dla urzadzen drukujacych i wycinajacych w systemach
operacyjnych macOS.

e Gdy zadanie zostalo przyciete po obrdceniu, nastepowalo odwracanie kolejnosci wymiaréw.
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Poprzednio margines przyciecia byt ograniczony do 1000 cm. Obecnie maksymalny margines przyciecia moze
wynosic tyle samo, co szeroko$¢/wysokos$¢ zadania.

Podczas edycji pliku VPC we wtyczce Color Tools byly wyswietlane krzywe wszystkich kanaléw, nawet jesli
wybrano tylko jeden kanat koloru.

Znany problem z oprogramowaniem Fiery Command WorkStation Package w wersji
6.4.0.321

Fiery Command WorkStation

Na komputerach z systemem macOS etykietki narzedzi nie sg wySwietlane dla zadnej z ikon w aplikacjach Fiery
Preview, Fiery Impose, Fiery Compose i Fiery JobMaster.

Problemy rozwigzane w programie Fiery Command WorkStation Package w wersji
6.4.0.261 SP1

Jesli uruchomiono program Fiery Command WorkStation natychmiast po uruchomieniu Fiery server, a
nastepnie wybrano tace odbierania papieru (lub inng opcje do zainstalowania) w oknie Wlasciwosci zadania,
opcja byla czasami wyéwietlana jako niezainstalowana. Teraz wyswietlane sa prawidlowe ustawienia.

Po dokonaniu uaktualnienia Fiery Command WorkStation do wersji 6.4 w systemie MacOS i polaczeniu si¢ z
Fiery server po raz pierwszy, Fiery Command WorkStationczasami przestal odpowiadad, a nastepnie zakonczylt
dziatanie. Ten problem zostal rozwiazany.

Gdy prébowano otworzy¢ Wtasciwosci zadania, program nieoczekiwanie zamykat sie, jesli opcja Wykonczenie >
Zagiecie zostala dodana do karty Szybki dostep przed dokonaniem uaktualnienia do Fiery Command
WorkStation 6.4. Ten problem zostal rozwiazany.
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Bu belge, stiriim hakkinda 6nemli bilgiler icermektedir. Yiikleme islemine devam etmeden 6nce tiim kullanicilara bu
bilgileri sagladiginizdan emin olun.

Bu surim hakkinda
Asagidaki uygulamalar bu stiriime dahil edilmistir:
o Fiery Command WorkStation Package v6.4.0.512

e Fiery Command WorkStation v6.4.00.62
e Mac v4.00.0.31 i¢in Fiery Hot Folders
e Windows v4.00.0.31 icin Fiery Hot Folders

o Fiery Software Manager v4.3.0.13

Yiikseltme

Bu yiikleyici tiim mevcut Fiery Command WorkStation Package 6gelerini Fiery Command WorkStation ve Fiery Hot
Folders iceren son pakete yiikseltecektir. Istege bagli olarak, Fiery Software Manager 6gesini kullanarak Fiery Remote
Scan'i yiikleyebilirsiniz.

Not: Fiery Command WorkStation Package v6.4.0.512, macOS Catalina 10.15'te desteklenmez. Fiery Command
WorkStation 6gesini macOS Catalina 10.15'te kullanmak icin mevcut Fiery Command WorkStation Package 6gesini
en son pakete yiikseltmeyin veya Fiery Command WorkStation Package 6.5 kullanin.

Fiery Command WorkStation siiriim 5.x'den 6.4'e yiikseltmek icin ilk olarak Command WorkStation 6.3'e (Fiery
Software Manager'da mevcuttur) ardindan 6.4 stiriimiine yiikseltin.

Fiery Command WorkStation Package, FS100 veya sonrasi ve Fiery proServer ve Fiery XF 7.0 veya sonrasi calistiran
Fiery servers Ogesini destekler. Asagidakilere baglanmaz:

o Fiery System 9/9e Rel2 ve System 10 yazilim1 ve dnceki stiriimleri ¢alistiran Fiery servers
o Fiery XF 6.x sunucular1 ve daha 6nceki siirtimleri

o Fiery Central sunucular1

Bu iiriinlere erismeniz gerekiyorsa, ylikseltmeyin. Fiery Extended Applications Paket hala www.efi.com/cws
adresinde mevcuttur. Desteklenen tiim kesilmis yaprak baski makinelerinin bir listesi i¢in bkz. http://
fiery.efi.com/CWS/supported-printers.
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Teknik 6zellikler hakkinda daha fazla bilgi icin www.efi.com/cws adresini ziyaret edin.

Yenilikler

Yeni 6zellikler hakkinda daha fazla bilgi i¢in http://fiery.efi.com/CWS/Whats-New adresini ziyaret edin.

macOS 10,15 (Catalina) bilgileri

macOS 10.15'te Fiery Preview, Fiery Impose, Fiery Compose veya Fiery JobMaster

PDF destek uygulamalari kiti

Adobe Acrobat ve Enfocus PitStop'tan olusan PDF destek uygulamalari kiti (EFI tarafindan saglanir), macOS
10.15 (Catalina) ile uyumlu degildir. Acrobat ve/veya PitStop kullaniyorsaniz macOS 10.15'e yiikseltmeyin. Yeni
yiiklemeler icin PDF destek uygulamalari yiikleyicisi ¢alismaz.

Gtincel PDF destek uygulamalari kitini kullanirken macOS 10.15 siiriimiine yiikseltme islemi asagidaki sorunlara
neden olabilir:

e macOS 10.15 siiriimiine yiikseltmeden 6nce Acrobat DC zaten yiikliiyse normal olarak ¢alisacaktir. Ancak
Acrobat DC yiikleyicisi macOS 10.15 ile uyumlu degildir, bu nedenle yeni Acrobat DC yiiklemeleri miimkiin
degildir. Ayrica dahili Enfocus PitStop, macOS 10.15'de desteklenmez.

e macOS 10.15 siiriimiine yiikseltmeden 6nce Acrobat XI zaten yiikliiyse calismayacaktir ve macOS 10.15'te
desteklenmez. macOS 10.15 siiriimiine yiikseltmeden 6nce Acrobat XI 'y1 kaldirmanizi dneririz. Acrobat XI
program kaldirici macOS 10.15 {izerinde ¢alismaz, bu nedenle Acrobat XI yiikli iken macOS 10.15'e
yiikseltirseniz sisteminizde Acrobat XI calismayacak ve kaldirilamayacaktur.

Uyumlu bir Acrobat siiriimii yiikklenmezse asagidaki sorunlar olacaktir:

¢ Acrobat'ta Dlzenle islevi, Fiery Impose, Fiery Compose ve Fiery JobMaster icinde kullanilamaz.

o Fiery Preview, Fiery Impose, Fiery Compose veya Fiery JobMaster ile bir PostScript isini agma bir hataya
neden olabilir.

¢ Kullanici tanimli sonlandirma boyutu veya Kesim kutusuna gore is akislar1 kullanan Fiery Impose sablonlari,
PostScript islerde diizgiin ¢alismayabilir.

o Fiery Hot Folders, PostScript dosyalar1 PDF'ye doniistiirme secenegi sunmaz.

Diger sorunlar

Daha eski bir macOS siiriimiinden macOS 10.15'e yiikselttikten sonra Fiery Preview'1 baglatirken Fiery Impose,
Fiery Compose veya Fiery JobMaster asagidaki mesajlardan birinin gériintiilenmesine neden olabilir:

e "ICUConverter.framework" bilgisayariniza zarar verecek. Onu Cop Kutusuna tagimalisin.

"ICUData.framework" bilgisayariniza zarar verecek. Onu C6p Kutusuna tagimalisin.

macOS 10.15, hatali sekilde bu dosyalar1 kotii amacl yazilim olarak algilar. Bu sorunlari ¢6zmek icin macOS
10.15 ile uyumlu Fiery Command WorkStation Package siiriim 6.4.0.396 veya sonrasini yeniden yiikleyin.

Fiery Preview, Fiery Impose, Fiery Compose ve Fiery JobMaster 6gesindeki denetim simgelerinin diigmeleri
tizerinde imlecinizi gezdirdiginizde arag ipugclar1 goriintillenmez.


http://www.efi.com/cws
http://fiery.efi.com/CWS/Whats-New

Musteri strim notlan |123
Fiery Command WorkStation Package, v6.4

Tam disk erisimi

macOS 10.15'in giivenligi yonetme seklindeki degisiklikler nedeniyle Fiery uygulamalarinin diizgiin ¢alisabilmesi
icin gerekli ek adimlar mevcuttur.

Fiery uygulamalarin giincellemeleri yonetmesi ve Impose sablonlari ve ¢alisma klasorleri gibi dosyalara erismesi
icin macOS'deki Tam disk erisimi gtivenlik 6zelligi tizerinde degisiklik yapmaniz gerekir. Fiery Command
WorkStation gibi Fiery uygulamalari i¢in Tam disk erisimi'ni etkinlestirin.

1 Tim Fiery uygulamalarini kapatin.

2 Sistem Tercihleri > Guvenlik ve gizlilik > Gizlilik > Tam disk erigimi.
3 Sol alt kosedeki Kilitle simgesine tiklayin ve sifrenizi girin.

4 + digmesine tiklayin.

5 Uygulamalar klasoriinde Fiery Software Manager ve Fiery Software Uninstaller se¢imini yapin ve A¢'a
tiklayin.

Bu uygulamalar, bilgisayarinizdaki Fiery uygulamalarini korumak ve giincellemek icin tam disk erisimi
gerektirir.

6 Uygulamalar klasoriinde Fiery Command WorkStation 6gesini secin ve A¢'a tiklayin.

7 Fiery Hot Folders veya Fiery Remote Scan kullaniyorsaniz her uygulamayi secin ve A¢'a tiklayin.

Fiery Hot Folders, Belgeler, Masaiistii ve Indirilenler klasérlerinin kullanildigini algilarsa tam disk erisimi
isteyen bir mesaj verir. Bu mesaj erisim izni verildikten sonra bile goriintiilenir. Bu mesaji kapatabilir ve
calismaya devam edebilirsiniz.

macOS 10.15'te Safari tarayici hatalari

macOS 10.15'te Safari kullaniyorsaniz, Fiery Command WorkStation 6gesinden asagidaki web sayfalarini agmaya
calisirken tekrarlanan tarayici hatalariyla karsilasacaksiniz Cihaz merkezi'ne tiklayin > Genel > Araglar:

o Fiery Sistem Geri Yiiklemesi
o Fiery System Goriintiisii
o Fiery kaynaklari ve ayarlar1

Bu hatalar, ayrica Safari tarayicisinda Fiery WebTools'u actiginizda da meydana gelebilir.

Bu web sayfalarina erismek i¢in Chrome veya Firefox kullanin.

Fiery XFmacOS 10,15

Renk Verifier ile Fiery XF kullanirsaniz, macos 10,15 ' a Upgrade’leri.

Bir Fiery XF sunucuya baglandiginizda, renk Verifier uygulama macos 10,15 ile uyumlu degildir. Renk Verifier
giincellemenizi soran bir mesaj olsa da su anda kullanilabilir giincelleme yoktur. Click OK to dismiss the
message.
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Fiery Spot Pro

Fiery Command WorkStation 6.4 nokta renklerini, Fiery Spot-On'un yerini alan Fiery Spot Pro ile yonetmenize
olanak saglar. Fiery Spot Pro asagidaki iyilestirmeleri ve daha fazlasini icerir:

e Adobe Photoshop gibi Adobe Creative Suite uygulamalarinda 6rnek kiitiiphane olarak kullanmak iizere nokta
renklerini ASE formatinda gonderin.

o Tium profillere kolay bir sekilde nokta rengi diizenlemeleri uygulayin.
o Istediginiz sayfa boyutuna uyacak sekilde 6zel 6rnek kitaplar olusturun.
fyilestirmelerin tam listesi icin bkz. https://www.efi.com/spotpro.

Fiery Spot Pro asagidaki gereksinimleri karsilayan secili sunucularda kullanilabilir:

e FS200 Pro ve daha iistii yazilim

o Fiery Graphic Arts Package, Premium Edition

http://fiery.efi.com/spotpro/supported-printers adresinde daha fazla bilgi edinin.

Fiery server 6genizde Fiery Spot Pro etkinlestirilmis degilse Fiery Command WorkStation Fiery Spot-On'u
desteklemeye devam edecektir.

Fiery Spot Pro kullanma hakkinda 6nemli bilgiler

e Herhangi nokta rengi adinda "@" semboliinii kullanmayin.

e Spot Pro'yu baslattikdan sonra arama islevini kullanmadan veya ¢ikt1 profillerini degistirmeden 6nce yaklasik
60-120 saniye bekleyin.

o Nokta renklerinin optimizasyonu, birkag yenilemeden sonra orijinal nokta renk ve doniistiiriilmiis nokta rengi
arasinda daha belirgin farkliliklara neden olabilir.

o Dontstirilmils L*a*b* degerleri ve cihaz CMYK degerlerinde hafif bir sayisal yuvarlama vardur.

e Farkl kullanici sistemleriyle ayni Fiery server 6gesine iki Spot Pro baglantis: gerceklestirildiginde, iki kullanici da
duzenleme islemi gerceklestirirse bu durum hatalara neden olabilir.

Fiery sistem yazilmindan bagimsiz olarak Fiery Command WorkStation Package 6gesini
glincelleme

Fiery Command WorkStation yazilimi artik yiikleme sirasinda standart uygulama gibi davranir.

Fiery Command WorkStation Package 6gesini Fiery server tizerinde yiikleme artik uzak bir istemciye yiikleme ile
aynidir. Bu, Fiery server tizerine yiiklenen Fiery Command WorkStation Package yaziliminin yeniden yiiklenmesi
veya yiikseltilmesi gerekirse analist veya teknisyenlerin Sistem yazilimi1 DVD'lerine gereksinim duymamasi anlamina
gelir.

Fiery Command WorkStation 6gesini Fiery server iizerinde yiiklerken yiikleme, WebTools veya SMB iizerinden
paylasilan yazilim paketlerini giincellemeyecektir. Ayrica Fiery hizmeti Fiery Command WorkStation 6.4 yiikleme/
ylikseltme/kaldirma iglemi sirasinda durdurulmaz.


https://www.efi.com/spotpro
http://fiery.efi.com/spotpro/supported-printers
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Fiery XF sunucuya yiikleme

Fiery Command WorkStation Package siiriim 6.4t Fiery XF 7.x sunucuya yiiklediginizde yiikleme islemi esnasinda
Fiery XF sunucu durdurulur. Yitkkleme tamamlandiktan sonra Fiery XF otomatik olarak yeniden calistirilacaktur.

64 bit uygulama

Fiery Command WorkStation 6.4 (CWS), hem macOS hem de Windows platformlari i¢in yerel bir 64 bit
uygulamadr.

32 bit igletim sistemlerinde CWS 6.4 desteklenmez. Fiery Software Manager, halihazirda Windows 7 32 bit gibi 32 bit
bir isletim sisteminde calisiyorsa, CPS 6.4 paketi i¢in giincelleme bildirimlerini gortintiilemez. Bu Fiery Software
Manager stiriimiinii bir 32 bit isletim sistemine yiiklemeye calisirsaniz bir uyumluluk hatasi goriirsiiniiz ve Fiery
Software Manager calismaz. Desteklenen igletim sistemlerini goriintillemek icin bkz. http://fiery.efi.com/cws-
specifications.

Fiery Color Profiler Suite ve Fiery Command WorkStation 6.4

Fiery Color Profiler Suite 5.0 (CPS) ve ve 6nceki siiriimler, kesilmis yaprak baski makineleri i¢in Fiery Command
WorkStation Package 6.4 (CWS) ile tam olarak uyumlu degildir. Fiery Color Profiler Suite 5.1'e giincellemenizi
oneririz.

CPS 5.01 CWS 6.4 ile kullanirken asagidaki sorunlarla karsilasabilirsiniz:

e CPS agikken CWS'de "Spektrofotometreyi bilgisayariniza baglayin" mesajini goriirseniz, CPS'yi kapatin ve devam
etmek icin Tamam'a tiklayin.

o Kalibrator'de yeni bir kalibrasyon ayar1 olusturduktan sonra CPS'yi baglatmak i¢in kullanilan Yeni profil olustur
dtugmesi gizlenir. CPS 5.1'e ylikselttikten sonra bu sorun giderilmistir.

Impose sablonu konumu yolu

Impose sablonu konumu yolu Fiery Hot Folders tercihlerinden kaldirilmigtir. Bunun yerine Fiery Hot Folders,
asagida tanimli olan ve Fiery Impose tarafindan kullanilan Impose sablon yolunu kullanir: Fiery Impose > Diizenle >
Tercihler.

Varsayilanlari ayarla iyilestirmeleri

e Varsayilanlar ayarla'da is boyutu ile ayni olarak adlandirilan yeni bir varsayilan Cikti kagit boyutu kullanilabilir.
o Isboyutuile ayni secenegini kilitleme istenmeyen sonuclara neden olur ve kilitli durum bu nedenle yok saylir.

o Ciktikagit boyutu icin is boyutu ile ayni secenegi Karma ortam, montaj veya Booklet Maker is akislar1 icin
kullanilamaz.


http://fiery.efi.com/cws-specifications
http://fiery.efi.com/cws-specifications
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is 6zellikleri iyilestirmeleri

Fiery Command WorkStation 6.4 dgesinde Is 6zellikleri'ni 2 saniye veya daha az bir siirede baslatabilirsiniz.

Herhangi bir is icin is 6zellikleri penceresini actiginizda tiim varsayilanlar1 gériintiiler. Paper Catalog, FreeForm,
denetim ¢ubugu gibi islevlere tikladiginizda bu alanlarin ayarlari doldurulacaktir.

is 6zellikleri'nin 500'den fazla Paper Catalog girisini goriintiilemesi gerekiyorsa Paper Catalog listesinin
tiklanmasi, pencerenin yenilenmesinde yaklasik 8 - 80 saniye gecikmeye neden olur. 5.000 civarinda giris varsa 80
saniye kadar bir gecikme bekleyin.

Bir ise egriyi Fiery ImageViewer 6gesinde uyguladiginizda, egriyi silip ardindan isin 6zelliklerini incelediginizde
silinen egri adi1 halen isle iligkilendirilmis olarak goriintiilenir. Ancak ImageViewer diizenlemeleri listesini
tikladiginizda bos goriiniir. Kullanilabilir bir Fiery ImageViewer egrisi secmezseniz egri icin orijinal ig ayarlar:
korunacaktir.

* Bos Fiery ImageViewer listesine benzer bir davranis ayrica is dzellikleri'nin diger alanlarinda da ortaya cikar:
Cikti profili, RGB kaynagi, CMYK kaynadi, Nokta grubu kullan, Denetim cubugu, Ana kopya olustur ve Ana
kopyayi kullan.

Paper Catalog secenegi veya ayari gecersiz olsa bile bu durumlarda bir hata mesaji goriintiilenmez:

e Fiery Command WorkStation 6gesinde oturum acgarsiniz ve gecerli Paper Catalog is ayarlarina sahip bir is icin
ozellikleri goriintiilersiniz.

* Is 6zellikleri icindeki Paper Catalog girislerinin listesine tiklar ve listeden herhangi bir Paper Catalog
secenegini secersiniz.

e Fiery Command WorkStation 6gesinden Paper Catalog'u fabrika ayarlarina sifirlarsiniz.

e Zaten Paper Catalog is ayarlarina sahip bir is icin 6zellikleri secersiniz.

Fiery Command WorkStation Package v6.4.0.512'de dizeltilen sorunlar

Fiery Command WorkStation

Cok sayida ¢ok baytl karakterden herhangi birini iceren Bicimlendirme 6n ayar1 adli Impose sablonu bazen Fiery
Command WorkStation 6gesinin yanit vermesini engelliyordu.

macOS bilgisayarlarda isletim sistemi dili Fransizca veya Almanca olarak ayarlanmigsa Fiery Calibrator
kalibrasyon tamamlamadan 6nce yanit vermiyordu.

Fiery Command WorkStation Package v6.4.0.500'de diizeltilen sorunlar

Fiery Command WorkStation

Bir Japonca dil sisteminde yeni bir kalibrasyon olustururken kalibrasyon test sayfasi yazdirdiginizda veya
Kalibrasyon Yoneticisi 6gesinden bir kalibrasyon test sayfasi yazdirdiginizda test sayfasindaki kalibrasyon adi ve
cikt1 profili ad1 bozuk olarak gériiniiyordu.

Kagit kaynag olarak Paper Catalog girisine sahip bir kalibrasyon seti olusturamiyordunuz.
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o Japonca dil sisteminde Fiery server dgesini yeniden baslatirsaniz, Cihaz merkezi'nden olusturulan Is 6n ayarlarini
kaydedemiyordunuz.

o Yeniden kalibrasyon islemi gerceklestirdiginizde kalibrasyon test sayfasi islenmeye bashyor ancak asla
yazdirilmryordu.

Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation Package v6.4.0.471'de diizeltilen sorunlar

Fiery Command WorkStation

o Fiery Impose ve Fiery Compose dgelerinin Sayfa goriiniimii ve Yaprak goriinimi bélmelerinde kii¢iik resimlerin
gorintisi gecikiyordu.

o Fiery Impose dgesine ait 300'den fazla sablonunuz varsa asagidaki sekilde bir Impose sablonu secildigi zaman Ig
ozellikleri > Dlzen > Impose > $Sablonlar Fiery Command WorkStation 6.4'iin yanit vermemesine neden
oluyordu.

o Kaplanmis veya kaplanmamis malzeme tiirlerini iceren isleri aramak icin Fiery Command WorkStation 6gesinde
Gelismis arama segenegi kullanilamiyordu.

Fiery XF

¢ Kesme isaretlerinin bulundugu 6l¢eklenen bir isi yazdirmak i¢in isi Job Editor'de yer alan ortam icinde el ile
hareket ettirmeniz ve isin X ve Y konumlarini degistirmeniz gerekiyordu.

Fiery Command WorkStation Package v6.4.0.471'deki bilinen sorun

Fiery Command WorkStation

e ASCII olmayan karakterler kullanilarak tanimlanan nokta renkleri, kesilmis yaprak baski makinelerinde
desteklenmemektedir.

Fiery Command WorkStation Package v6.4.0.434'de dizeltilen sorunlar
Fiery Command WorkStation

e Fiery Command WorkStation 6.4 siiriimiine yiikselttikten sonra baski makinesinde olusturulan 6zel kagt
boyutlarini kullanarak Fiery Command WorkStation iizerinde is yazdiramadiniz.

e Fiery Command WorkStation 6.4 siiriimiine yiikselttikten sonra Microsoft Word belgelerinde madde isaretleri
uygulayamadiniz.

o Kullanici ana klasorii bir ag klasoriine ayarliyken Fiery Impose, Fiery Compose veya Fiery JobMaster 6gelerini
baslattiginizda yanlis bir hata mesaji olustu.

o Fiery Hot Foldersbirden fazla diizeyde derin klasor yapilarini yedeklediginizde ve geri yiiklerken klasor yapisini
atmak icin kullanilmistir. Klasor yapisi Fiery Hot Folders artik bir yedekten geri yiiklendikten sonra korunur.
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Fiery XF

e Fiery Command WorkStation bir Windows istemci bilgisayarinda siirekli calisiyorsa giinliik Fiery XF giincelleme
sayis1 artacakti.

» Bilgisayarin Color Tools > Ayarlar, noktali resim ayar1 Raslantisal tarama (SE2) her zaman Hata dagilimina (SE1)
geri dontiyordu.

¢ Bilgisayarin Color Tools > Toplam murekkep siniri, 6zel grafik yapilandirmasini tanimladiktan sonra Toplam
miirekkep sinir1 (TIL) grafigini yazdiramiyordunuz. Bir hata mesaji, ayarlarin ortam boyutunu astigini
belirtiyordu.

¢ Fiery Command WorkStation 6.4 stiriimiine yiikseltme C:\ProgramData\Fiery\Fiery XF\Client\Working
klasoriiniin silinmesine neden oluyordu.

Not: Fiery Command WorkStation mevcut siiriimiinii kaldirirken ve en son siiriime yiikseltirken herhangi bir
tercihi silmeyin. Tercihler silindiginde C:\ProgramData\Fiery\Fiery XF\Client\Working klasérii kaldirilacak ve bu
onemli is verilerinin kaybiyla sonuclanabilecektir (sadece Windows i¢in gegerlidir).

Fiery Command WorkStation Package v6.4.0.358'de diizeltilen sorunlar
Fiery Command WorkStation

o Fiery Impose'da, belirli bir ofset degeri ile standart bir kirpma isaretinden Japonca kirpma isaretine gecis
yaptiysaniz, Is 6nizlemesi ve Yaprak gériiniimii pencerelerinde tek bir kirpma isareti uygulaniyordu.

o Fiery Impose'da, Ortaya hizala konumlandirmasi ile karma sayfa boyutlu PDF i¢in bir sablon olusturdugunuzda,
is icin sablon ayarlar1 dogru sekilde uygulanmiyordu. Sablonu beklenen ¢ikti ile basarili bir sekilde kullanmak icin
sablonu yeniden olusturun.

o JobMaster isinin kullanilmayan sekmeleri, belirtilen kasete ¢ikarilmiyordu.

e Mevcut bir profili cogaltarak ve yeniden adlandirarak yeni bir kalibrasyon profili olusturdugunuzda, yeni profilin
ozellikleri orijinal profille eslesmiyordu.

o Sayfa 6nizlemedeki kii¢iik resimler Fiery onizleme, Fiery Impose, Fiery Compose ve Fiery JobMaster'da
olusturulmuyordu.

Fiery XF

e Adimla ve Tekrarla isleri ile MATIK kesici kullandiginizda, Job Editor goriintiilenen kesme isareti pozisyonlari
ciktidaki kesme isareti konumlariyla eslesmiyordu.

o Sapkali karakterler igeren sistem kullanici adi (sesli harf tizerindeki aksan isareti gibi) bazen Server Manager'in
yanit vermemesine neden oluyordu. Ayrica, ¢alisma klasoriinii Kiril karakterlerini iceren bir klasor adu ile
degistirince yeni klas6r bulunamiyordu.

o NVIDIA GeForce GTX1660 grafik karti, Server Manager'in ve Job Editor'in yanit vermemesine sebep oluyordu.

Fiery Command WorkStation Package v6.4.0.321

Fiery Command WorkStation Package v6.4.0.321'de diizeltilen sorunlar

Asagidaki sorunlar dizeltilmistir:



Musteri strim notlar 129
Fiery Command WorkStation Package, v6.4

Fiery Command WorkStation

o Cihaz merkezi > Kaynaklar > Profiller > Cikti profilleri'nde varolan bir ¢ikt1 profilinin renk egrilerini
duizenlediginizde degisiklikler kalici olmadi.

e Yedek dosyadan Hot Folders' geri yiiklediginizde Hot Folders bazi dosyalar1 isleyemedi.
Fiery XF

¢ Job Editor'de i ice yerlestirme ve adimlama ve tekrarlama isleri icin kesme isaretleri artik yazicinin
yazdirilamayan kenar bosluklarinda goriintillenmez.

o Artik kesim kontur kaynaklarini ve yontemleri 6n ayar olarak dogru sekilde kaydedebilirsiniz.
o Kontur kesme diigmesi artik macOS isletim sistemlerinde yazdirma ve kesme cihazlarinda kullanilabilir.
e Bir is dondiirdiikten sonra kirpildiginda boyutlar: tersine cevrildi.

o Kirpma kenar boslugu daha 6énce 1000 cm ile sinirliydi. Maksimum kirpma kenar boslugu artik isin genisligi/
yiiksekligiyle aynidir.

e Color Tools'da bir VPC dosyasini diizenlerken yalnizca bir renk kanali se¢mis olsaniz bile tiim renk kanallar:
egrileri goriintiileniyordu.

Fiery Command WorkStation Package v6.4.0.321'de bilinen sorun

Fiery Command WorkStation

o macOS bilgisayarlarda arag ipuclari Fiery Preview, Fiery Impose, Fiery Compose ve Fiery JobMaster'daki denetim
simgelerinin hic¢birinde goriintilenmez.

Fiery Command WorkStation Package v6.4.0.261'de diizeltilen sorunlar

o Fiery Command WorkStation dgesini Fiery server 6gesini baglattiktan hemen sonra baslatip ve sonra Is
ozellikleri'nde bir istifleyici tepsisi (veya diger bir kurulabilir secenek) secerseniz secenek, bazen yiikla degil
seklinde gosteriliyordu. Simdi dogru ayarlar goriintiilenir.

e macOS'de Fiery Command WorkStation 6.4 siiriimiine giincelleme yapip Fiery server 6gesine ilk kez
baglandiginizda Fiery Command WorkStation bazen tepki vermiyor ve sonra kapaniyordu. Bu sorun simdi
¢Ozilmustir.

o s 6zellikleri'ni agmaya calistiginizda eger Sonlandirma > Kirma secenegi Fiery Command WorkStation 6.4
siiriimiine giincelleme yapmadan Hizli erisim sekmesine eklenmisse Is 6zellikleri beklenmedik bir sekilde
kapaniyordu. Bu sorun simdi ¢oziilmiistiir.
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Tento dokument obsahuje dulezité informace o této verzi produktu. Nez budete pokracovat v instalaci, nezapomerite
tyto informace poskytnout vsem uzivateltim.

Informace o této verzi
Tato verze obsahuje nasledujici aplikace:
o Fiery Command WorkStation Package v6.4.0.512

* Fiery Command WorkStation v6.4.00.62
e Fiery Hot Folders pro Mac v4.00.0.31
e Fiery Hot Folders pro Windows v4.00.0.31

o Fiery Software Manager v4.3.0.13

Upgradovani

Tento instala¢ni program provede upgrade vaseho stavajiciho bali¢cku Fiery Command WorkStation Package na
nejnovéjsi verzi, kterd obsahuje aplikaci Fiery Command WorkStation a Fiery Hot Folders. Aplikaci Fiery Remote
Scan muizete také volitelné nainstalovat pomoci Fiery Software Manager.

Poznamka: Balicek Fiery Command WorkStation Package v6.4.0.512 neni v systému macOS Catalina 10.15
podporovan. Chcete-li v systému macOS Catalina 10.15 pouzivat aplikaci Fiery Command WorkStation,
neprovadéjte upgrade stavajiciho balicku Fiery Command WorkStation Package na nejnovéjsi verzi ani nepouzivejte
Fiery Command WorkStation Package 6.5.

Chcete-li upgradovat aplikaci Fiery Command WorkStation verze 5.x na verzi 6.4, nejdiive upgradujte na verzi
Command WorkStation 6.3 (k dispozici v ndstroji Fiery Software Manager) a pak provedte upgrade na verzi 6.4.

Fiery Command WorkStation Package podporuje Fiery servers se systémem FS100 a novéjsim, Fiery proServer a
Fiery XF 7.0 a novéjsim. Neptipoji se k:

o Fiery servers se systémem Fiery System 9/9e Rel2 a softwarem System 10 a pfedchozimi verzemi
o Servery Fiery XF 6.x a star$i

e Serveriim Fiery Central
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Pokud potiebujete pristup k témto produktiim, neprovadéjte upgrade. Fiery Extended Applications Package je stale k
dispozici na adrese www.efi.com/cws. Uplny seznam podporovanych tiskaren na volné listy viz http://
fiery.efi.com/CWS/supported-printers.

Dalsi informace o technickych specifikacich naleznete na adrese www.efi.com/cws.

Co je nového?

Dalsi informace o novych funkcich jsou dostupné na strankach http://fiery.efi.com/CWS/Whats-New.

Informace tykajici se systému macOS 10.15 (Catalina)

Fiery Preview, Fiery Impose, Fiery Compose nebo Fiery JobMaster v systému MacOS 10.15

Sada aplikaci pro podporu PDF

Sada aplikaci pro podporu PDF (poskytovana spolecnosti EFI), ktera obsahuje aplikace Adobe Acrobat a Enfocus
PitStop, neni kompatibilni se systémem macOS 10.15 (Catalina). Pokud pouzivate aplikaci Acrobat nebo
PitStop, neprovadéjte upgrade na systém macOS 10.15. Pro nové instalace aplikaci pro podporu PDF se
instala¢ni program nespusti.

Po upgradu na systém macOS 10.15 se pfi pouzivani aktudlni sady podptirnych aplikaci PDF mohou objevit

nésledujici problémy:

e Pokud mate pred upgradem na systém macOS 10.15 jiz nainstalovanou aplikaci Acrobat DC, spusti se
normalné. Instala¢ni program aplikace Acrobat DC vsak neni kompatibilni se systémem macOS 10.15, takze
novou instalaci aplikace Acrobat DC nelze provést. Enfocus PitStop, které je soucdsti sady, navic neni v
systému macOS 10.15 podporovan.

e Pokud mate aplikaci Acrobat XI jiz nainstalovanou pfed upgradem na systém macOS 10.15, nespusti se a
neni podporovana pro systém macOS 10.15. Pied upgradem na systém macOS 10.15 doporucujeme aplikaci
Acrobat XI odinstalovat. Odinstala¢ni program pro aplikaci Acrobat XI se v systému macOS 10.15 nespusti,
takze pokud provedete upgrade na systém macOS 10.15, kdyz je aplikace Acrobat XI stéle nainstalovana,
dostane se vas systém do situace, kdy aplikace Acrobat XI nefunguje a nelze ji odinstalovat.

Pokud neni nainstalovana kompatibilni verze aplikace Acrobat, plati nésledujici omezeni:

¢ Funkce Upravit v aplikaci Acrobat neni k dispozici v aplikacich Fiery Impose, Fiery Compose a Fiery
JobMaster.

o DPri otevreni tlohy PostScript pomoci aplikace Fiery Preview, Fiery Impose, Fiery Compose Fiery JobMaster
muze dojit k chybé.

o Sablony Fiery Impose, které pouzivaji pracovni postupy Uzivatelem definovana velikost dokonéovani nebo
Podle ramecku trimovani, nemusi fungovat spravné s alohou PostScript.

o Fiery Hot Folders nenabizi moznost pfevodu soubort PostScript do formatu PDF.

Dalsi problémy

Po upgradu na systém MacOS 10.15 ze starsi verze systému MacOS muize spusténi aplikace Fiery Preview, Fiery
Impose, Fiery Compose nebo Fiery JobMaster zptisobit zobrazeni jedné z nésledujicich zprav:

o ,ICUConverter.framework” poskodi vas pocitac. Méli byste ho presunout do kose.

o ,ICUData.framework” poskodi vas pocitac. Méli byste ho presunout do kose.


HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWS/Whats-New
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Systém macOS 10.15 tyto soubory chybné vyhodnoti jako malware. Chcete-li tyto potize vyfesit, znovu
preinstalujte sadu Fiery Command WorkStation Package ve verzi 6.4.0.396 nebo novéjsi, ktera je kompatibilni se
systémem MacOS 10.15.

Kdyz umistite kurzor mysi na tlacitka pro kteroukoli ikonu ovladacich prvka v aplikaci Fiery Preview, Fiery
Impose, Fiery Compose, nebo Fiery JobMaster, nezobrazi se jejich popis.

Uplny p¥istup k disku

V diisledku zmén zpisobu, jakym systém macOS 10.15 spravuje zabezpeceni, je nyni nutné provést dalsi kroky
ke zprovoznéni aplikaci Fiery.

Chcete-li, aby aplikace Fiery spravovaly aktualizace a ptistup k soubortm, napriklad k $ablondm Impose nebo
sledovanym slozkam, musite v systému macOS provést zmény funkce zabezpeceni Uplny pfistup k disku .
Povolte Uplny pFistup k disku pro aplikace Fiery, jako je napiiklad Fiery Command WorkStation.

1 Zavrete vSechny aplikace Fiery.

2 Piejdéte do ¢asti PFredvolby systému > Zabezpeéeni a ochrana soukromi > Ochrana soukromi > Uplny pFistup
k disku.

3 Vlevém dolnim rohu kliknéte na ikonu zdmku a zadejte své heslo.
4 Kliknéte na tlacitko +.

5 Prejdéte do slozky Aplikace, vyberte Fiery Software Manager a Fiery Software Uninstaller a kliknéte na
Oteviit.

Tyto aplikace vyzaduji uplny ptistup k disku, aby bylo mozné v pocitaci spravovat a aktualizovat aplikace
Fiery.

6 Ve slozce Aplikace vyberte Fiery Command WorkStation a kliknéte na Otevfit.

7 Pouzivate-li Fiery Hot Folders nebo Fiery Remote Scan, vyberte kazdou aplikaci a kliknéte na tlacitko Otevfit.

Kdyz Fiery Hot Folders zjisti, Ze se pouzivaji slozky Dokumenty, Plocha a Stazené soubory, vygeneruje zpravu
pozadujici uplny pristup k disku. Tato zprava se stale zobrazuje i po udéleni pristupu. Tuto zpravu miizete
zrusit a pokracovat v praci.

Chyby v prohlizeci Safari v systému macOS 10.15

Pokud pouzivate prohlize¢ Safari v systému macOS 10.15, pfi pokusu o otevieni nsledujicich stranek z aplikace
Fiery Command WorkStation bude dochdzet k opakovanym chybam prohlizece. Stfedisko zafizeni > Obecné >
Nastroje:

e Obnoveni systému Fiery
o Bitovd kopie systému Fiery
o DProstredky a nastaveni Fiery

K témto chybdm muze dochézet také pii otevirdni aplikace Fiery WebTools v prohlizeci Safari.

Pro ptistup k témto strankdm pouzijte prohlize¢ Chrome nebo Firefox.

Fiery XF v systému macOS 10.15

Pouzivéte-li Fiery XF s funkci Color Verifier, neprovadéjte upgrade na systém MacOS 10.15.
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Kdy?z se pripojite k Fiery XF, aplikace Color Verifier neni kompatibilnf se systémem MacOS 10.15. Prestoze se
zobrazi zpréva s vyzvou k aktualizaci aplikace Color Verifier, v tomto okamziku neni k dispozici zddna
aktualizace. Kliknutim na tlacitko OK zpravu zavrete.

Fiery Spot Pro

Fiery Command WorkStation 6.4 umoznuje spravovat pfimé barvy pomoci néastroje Fiery Spot Pro, ktery nahrazuje
Fiery Spot-On. Fiery Spot Pro obsahuje nasledujici vylepseni a zmény:

e Export pfimych barev do formatu ASE, ktery lze pouzit jako knihovnu vzornikd v aplikacich Adobe Creative
Suite, jako je napfiklad Adobe Photoshop.

e Snadné pouziti uprav pfimych barev na véechny profily.

e Vytvéreni vlastnich vzornika barev tak, aby odpovidaly pozadované velikosti stranky.

Uplny seznam vylepseni naleznete na strankach https://www.EFL.com/spotpro.

Fiery Spot Pro je k dispozici pro vybrané servery a mé nésledujici pozadavky:

e Software FS200 Pro a novéjsi

o Fiery Graphic Arts Package, Premium Edition

Dalsi informace ziskdte na strankach http://fiery.efi.com/spotpro/supported-printers.

Pokud Fiery server nemd zapnutou funkci Fiery Spot Pro, Fiery Command WorkStation bude nadéle podporovat

Fiery Spot-On.

Diilezité informace tykajici se pouziti Fiery Spot Pro

e Nepouzivejte symbol ,@" v Zddném ndzvu primé barvy.

o Do spusténi Spot Pro vyckejte priblizné 60-120 sekund, nez pouzijete funkci hledani nebo prepnete vystupni
profily.

o Optimalizace pfimych barev po nékolika iteracich mize mit za nasledek vyraznéjsi rozdily mezi ptivodni pfimou
barvou a pfevedenou pfimou barvou.

o DPrevedené hodnoty L*a*b* a hodnoty zarizeni CMYK se nepatrné zaokrouhluji.

e DPokud se dvé instance nastroje Spot Pro spusténé v riznych systémech pripoji ke stejnému serveru Fiery server a
oba uzivatelé provadéji operace iprav, muze dojit k chybam.

Aktualizace sady Fiery Command WorkStation Package nezavisle na softwaru systému
Fiery

Software Fiery Command WorkStation se nyni pfi instalaci chova stejné jako standardni aplikace.

Instalace sady Fiery Command WorkStation Package na serveru Fiery server nyni probiha stejné jako instalace na
vzdéaleném klientovi. To znamend, Ze pokud software Fiery Command WorkStation Package nainstalovany na
serveru Fiery server vyzaduje reinstalaci nebo upgrade, analytici nebo technici k tomu nebudou pottebovat disky
DVD se systémovym softwarem.

Kdyz nainstalujete Fiery Command WorkStation na server Fiery server, instalace neaktualizuje softwarové balicky
sdilené prostrednictvim WebTools nebo SMB. Béhem instalace/upgradu/odinstalace aplikace Fiery Command
WorkStation 6.4 se nové sluzba Fiery nezastavi.


https://www.efi.com/spotpro
http://fiery.efi.com/spotpro/supported-printers
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Instalace na server Fiery XF

Pri instalaci balicku Fiery Command WorkStation Package verze 6.4 na server Fiery XF 7.x, server Fiery XF bude v
prubéhu instalace zastaveny. Po dokonceni instalace se Fiery XF automaticky restartuje.

64bitova aplikace

Fiery Command WorkStation 6.4 (CWS) je nativni 64bitova aplikace pro platformy Mac OS a Windows.

32bitové operacni systémy nejsou aplikaci CWS 6.4 podporovany. Pokud je jiz aplikace Fiery Software Manager
spusténa v 32bitovém opera¢nim systému (OS), jako je naptiklad 32bitova verze Windows 7, nezobrazi oznameni o
aktualizaci pro sadu CWS 6.4. Pokud se tuto verzi aplikace Fiery Software Manager pokusite spustit v 32bitovém
operac¢nim systému, zobrazi se chyba kompatibility a Fiery Software Manager se nespusti. Chcete-li zobrazit
podporované operaéni systémy, navstivte web http://fiery.efi.com/cws-specifications.

Fiery Color Profiler Suite a Fiery Command WorkStation 6.4

Fiery Color Profiler Suite 5.0 (CPS) a stars{ verze nejsou plné kompatibilni s aplikaci Fiery Command WorkStation
Package 6.4 (CWS) pro digitalni tiskové stroje na volné listy. Doporucujeme aktualizovat na nastroj Fiery Color
Profiler Suite 5.1.

Pfi pouzivani CPS 5.0 s aplikaci CWS 6.4 mUlizete zaznamenat ndsledujici problémy:

Y.l

e Pokud v nastroji CWS uvidite zpravu , Pripojte spektrofotometr k pocitaci zatimco je nastroj CPS otevren,
zaviete CPS a pokracujte kliknutim na tla¢itko OK.

e Jakmile vytvorite nové nastaveni kalibrace v modulu Kalibritor, skryje se tlacitko Vytvofit novy profil ke spusténi
CPS. Tento problém je vyfesen po upgradu na CPS 5.1.

Cesta k umisténi Sablony Impose

Cesta k umisténi sablony Impose byla odebrana z predvoleb Fiery Hot Folders. Fiery Hot Folders namisto toho
pouzije cestu k $abloné Impose, kterou pouziva Fiery Impose a kterd je definovand ve Fiery Impose > Upravit >
Predvolby.

Vylepseni nastaveni vychozich hodnot
¢V nastaveni Nastaveni vychozi je k dispozici nova vychozi moznost Velikost vystupniho papiru s ndzvem Stejna
jako velikost v uloze.

¢ Uzamknuti moznosti Stejna jako velikost v Uloze zptsobi nezddouci vysledky a uzamceny stav je proto
ignorovan.

¢ Moznost Stejna jako velikost v Uloze v nastaveni Velikost vystupniho papiru neni k dispozici pro pracovni
postupy smisenych médii, vyFazovani nebo nastroje Booklet Maker.


http://fiery.efi.com/cws-specifications
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Vylepseni vlastnosti ulohy

e Vaplikaci Fiery Command WorkStation 6.4 miizete spustit Vlastnosti Glohy béhem 2 sekund nebo rychleji.

¢ Kdyz oteviete okno Vlastnosti Ulohy pro libovolnou tlohu, zobrazi se vsechny vychozi hodnoty. Kdyz kliknete na
funkce jako Katalog papiru, FreeForm, kontrolni prouzek, zobrazi se v prislusnych polich odpovidajici hodnoty.

¢ Pokud maji Vlastnosti Ulohy zobrazit vice nez 500 polozek Katalogu papiru, po kliknuti na seznam Katalog papiru
bude trvat 8-80 sekund, nez se okno aktualizuje. Pokud je pocet polozek 5 000, pocitejte s prodlevou 80 sekund.

o DPokud v nastroji Fiery ImageViewer na tlohu pouzijete kiivku, odstranite ji a poté se podivate na vlastnosti
ulohy, nazev odstranéné krivky bude stale zobrazeny, jako Ze je pridruzeny k tloze. Kdyz v$ak kliknete na seznam
Upravy néstroje ImageViewer, bude prazdny. Pokud nevyberete dostupnou kiivku Fiery ImageViewer, bude pro
ktivku zachovano ptivodni nastaveni tlohy.

e K chovani podobnému prazdnému seznamu Fiery ImageViewer také dochazi v téchto dal$ich oblastech
Vlastnosti ulohy: Vystupni profil, Zdroj RGB, Zdroj CMYK, Pouzit skupinu pfimych barev, Kontrolni prouzek,
Vytvofit predlohua Pouzit pfedlohu.

¢ Ikdyz mtze byt moznost nebo nastaveni v Katalogu papiru neplatn4, v téchto situacich se nezobrazi chybova
zprava:

e Prihlasite se k serveru Fiery Command WorkStation a zobrazite vlastnosti ilohy s platnymi nastavenimi Glohy
Katalogu papiru.

¢ Kliknete na seznam polozek Katalogu papiru v okné vlastnosti dlohy a v seznamu vyberete libovolnou moznost
Katalogu papiru.

* Obnovite Katalog papiru do tovarniho nastaveni z aplikace Fiery Command WorkStation.

e Vyberete vlastnosti tlohy, ktera jiz ma nastaveni ulohy Katalogu papiru.

Potize opravené ve verzi Fiery Command WorkStation Package v6.4.0512
Fiery Command WorkStation

o Sablona Impose s nazvem piedvolby Zna¢ky, obsahujicim libovolny z velkého poctu vicebajtovych znak, nékdy
zpusobila, ze aplikace Fiery Command WorkStation prestala odpovidat.

eV pocitacich se systémem macOS a jazykem operacniho systému nastavenym na francouzstinu nebo némcinu
prestal Fiery Calibrator pred dokoncenim kalibrace reagovat.

Problémy opravené v aplikaci Fiery Command WorkStation Package v6.4.0.500
Fiery Command WorkStation

eV pripadé japonského jazykového systému, kdyz jste pti vytvareni nové kalibrace vytiskli zkus$ebni stranku
kalibrace, nebo kdyz jste vytiskli zkusebni stranku kalibrace ze Spravce kalibraci, nazev kalibrace a vystupniho
profilu se na zkusebni strance zobrazoval zkomolené.

o Nemohli jste vytvorit kalibra¢ni sadu s polozkou Paper Catalog jako zdrojem papiru.

eV pripadé japonského jazykového systému, kdyz jste restartovali aplikaci Fiery server, nemohli jste ulozit
predvolby tlohy vytvorené ve Stredisku zarizeni.

e Po provedeni rekalibrace se zkusebni stranka kalibrace zacala zpracovavat, ale nikdy se nevytiskla.
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Fiery Command WorkStation Package v6.4.0.471

Problémy opravené ve verzi Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

e Zobrazeni miniatur bylo v podoknech zobrazeni stranky a zobrazeni archu aplikaci Fiery Impose a Fiery
Compose zpozdéno.

eV pripadé dostupnosti vice nez 300 $ablon aplikace Fiery Impose vybér $ablony Impose z nabidky Vlastnosti
dlohy > Rozvrzeni > Impose > Sablony zptisobil, Ze aplikace Fiery Command WorkStation 6.4 piestala reagovat.

e Moznost Rozéifené hledani v aplikaci Fiery Command WorkStation nelze pouzit k vyhleddni tiloh, které obsahuji
potahované nebo nepotahované typy médii.

Fiery XF

e Chcete-li vytisknout tlohu se zménénou velikosti s ofezovymi znackami, je nutné presunout tlohu ru¢né v ramci
média v aplikaci Job Editor a zménit polohy os X a Y dlohy.

Znamy problém v aplikaci Fiery Command WorkStation Package v6.4.0.471

Fiery Command WorkStation

o Primé barvy definované pomoci jinych znakt nez ASCII nejsou pro archové digitalni tiskové stroje podporovany.

Problémy opravené v aplikaci Fiery Command WorkStation Package v6.4.0.434
Fiery Command WorkStation

e Do upgradu na Fiery Command WorkStation 6.4 nebylo mozné tisknout tlohu z Fiery Command WorkStation s
pouzitim vlastnich velikosti papiru vytvorenych na tiskdrné.

o Do upgradu na Fiery Command WorkStation 6.4 nebylo mozné v dokumentech Microsoft Word pouzit odrazky.

o DPri spusténi aplikace Fiery Impose, Fiery Compose nebo Fiery JobMaster s uzivatelskou domovskou slozkou
nastavenou na sitovou slozku se zobrazovala nespravna chybova zpréava.

o Aplikace Fiery Hot Folders zahazovala strukturu slozek pfi zalohovani a obnovovani z vice trovni hlubokych
struktur slozek. Struktura slozek aplikace Fiery Hot Folders ztstava nyni po obnoveni ze zalohy zachovana.

Fiery XF

o Dochazelo ke zvyseni poctu aktualizaci Fiery XF za den, pokud byla aplikace Fiery Command WorkStation
spusténa na klientském pocitaci se systémem Windows nepretrzité.

eV nastaveni Color Tools > senastaveni polotdnu stochastického rastrovani (SE2) vzdy zménilo zpét na chybovou
difdzi (SE1).
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V Color Tools > v ¢asti Celkovy limit inkoustupoté, co jste definovali vlastni konfiguraci grafu, nebylo mozné
vytisknout graf celkového limitu inkoustu (TIL). V chybové zpravé bylo uvedeno, Ze nastaveni prekrocilo velikost
média.

Upgrade na Fiery Command WorkStation 6.4 SP1 zptsobil smazani slozky C:\Program Data\Fiery\Fiery XF\Client
\Working.

Poznamka: Neodstranujte zddné z predvoleb pti odinstalaci aktudlni verze Fiery Command WorkStation a
upgradu na nejnovéjsi verzi. Odstranéni predvoleb zptisobi odinstalaci slozky C:\ProgramData\Fiery\Fiery XF
\Client\Working, coz muze vést ke ztrdté dilezitych dat ulohy (plati pouze pro systém Windows).

Problémy opravené ve Fiery Command WorkStation Package v6.4.0.358

Fiery Command WorkStation

Pokud jste v aplikaci Fiery Impose s ur¢enou hodnotou posunu prepnuli ze standardnich ofezovych znacek na
japonské ofezové znacky, v oknech Nahled ulohy a Zobrazeni archu se pouzila pouze jedna znacka orezu.

Pokud jste v aplikaci Fiery Impose vytvorili $ablonu pro soubor PDF se smiSenymi velikostmi stranek a s
moznosti Zarovnat na stfed, nastaveni Sablony se na tlohu nepouzilo spravné. Chcete-li $ablonu Gspésné pouzit s
ocekavanym vystupem, vytvorte $ablonu znovu.

Nepouzité karty ulohy JobMaster nebyly vysunuty do zadaného zdsobniku.

Kdyz jste vytvorili novy profil kalibrace duplikovianim a prejmenovanim stavajiciho profilu, vlastnosti nového
profilu se neshodovaly s vlastnostmi ptivodniho profilu.

V aplikacich Fiery Preview, Fiery Impose, Fiery Compose a Fiery JobMaster se negenerovaly nahledy miniatur
stranek.

Fiery XF

Kdyz pouzijete fezacku MATIC s tlohami typu Krok a opakovat, znacky pro ofez zobrazené v néstroji Job Editor
neodpovidaly umisténi znacek pro ofez ve vystupu.

Systémové uzivatelské jméno obsahujici znaky s diakritikou (napfiklad hacky nebo ¢arky) nékdy zpiisobilo, ze
Server Manager prestal reagovat. Také pokud jste zménili pracovni slozku na slozku s nazvem, ktery obsahoval
znaky cyrilice, nebyla nové slozka nalezena.

Grafickd karta NVIDIA GeForce GTX1660 zptsobila, ze Server Manager a Job Editor prestaly reagovat.

Fiery Command WorkStation Package v6.4.0.321

Problémy opravené ve verzi Fiery Command WorkStation Package v6.4.0.321

Opraveny byly nasledujici problémy:

Fiery Command WorkStation

Pokud jste upravili ktivky barev existujiciho vystupniho profilu v nastaveni Stredisko zafizeni > Prostfedky >
Profily > Vystupni profily, zmény nebyly zachovany.

Pokud jste obnovili Hot Folders ze souboru zalohy, nepodatilo se Hot Folders zpracovat nékteré soubory.
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Fiery XF

V naéstroji Job Editor se na netisknutelnych okrajich tiskdrny nezobrazuji znacky ofezu pro vnoreni a alohy typu
krok a opakovani.

Nyni mtizete spravné ulozit zdroje fezu kontur a metody jako predvolbu.

Tlacitko fezu Kontur je nyni dostupné pro zarizeni pro tisk a ofez v opera¢nich systémech macOS.
Kdyz byla tloha po otoceni ofiznuta, byly rozméry obracené.

Okraj ofezu byl drive omezen na 1000 cm. Maximalni okraj ofezu je nyni stejny jako $ifka/vyska tlohy.

P1i tpravach souboru VPC v néstroji Color Tools byly zobrazeny ktivky vSech barevnych kanald, i kdyz jste
vybrali pouze jeden barevny kanal.

Znamy problém v balicku Fiery Command WorkStation Package v 6.4.0.321

Fiery Command WorkStation

Na pocitacich se sytémem macOS se nezobrazuji popisy tlacitek pro zadnou z ikon ve Fiery Preview, Fiery
Impose, Fiery Compose a Fiery Jobmaster.

Problémy opravené ve verzi Fiery Command WorkStation Package v6.4.0.261 SP1

Pokud jste spustili aplikaci Fiery Command WorkStation ihned po spusténi serveru Fiery server a poté vybrali
moznost Zasobnik stohovace (nebo dalsi Instalovatelné moznosti) v okné Vlastnosti ilohy se moznost nékdy
zobrazila jako Neni nainstaloviano. Nyni se zobrazi spravné nastaveni.

Po aktualizaci na verzi aplikace Fiery Command WorkStation 6.4 v systému MacOS a pripojili se poprvé k
serveru Fiery server, aplikace Fiery Command WorkStation nékdy prestala reagovat a pak se uzavrela. Tento
problém byl vyresen.

Pii pokusu o otevieni okna Vlastnosti tlohy se okno neoc¢ekdvané uzavrelo, pokud byly moznosti Dokonéeni >
Ryha pridany na kartu Rychly pfistup pred upgradem aplikace Fiery Command WorkStation na verzi 6.4. Tento
problém byl vyresen.
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